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Preface

Note

For the latest ViPR SRM documentation, go to the EMC Community Network.

Related documentation
The following EMC publications provide additional ViPR SRM information and are
available on EMC Online Support:

l ViPR SRM SolutionPack Release Notes
This publication contains known issues and supplemental information for each
SolutionPack.

l EMC M&R Release Notes
This publication contains known issues and supplemental information related to the
M&R platform, which provides the foundation for ViPR SRM.

l ViPR SRM Support Matrix
This publication lists SolutionPack compatibility, prerequisites, data collection
interfaces, and ports.

Your comments
Your suggestions will help us continue to improve the accuracy, organization, and
overall quality of the user publications. Send your opinions of this document to SRM
Documentation.
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CHAPTER 1

Getting Started

This chapter includes the following topics:

l What are SolutionPacks?................................................................................... 18
l Licenses..............................................................................................................18
l Browse and install...............................................................................................18
l Reconfigure an installed SolutionPack................................................................ 19
l Update SolutionPacks........................................................................................20
l Where to find the latest SolutionPack software.................................................20
l ViPR SRM and SolutionPack privileges.............................................................. 20
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What are SolutionPacks?
Understand the role of SolutionPacks in the ViPR SRM product and gain a high-level
understanding of how they are licensed, installed, reconfigured, and updated.

A SolutionPack is an installable application that provides data collection and reporting
capabilities for specific entities in the infrastructure. The SolutionPacks support EMC
storage systems along with many common third-party storage infrastructure
components.

The SolutionPacks provide asset-specific support to an enterprise installation.
Organization purchases licenses to provide visibility into only those assets that exist in
its installed infrastructure.

With a new installation, most SolutionPacks are initially available for you to try for 30
days using a trial license. You can obtain a permanent license that enables any number
and combination of available SolutionPacks in the environment.

After a SolutionPack is installed, its reports are available in the Report Library in the
User Interface. Each asset-specific node contains many pre-defined reports to
support that asset type.

ViPR SRM discovers and collects data on hosts, hypervisors, and switches, as well as
EMC and third-party storage devices. Global dashboards and reports roll up data from
the SolutionPacks into holistic views and reports such as end-to-end topology views,
path details, capacity reports, and explore views. ViPR SRM offers support for hosts,
hypervisors, switches, and arrays using SolutionPacks that provide in-depth reporting
for the individual objects. Most of the available SolutionPack data is rolled up into the
global reports and dashboards, although not all are included. As EMC normalizes the
SolutionPack data, EMC continues to add data from those SolutionPacks to the global
reports and dashboard views.

Licenses
You must have a license to install SolutionPacks.

With the installation of ViPR SRM, all SolutionPacks are initially available for you to try
for 30 days using a trial license.

A permanent license can enable any number and combination of SolutionPacks for an
environment.

To add SolutionPacks to an initial license, contact the EMC Account representative.
They can help issue temporary licenses for evaluation purposes or set up the sale of
additional SolutionPacks. New entitlements are added to the existing license. To
obtain the updated license, download it from the license portal.

Browse and install
You can browse SolutionPacks before installing them to learn more about what
SolutionPack monitors and the kinds of reports and dashboards that it provides.

Procedure

1. Browse SolutionPacks:

a. Log in to the Console and click Administration  in the banner.

b. Click Centralized Management.

Getting Started

18 EMC ViPR SRM 4.2.1  SolutionPack Guide



c. Click SOLUTIONPACK CENTER in the menu area at the top of the page.

A list of available SolutionPacks appears.

d. Click a SolutionPack name.

A page opens describing the SolutionPack and its reports. Notice the install
button at the bottom of the page.

2. To prepare to install a new SolutionPack:

a. Ensure that you have a license.

b. Obtain installation instructions for the SolutionPack from the ViPR SRM
SolutionPack Installation Guide available here: https://community.emc.com/
docs/DOC-62710.

Each chapter in that guide describes installation and configuration steps for
integrating a particular SolutionPack into an installed ViPR SRM
environment.

3. To install a new SolutionPack:

a. Browse to the SolutionPack page as described in Step 1.

b. To start the installation, click Install on the description page.

c. Continue by following instructions in the installation guide.

Reconfigure an installed SolutionPack
You can change the configuration options that are initially set during a SolutionPack
installation.

To reconfigure a SolutionPack:

Procedure

1. Log in to the Console and click Administration  in the banner.

2. Click Centralized Management.

A new browser tab opens.

3. Click SolutionPacks in the new navigation tree.

A list of installed SolutionPacks appears.

4. Click or select a SolutionPack name that you want to reconfigure.

A summary description of the SolutionPack opens, including a list of configured
components associated with that SolutionPack.

5. Click Edit (the pencil icon) next to a component to access its configuration
screen.

6. Change any of the settings on the resulting screen.

7. Click Reconfigure, and then Ok.

Getting Started
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Results

The SolutionPack is reconfigured to use the new settings.

Update SolutionPacks
You can configure ViPR SRM to automatically download updates and enhancements
to SolutionPacks.

The Online Update feature helps you to quickly take advantage of new capabilities as
they are provided in each SolutionPack. You can configure, enable, and disable
automatic downloads of SolutionPack updates. You can also see currently available
downloads and download history.

To access the Online Update feature:

Procedure

1. Log in to the Console, and click Administration  in the banner.

2. Click Centralized Management.

3. Click CONFIGURATION > ONLINE UPDATE in the banner.

4. For more information, see the ViPR SRM Administration Guide available here: 
https://community.emc.com/docs/DOC-62710.

Where to find the latest SolutionPack software

Install the latest core software update for the product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the
software longer than 30 days, you must install a SolutionPack license before the trial
period ends.

This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request for a license. For the license, submit a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.

ViPR SRM and SolutionPack privileges
The following table provides the privilege levels that are required to install and operate
SolutionPacks.

Table 1 ViPR SRM and SolutionPack privilege levels

SolutionPack Privilege level

SolutionPack for Brocade FC Switch SMI-S:

l For SMI-S, any user having SAN System
administrator privileges and having access to all
Fabrics.

SNMP:

l For SNMP v1/v2c, configure SNMP community
string.

Getting Started
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Table 1 ViPR SRM and SolutionPack privilege levels (continued)

SolutionPack Privilege level

l For SNMP v3, configure an SNMP v3 user name.

SolutionPack for Cisco MDS/Nexus For SNMP v1/v2c, configure SNMP community string.

For SNMP v3, configure an SNMP v3 user name.

SolutionPack for Cisco UCS “Role-read-only” role is sufficient for the SolutionPack
to work properly. We recommend to create a new
dedicated “service account” for SolutionPack
integration.

SolutionPack for Dell SC Series User with admin level privileges.

SolutionPack for EMC Atmos Atmos System Management Console

l SysAdmin Level

l TenantAdmin on each Tenant that the user wants
to collect data.

Atmos Cloud Delivery Platform

l Admin level access to management nodes.

l Admin level access to authentication nodes.

SolutionPack for EMC Centera The minimum profile privileges needed for data
collection are:

l The only required roles are "Accesscontrol" and
"Monitor".

l The "Granted Rights" only need to be set to "read"
(r).

The installation of the Centera collection services on a
Windows host requires Administrator privileges. But
there is a workaround described in KnowledgeBase
article 188584 that will allow the post-install running of
these services as a non-Administrator user.

SolutionPack for EMC Data Domain For SNMP v1/v2c, configure SNMP community string.

For SNMP v3, configure an SNMP v3 user name.

SolutionPack for EMC Data
Protection Advisor

DPA user needs a custom role with Manage Scheduled
Reports privileges enabled on DPA server.
Enabling the Manage Scheduled Reports will also
enable Run reports and View existing scheduled reports
and schedules. These privileges are sufficient for the
DPA SolutionPack to pull data from DPA server.

SolutionPack for EMC ECS User with "System Monitor" role is required for data
collection.

SolutionPack for EMC Host
Interface

Privileges are controlled by the configuration of the
host agent. No special privileges are required for a host
to be discovered.

Getting Started
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Table 1 ViPR SRM and SolutionPack privilege levels (continued)

SolutionPack Privilege level

SolutionPack for EMC Isilon Collection will work with root/admin users who have
administrative privileges. Collection also works for a
non-admin user that is a member of the AuditAdmin
role. This role has mostly READ ONLY privileges.

SolutionPack for EMC RecoverPoint l monitor account - read-only privileges

l admin account - has all privileges except security
and web-download

SolutionPack for EMC Unity/VNX/
VNXe

VNX Block Only, VNX Unified/File -- User with
Operator role or higher. NOTE: If the user only has the
Operator role and you run the status "Test" from
Discovery Center, the "statistics logging" test will
always fail. To confirm Statistics Logging is enabled,
you should login to Unisphere as a user with
Administrator privileges. Once Statistics Logging is
enabled, the Operator user will be able to collect
performance data from the array.

VNX Unified/File, NAS Gateway/eNAS -- A local user
for file with NAS Administrator role or higher. The "CLI
access allowed" check box must be checked.

Unity/VNXe2 -- User with Operator role or higher.

SolutionPack for EMC VMAX For ViPR SRM to collect all masking views when
Symmetrix Access Control (symacl) is enabled, the
Solutions Enabler host must be added to an Access
Group which has Access Type "BASE" and "VLOGIX"
to all devices.

For ViPR SRM to collect all masking views when
Symmetrix Authorization (symauth) is enabled the user
performing the collection only needs the Monitor role.

IMPORTANT: symauth "Monitor" role only works to
retrieve all masking views with latest Solutions Enabler
7.6.2.25 (hotfix 1843/service alert 1708). Older
versions of Solutions Enabler 7.6.2 (ex. 7.6.2.8 which
was required in ViPR SRM 3.5 release) required
"Storage Admin" or "Admin" role in order to retrieve all
masking views.

Windows-based collector host running VMAX Solution
Pack and using "remote" SYMAPI Server:

l The Windows "System" account runs the Collector
service which performs the VMAX collection

l The Windows "System" account therefore
executes the SYMCLI commands to get the
masking view.

l In order for symauth to retrieve all masking views
the collector hosts's "System" user account must
at least have the "Monitor" role authorized. Again,
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Table 1 ViPR SRM and SolutionPack privilege levels (continued)

SolutionPack Privilege level

this assumes Solutions Enabler 7.6.2.25 or higher is
installed

l Otherwise if an older 7.6.2 Solutions Enabler is
installed then "Storage Admin" or "Admin" role
would be required.

Linux-based collector host running VMAX SolutionPack:

l The "apg" user account runs the Collector service
which performs the VMAX collection

l The "apg" user therefore executes the SYMCLI
commands to get the masking views

l In order for symauth to retrieve all masking views
the SRM ViPR Linux collector hosts's "apg" user
account must at least have the "Monitor" role
authorized. Again, this assumes Solutions Enabler
7.6.2.25 or higher is installed

l Otherwise, if an older 7.6.2 Solutions Enabler is
installed, then "Storage Admin" or "Admin" role
would be required.

SolutionPack for VMAX HYPERMAX Collection requires the specified Unisphere user to have
a minimum role of "Monitor".

SolutionPack for EMC ViPR
Controller

Set the following roles in the Virtual Data Center

l System Monitor - Retrieves metering and
monitoring records for the Virtual Data Center.

l System Auditor - Retrieves audit logs for the
Virtual Data Center.

SolutionPack for EMC VPLEX Use the management CLI and the Linux shell account to
navigate on the management station. The service
account that is used by default is both a Linux account
and a CLI account.

From the perspective of the management CLI, the
service user is not read-only, because you can perform
some provisioning operations on the VPLEX, although it
does not have full administrative capabilities.

From the perspective of the Linux shell, the service
account is a regular user account so you cannot do
operations that require root privilege.

For a non-service account, follow these additional steps
once the user has been created. This is assuming the
SolutionPack is already installed using the service
account. If it is being installed for the first time with a
non-service user, you do not need this procedure.

1. Change the permission to the virt-volumes folder
with following command: chmod g+w virt-
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Table 1 ViPR SRM and SolutionPack privilege levels (continued)

SolutionPack Privilege level

volumes // run under /var/log/
Vplex/cli/w4

2. Reconfigure the VPLEX SolutionPack with the
alternate account

SolutionPack for EMC XtremIO Non-admin account with read-only privileges.

SolutionPack for Hitachi Device
Manager

Non-privileged account with rights to view all.

SolutionPack for HP 3PAR
StoreServ

Non-privileged account with browse privileges.

SolutionPack for HP StorageWorks
P9000

Non-privileged account with rights to view all.

SolutionPack for IBM DS Non-admin account with read-only privileges.

Discover DS8000 devices with Monitor privileges.

SolutionPack for IBM LPAR HMC credentials

l User role or Operator (recommended), or HMC
Viewer (minimum).

l Refer to table 4 at http://www-01.ibm.com/
support/knowledgecenter/POWER6/ipha1/
hmctasksanduserroles.htm

SolutionPack for IBM SAN Volume
Controller/Storwize

All the performance, topology and capacity metrics are
supported for a user who is a member of the
"Administrator" user group. Performance data such as
CPU usage, Port traffic statistics of non-configuration
nodes are not supported for a user who is not a member
of the "Administrator" user group.

SolutionPack for IBM XIV Discovery works with Read Only, Storage
Administrator, Application Administrator access.

Read Only is the minimum required.

Note

Due to limitations with the IBM software, discovery
using the LDAP users will not happen if there is no
active IBM XIV GUI user session, either by the
corresponding LDAP user or a stroage administrator.

SolutionPack for Microsoft Hyper-V Admin rights are required in order to run unsigned
PowerShell scripts.
In order to do this, you must run the following command
as an administrative user:

PowerShell -C Set-ExecutionPolicy
Unrestricted
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Table 1 ViPR SRM and SolutionPack privilege levels (continued)

SolutionPack Privilege level

On Microsoft Windows Server 2008 R2 and Microsoft
Windows Server 2012 Hyper-V hosts, the domain
administrative user must be member of domain group
Domain Admins. In other words, it is not enough to
make a domain user member of local group
Administrators in Hyper-V hosts.

On Microsoft Hyper-V Server 2012, it is possible to
collect data using a non-administrative local or domain
user. This user must be member of local groups Hyper-
V Administrators and Performance Log Users groups.

SolutionPack for Microsoft SQL
Server

l SQL authentication requires that the user be a
member of the SYSADMIN group

l Windows user account requires the user be a
member of the Guests group or the Domain Guests
group

l The default database must be the master

l Windows user account must be imported into the
Microsoft SQL Server with settings similar to
these:

n Server roles of public

n Securable grants for Connect SQL, View any
definitions, and View server state

SolutionPack for NetApp Filer SSH connection to the 7-Mode NetApp devices with
the following role:

l login-ssh, cli-stats*, cli-snap*, cli-aggr*, cli-vol*,
cli-disk*, cli-nfs*, cli-cifs*, cli-df, cli-sysconfig, cli-
ifconfig, cli-qtree, cli-quota, cli-storage, cli-
maxfiles, cli-echo, cli-lun, cli-fcp, cli-vfiler, cli-
exportfs

SSH connection to the C-Mode NetApp devices with
the following role:

l Access level 'readonly' for the commands : volume,
df, lun, storage, statistics, network, vserver,
cluster, sleep, snapmirror

l Access level 'all' for the commands: set, system

SolutionPack for Oracle Database The ViPR SRM collector must connect to each instance
of Oracle databases and perform SQL queries. You can
use either an administrator equivalent system account,
or create a dedicated system account for the collector.
If you want to use the last option, ask the DBA
administrator to run the query described in the
SolutionPack for Oracle chapter.

This will create a "watch4net" account, which specific
grant for the collector.
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Table 1 ViPR SRM and SolutionPack privilege levels (continued)

SolutionPack Privilege level

SolutionPack for Oracle MySQL
Database

This SolutionPack requires MySQL database user login
privileges to collect information from MySQL database
servers running remotely.

SolutionPack for Physical Hosts Windows user privileges

l Domain user in the local administrator's group
(recommended), or

l Local administrator for the host.

UNIX user privileges

l Sudo user with read/execute permissions for
commands, or

l SSH public/private key pair with execute
permission for commands.

Refer to the SolutionPack for Physical Hosts chapter
for more information.

VIO server

l SUDO user role with elevated (root) privileges to
execute commands to be run on the VIOS host.

l Note: The padmin role is not required for VIO
Servers.

VIO Client/LPAR

l SUDO user role (or)

l SSH Keys (or)

l root user (optional)

SolutionPack for VMware vCenter Discovery works with read-only non-admin user.
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CHAPTER 2

SolutionPack for Amazon AWS

This chapter includes the following topics:

l Overview............................................................................................................28
l Installing the SolutionPack................................................................................. 28
l Discovering AWS accounts and services............................................................ 29
l Limitations......................................................................................................... 29
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Overview
The SolutionPack for Amazon AWS collects storage and instances data from the
Amazon AWS account and displays the data in easy-to-use reports in ViPR SRM.

Installing the SolutionPack

Before you begin

For Windows and Linux binary installations, the AWS Command Line Interface (CLI)
tools are installed and configured on the collector server. In addition, Windows binary
installations require a minimum of Windows Management Framework 3.0. The AWS
CLI tools are preinstalled on the ViPR SRM vApp. For more information about
installing AWS CLI, refer to:

https://docs.aws.amazon.com/cli/latest/userguide/installing.html

The AWS CLI tools must be configured for user apg, with credentials and
configuration files under /opt/APG/.aws/.

Ensure that the appliance has the correct date and time so that AWS does not reject
requests. For more information about Configuring the AWS Command Line Interface,
refer to:

https://docs.aws.amazon.com/cli/latest/userguide/cli-chap-getting-started.html

For cost reports, the following reports must be enabled in the Amazon AWS account
billing preferences:

l Monthly cost allocation report for monthly cost analysis

l Detailed billing report with resources and tags for hourly cost estimates

For more information about configuring reports, refer to:

https://docs.aws.amazon.com/awsaccountbilling/latest/aboutv2/billing-what-is.html

Note

The SolutionPack downloads the files from the specified bucket to parse them.
Standard AWS storage rates apply.

Ensure that the following details are available to configure the SolutionPack during
installation:

l AWS CLI profile name to use for each collection configuration profile (see /opt/
APG/.aws/credentials)

l Account Name (used to tag collected data. Example: john.doe)

l Account Number (used to tag collected data)

l S3 bucket name where Excel billing reports are located. You must be the owner of
this bucket

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.
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4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays data collection details.

9. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

10. Type the location of the Amazon AWS CLI bin file.

11. Optionally, specify any additional AWS CLI arguments to pass.

12. Optionally, select Configure advanced settings to configure topology and
billing polling intervals.

13. Click Next.

14. Click Install.

15. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

Discovering AWS accounts and services
Follow the procedure for each Amazon AWS account that you want to monitor.

Procedure

1. From Centralized Management, browse to Discovery Center > Inventory
Management > Amazon AWS Account.

2. Click Add new device.

3. Select the server and collector instance where you want to store the
configuration details.

4. Type the Amazon account credentials.

5. Select the services that you want to monitor.

6. To validate access to the account and services, click Test.

7. Click Ok.

Limitations

When the AWS SolutionPack Collector is installed on a separate Linux server, and the
AWS CLI is not installed on the default path, then the error might be displayed in the
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collection log file. Since there is no functionality impact due to this error, you can
ignore this exception.

SEVERE – [2016-05-20 09:03:47 EDT] – 
AbstractStreamHandlerJob::prepareNextStep(): Error executing 
handler Read billing file-FileOpener
 com.watch4net.apg.ubertext.parsing.StreamHandlerException: Error 
while creating the stream for file /opt/APG/Collecting/Stream-
Collector/amazon-aws-linux/./incoming/150213616981-aws-billing-
detailed-line-items-with-resources-and-tags-2016-05.csv
 at 
com.watch4net.apg.ubertext.parsing.retriever.FileReaderRetriever.new
FileToRead(FileReaderRetriever.java:370)
 at 
com.watch4net.apg.ubertext.parsing.retriever.FileReaderRetriever.acc
ess$200(FileReaderRetriever.java:53)
 at com.watch4net.apg.ubertext.parsing.retriever.FileReaderRetriever
$FileOpenerHandler.handleExecution(FileReaderRetriever.java:452)
 at 
com.watch4net.apg.ubertext.parsing.concurrent.AbstractStreamHandlerJ
ob.prepareNextStep(AbstractStreamHandlerJob.java:170)
 at 
com.watch4net.apg.ubertext.parsing.concurrent.SimpleStreamHandlerJob
.step(SimpleStreamHandlerJob.java:43)
 at com.watch4net.apg.concurrent.executor.AbstractJobExecutor
$SequentialJob.step(AbstractJobExecutor.java:421)
 at 
com.watch4net.apg.concurrent.executor.AbstractJobExecutor.executeJob
Runner(AbstractJobExecutor.java:124)
 at com.watch4net.apg.concurrent.executor.AbstractJobExecutor.access
$500(AbstractJobExecutor.java:24)
 at com.watch4net.apg.concurrent.executor.AbstractJobExecutor
$JobRunnerImpl.run(AbstractJobExecutor.java:276)
 at 
java.util.concurrent.ThreadPoolExecutor.runWorker(ThreadPoolExecutor
.java:1142)
 at java.util.concurrent.ThreadPoolExecutor
$Worker.run(ThreadPoolExecutor.java:617)
 at java.lang.Thread.run(Thread.java:745)
 Caused by: java.io.FileNotFoundException: /opt/APG/Collecting/
Stream-Collector/amazon-aws-linux/./incoming/150213616981-aws-
billing-detailed-line-items-with-resources-and-tags-2016-05.csv (No 
such file or directory)
 at java.io.FileInputStream.open0(Native Method)
 at java.io.FileInputStream.open(FileInputStream.java:195)
 at java.io.FileInputStream.<init>(FileInputStream.java:138)
 at 
com.watch4net.apg.common.io.ActionOnCloseFileInputStream.<init>(Acti
onOnCloseFileInputStream.java:170)
 at 
com.watch4net.apg.ubertext.parsing.retriever.FileReaderRetriever.new
FileToRead(FileReaderRetriever.java:363)
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CHAPTER 3

SolutionPack for Block Chargeback

This chapter includes the following topics:
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l Running the chargeback preprocessor task manually.........................................35
l Enable collecting component level metrics for a limited set of hosts..................35
l Limitations ........................................................................................................ 36
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Overview
The SolutionPack for Block Chargeback provides visibility into block storage usage
and associated costs by host or by defined groups of hosts in the environment.

When you install the SolutionPack, it creates a chargeback preprocessor task that
runs as configured during SolutionPack installation and collects block chargeback
metrics for all physical hosts and virtual machines. Primary Used, Primary Presented,
Total Used, and Total Presented are the four use cases. The reports display
chargeable capacities and cost for every physical host, virtual machine, hypervisor
cluster, and defined device group for each of these use cases. The reports also display
chargeable capacity by service level.

Chargeable and non-chargeable metrics
This SolutionPack can generate both chargeable and non-chargeable metrics. Non-
chargeable metrics are optional, and are disabled by default during SolutionPack
installation.

If storage is not shared across hosts, there is no difference in chargeable and non-
chargeable metric values.

The values are different when multiple hosts share a physical or virtual volume.

l Non-chargeable metrics are the values as seen directly by the host. The same
values are duplicated for each of the hosts sharing that storage, without regard for
how many hosts are sharing it.

l Chargeable metrics take host sharing into account, and divide the metrics by the
number of hosts that are sharing it. The metrics are deduplicated, making them
representative of chargeability.

Examples
If two hosts are sharing 500GB of block storage from the same disk, and none of that
storage is used, the capacity metrics are as shown in the following table.

Table 2  Shared disk with no storage used

Metric name Host A - Disk1 Host B - Disk1

Non-Chargeable Presented
(=total capacity of the disk)

500GB 500GB

Non-Chargeable Used (=used
capacity of the disk)

0 0

Chargeable Presented (=total
capacity of the disk ÷ # hosts
sharing it)

250GB 250GB

Chargeable Used (=used
capacity of the disk ÷ # hosts
sharing it)

0 0

Alternatively, if Host A uses 100GB of this storage, the capacity metrics are as follows.
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Table 3 Shared disk with some storage used

Metric name Host A - Disk1 Host B - Disk1

Non-Chargeable Presented
(=total capacity of the disk)

500GB 500GB

Non-Chargeable Used (it has
changed from 0 GB to 100
GB)

100GB 100GB

Chargeable Presented (=total
capacity of the disk ÷ # hosts
sharing it)

250GB 250GB

Chargeable Used (=used
capacity of the disk ÷ # hosts
sharing it)

50GB 50GB

Installing the SolutionPack
Before you begin

l Identify the collector host for the chargeback preprocessor.

l Identify the chargeback use case that you are interested in. Possible options are:

n Presented—Only presented capacity and cost metrics are computed.
Presented capacity is based on the total capacity that is provisioned to the
host but not necessarily written.

n Used—Only used capacity and cost metrics are computed. Used capacity is
based on the actual capacity.

n Both (Default)—Both used and presented capacity and cost metrics are
computed.

l Identify whether non-chargeable capacity and cost metrics are needed. If the
Enable non-chargeable metrics option is enabled, non-chargeable metrics are
created in addition to the chargeable metrics. Non-chargeable metrics are key-
performance indicators of storage, showing the capacities and costs for the
storage before deduplication is applied for the hosts sharing that storage.

l Identify whether collection of component level chargeback metrics are needed. If
the Enable component level chargeable metrics option is enabled, chargeback
metrics are collected for every constituent component of the host or the virtual
machine (including host devices, RDMs, and VMDK/log files).

Note

Enabling this feature causes a significant increase in metrics that are produced and
may result in the need for additional backends in larger environments.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.
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5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically. Ensure that the preprocessor component is installed on the
collector that was identified for this purpose

8. Click Next.

9. From the How often should the chargeback calculations run? drop-down list,
select the desired frequency for the chargeback preprocessor task.

The default value is Every day. The other options available are Every 2 days,
Every 5 days, Every 7 days, and Every 6 hours.

10. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

11. From the Frontend Web service drop-down list, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

Note

In a multi-server setup, be sure to select a Frontend server. Do not select
same-as-generic-chargeback-collect or other choices that result in using
localhost. The localhost in this SolutionPack refers to the Collector server
for the chargeback preprocessor.

12. To configure various options, select Use advanced settings.

a. From the Compute Chargeback for Use-case drop-down list, select the
option for the desired use case.

By default, both used and presented chargeback metrics are collected.

b. Check or uncheck the Enable non-chargeable metrics option for the
desired use case.

This option is not enabled by default.

If this option is enabled, the non-chargeable capacity and cost metrics are
created in addition to the chargeable metrics. Non-chargeable metrics are
key-performance indicators of storage, showing the capacities and cost for
the storage before deduplication is applied for the hosts sharing that
storage.

c. Check or uncheck the Enable component level chargeable metrics option
for what was identified earlier.

This option is not enabled by default.

SolutionPack for Block Chargeback

34 EMC ViPR SRM 4.2.1  SolutionPack Guide



If this option is enabled, chargeback metrics are collected for every
constituent component of the host or the virtual machine (including host
devices, RDMs, and VMDK/log files).

Note

Enabling this feature causes a significant increase in metrics that are
produced and may result in the need for additional backends in larger
environments.

13. Click Next.

The window displays reports settings.

14. Click Install.

15. When the installation is complete, click OK.

After you finish

Chargeback reports are available under Reports Library > Chargeback and also under
Operations > Chargeback.

The reports are empty immediately after the SolutionPack is installed. They start
displaying data only after the chargeback preprocessor task completes successfully
and data has had sufficient time to propagate through the environment. This task runs
using the schedule that is selected during installation.

User configuration changes in Centralized Management > Groups Management
affect chargeback data, such as changes to service level tags and user-defined group
definitions. In general, expect to wait 1 day plus the frequency of the chargeback task
to see reconfigured chargeback data after such changes.

To shorten these wait times, wait for data collection to occur and then manually run
the chargeback preprocessor task. For example, if the chargeback preprocessor task
is scheduled to run every 5 days, wait the 1 day for data to settle and then manually
run the task.

Running the chargeback preprocessor task manually
You can run the chargeback preprocessor task manually instead of waiting for the
scheduled run

Procedure

1. Go to Administration  > Centralized Management > Scheduled Tasks.

2. Expand the Chargeback node.

3. Select the chargeback processor instance. The default instance name is
chargeback-processor-generic-chargeback.

4. In the right pane, click Run Now.

Enable collecting component level metrics for a limited set
of hosts

You can specify a list of hosts to the collector to limit collection.

Use this procedure to enable full collection of certain hosts regardless of SolutionPack
configuration settings.
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Procedure

1. Go to Administration > Logical Overview > Miscellaneous > Tools >
Chargeback Processor::Generic Chargeback.

2. In the right pane, click the arrow on the Configuration files row to expand it.

3. Select the file that is named /conf/chargeback-processor.properties,
and click Edit.

4. In the editing window, add the following entry to the end of the file:

cbp.usecase.whitelist=<hosts>

where <hosts> is a comma-separated list of hostnames.

5. If the whitelist separator must be changed to a character other than comma,
add the following additional entry:

cbp.usecase.whitelist.separator=separator

where separator is the character. For example, to use the pipe character as
separator, type:

cbp.usecase.whitelist.separator=|

Here are example entries:

#cbp.usecase.whitelist=host1,host2,host3
#cpb.usecase.whitelist.separator=,

6. Click Save.

Note

If the SolutionPack is reconfigured, direct changes to this file are lost. In that
case, the changes must be reentered.

Limitations
l When you upgrade from a previous version, the SolutionPack for Block

Chargeback is not installed by default and the old chargeback reports reference a
broken link. Install the SolutionPack for Block Chargeback to obtain chargeback
reports and resolve this link.

l Hosts that are not completely discovered and hosts with only local disks do not
show up in chargeback reports.

l Delegation of chargeable capacities to host disk capacity when the backend array
is not discovered and not supported for passive hosts nor for Windows hosts
discovered through the SolutionPack for Physical Hosts using a user with non-
admin privileges.
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l This SolutionPack does not support chargeback reporting for:

n RDM level chargeable capacity will not be shown for Hyper-V VMs, therefore
the component level chargeback reports will be empty

n Hyper-V chargeback is supported at the hypervisor level, VM level chargeback
is supported only for LUNs mapped to VM with NPIV configuration

n Virtual Machines where the data store on which the VM resides is backed by
BOTH a LUN and a virtual volume

n Virtual Machines where the data store on which the VM resides is backed by
BOTH a local virtual volume and a remote virtual volume

n Virtual volumes backed by RAID 1 (mirrored) LUNs

n Hosts with disks that are backed by a distributed virtual volume if any of the
arrays contributing to the storage of that distributed virtual volume are
undiscovered

l If two or more VMs have the same display name, but different host names and IP
addresses, their chargeback capacities get grouped under one VM.

l Chargeback data is missing for hosts that are discovered passively using the
Hitachi Device manager SolutionPack and connected to arrays other than HDS
arrays. Chargeback data for disks that are directly connected to such passive
hosts from HDS will show up correctly.

l When a vmdk file is backed up by Avamar and the VM which hosts Avamar is
discovered by ViPR SRM, Chargeback considers both the hosts (Actual host and
Avamar backed VM) as connected to the vmdk file. As a result, chargeable
capacity will be shared between both the VMs. As a workaround, change/deny the
permission from vCenter to collect data from Avamar backed VM. In this way, no
metrics will be collected from the VM, which hosts Avamar and no impact on the
chargeable capacity will happen.
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CHAPTER 4

SolutionPack for Brocade FC Switch

This chapter includes the following topics:

l Overview............................................................................................................40
l Brocade switch and SMI agent configuration.....................................................40
l Configuring Brocade SMI Agents....................................................................... 40
l Configuring Brocade switches for alert consolidation......................................... 41
l Configuring Brocade switches for SNMP discovery............................................41
l Installing the SolutionPack................................................................................. 42
l Passive host discovery configuration options.....................................................46
l Limitations..........................................................................................................47
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Overview
The SolutionPack for Brocade FC Switch accesses performance data information that
was automatically collected and interpreted (using resource grouping and
mathematical calculations) from across multiple fabrics. Alerts are consolidated from
Brocade FC Switches and shown on the All Alerts Console

Data collection methods

SMI-S

Discover switch topology, zoning details, and some performance data through
SMI-S.

SNMP + SMI-S (Zoning only through SMI-S)

Discover switch topology and all performance data through SNMP. SNMP does
not support zoning discovery. Restrict SMI-S discovery to zoning details only.

Brocade switch and SMI agent configuration
Configure Brocade switches and SMI agents for discovery and alert consolidation in
ViPR SRM.

l Configuring Brocade SMI Agents

l Configuring Brocade switches for alert consolidation

l Configuring Brocade Switches for SNMP discovery

Configuring Brocade SMI Agents
Install and configure the Brocade SMI agent for complete switch discovery or zoning
discovery only.

Procedure

1. Install Brocade SMI agent in one of the following modes:

Installation mode Description

Integrated Brocade SMI
Agent

The Brocade SMI agent is integrated with CMCNE,
BNA, CMDCE, DCFM, and gets installed when you
install any of these products.

Brocade SMI Agent only
(headless installation)

Headless installation (silent mode installation) does
not need a license and installs the SMI agent only.

Refer to the CMCNE/CMDCE installation guide for more details on installation
and configuration of Brocade SMI agent.
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Configuring Brocade switches for alert consolidation
Use the snmpConfig command to forward SNMP v1 traps from Brocade switches to
ViPR SRM.

Trap-based alerts for Brocade switches are supported through SNMP regardless of
the discovery option you choose. Even if you choose not to restrict SMI-S to zoning
discovery, configure the switches for SNMP trap forwarding.

Use the snmpConfig command to forward SNMP v1 traps from Brocade switches to
ViPR SRM.

Procedure

1. Log in to the Brocade FC switch as the administrator.

2. Type snmpConfig ––set snmpv1 and press Enter.

3. Type the following details, when prompted:

Option Input

Community [public]

Trap recipient's IP
address

In a single vApp installation, this option is the ViPR
SRM IP, and in a distributed environment, is the
Primary Backend server's IP.

Trap recipient severity
level

(0..5)

Trap recipient port 2041, which is the ViPR SRM trap listening port.

4. If you have multiple Brocade FC switches in the storage environment, repeat
this procedure on each switch.

Configuring Brocade switches for SNMP discovery

If you choose SNMP+SMI-S (zoning only through SMI-S) discovery option, Brocade
switches are configured with SNMP v1/v2c/v3 credentials.

Procedure

1. Launch a command line interface for the Brocade switch and log in with
Administrator credentials.

2. To configure the switch for SNMPv1/v2c, perform the following steps:

a. Type snmpConfig --show snmpv1.

The community strings are listed.

b. If you want to change a community string, type snmpConfig --set
snmpv1

c. Type the new community string and continue.

3. To configure the switch for SNMPv3, perform the following steps:

a. Type snmpConfig --show snmpv3.
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The configuration parameters are listed.

b. If you want to change the parameters, type snmpConfig --set snmpv3.

c. Type the parameters and continue.

4. Repeat these steps for each Brocade switch in the storage environment.

Installing the SolutionPack

Before you begin

l To discover the switch topology (switch details and switch port details) and
switch performance using SNMP and zoning details through SMIS, you must be
aware of SNMP v1/v2 community strings and SNMP ports, or SNMP v3 user
details and privacy and authentication details for the v3 username. In addition, the
username, password, port number, and SSL enabled/status for the SMI-S provider
are required to discover the zoning details.

l To discover the switch topology, switch performance, and zoning details through
SMIS, the username, password, port number, and SSL enabled/status for the
SMI-S provider are required

l The ViPR SRM Alerting Guide explains how to configure alerts consolidation.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. From the Alerting on data collection drop-down list, select existing settings
that have been specified for other components, or select Add a new alerting
data collection.

If you select Add a new alerting on data collection, choose an alerting web-
service instance.

11. Click Next.

The window displays Brocade data collection details.

12. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
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2020, which is the Collector host where the Load Balancer Connector is
installed.

13. Leave Enable Topology Backend on data collected checked.

14. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

15. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

16. From the SMI-S Discovery Configuration option drop-down list, select
existing settings that have been specified for other components, or add a new
configuration. If desired, select Restrict SMI-S to zoning discovery only.

If the option is selected, SMI-S will be used to discover zoning details only. If
unselected, SMI-S will be used to discover switch and zoning details
completely.

17. From the Passive Host Discovery Specific Configuration drop-down list,
select existing settings that have been specified for other components, or add a
new configuration. If desired, select Enable Passive Host Discovery.

See Passive host discovery configuration options for additional details.

18. Optionally, select Advanced settings for SMI-S to configure polling settings.

Beginning with ViPR SRM 4.2, the SolutionPack for Brocade FC Switch allows
you to discover Brocade SNMP based switch discovery via Discovery Center.
The advantage of using Discovery Center is that you can discover all of the
switches in a fabric by entering the IP address of just one switch in the fabric by
using discovery groups. However, you can discover Brocade switches through
SNMP using Device Discovery web application and the Generic-SNMP
collector. This option has been provided for backward compatibility.

19. Select Configuration settings for SNMP Discovery option For SNMP
discovery.

The advanced settings are applicable only for the SNMP based switch discovery
using Discovery center using Brocade collector and are not applicable for the
Generic-SNMP collector. Use caution when configuring these settings.
Improper settings impact Brocade Collector performance.

On selecting SNMP Discovery Configuration, user can optionally configure the
SNMP Collector name, SNMP Collector port, and Communication interface IP
address

Polling period configuration:

Performance data Polling period defines the frequency with which the
Brocade Collector polls the performance related data from the switch.
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Topology Polling period defines the frequency with which Brocade Collector
polls the topology related data from the switch.

All of the capabilities that are supported by the switch will be polled.

Polling Group configuration consists of a group of switches and some of the
capabilities that are supported by those switches. You can optimize the
resources that are consumed by the Brocade Collector by tuning these settings.

Property refresh time is the time at which the properties will be refreshed for
a polling group. The property refresh time format is HH:MM:SS, where HH is
hours, MM is minutes, and SS is seconds.

Start Polling Group at Defined period when enabled, will start the polling at
the next "round" period. Raw value timestamps will be accurate. For example, if
the polling period is set to 5 minutes, this would mean that the polling cycles will
start at 00:00, 00:05, 00:10, and so on.

Polling Group Start Time offset (s) is used to start different polling groups at
different times to avoid putting an excessive load on the Brocade Collector. The
polling for the polling groups will start one after the other with a delay that is
specified by this time offset. When setting a polling group start time offset,
consider the shortest polling period (performance or topology), the time it takes
for the Brocade Collector to poll the switch for the capabilities in the polling
group, and the number of polling groups. If the polling group start time is too
short, the load on the Brocade Collector will increase. If the polling group start
time is too long, the polling groups might not be finished polling within the
polling interval and the next polling period might start.

20. Click Next.

The window displays reports settings.

21. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

22. Click Next.

The window displays a note about SNMP masks.

23. Click Install.

24. Click Ok.

Monitor the installation logs to ensure that the installation completes
successfully.

Discovery of Brocade Elements through Discovery center
The following section describes how to add Brocade SMIS provider and SNMP based
switch discovery using Discovery Center. To add multiple Brocade elements at a time,
use a discovery group.

The advantage of using a discovery group is that you can discover all of the switches
in a fabric by entering the IP address of just one switch per fabric or multiple SMIS
providers. If the switches/provider shares credentials, the credentials only need to be
entered once as well. For more information about creating discovery groups, refer to 
Add devices using discovery.

Procedure

1. Click Discovery Center > Inventory Management.

2. Click Brocade FC Switch.

3. Click Add new device.
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4. Specify the details of the Brocade Fc Switch/Provider configuration.

Do not enter spaces.

5. In the Device location section, select the server and instance where you want to
store the configuration details for this device.

6. Select Discovery Mode.

l To discover SMI-S provider, select SMI-S option from the drop down.

a. In the SMI Provider IP Address or Host Name field, type the Brocade
SMI Provider host.

b. Enter the access credentials.

c. If desired, select Enable Secure Connection (SSL).

d. Type the port number. The default ports are 5988 for non-SSL and 5989
for SSL.

e. Click Validate and Add.

f. Click Ok.

g. Click Save.

l To discover Brocade switch though SNMP, select SNMP option from the
drop down.

a. In the Switch IP address field, type the IP address of the device that is
supporting the SNMP agent.

b. Switch name is optional.

c. In SNMP Port field, type the device SNMP agent listening port.

d. In the SNMP Version field, type the device SNMP agent version. If you
select v3, select the authentication and encryption protocols, and specify
the passwords.

e. In the Community String/User Name field, specify the community
name if the SNMP version is v1 or v2c. Specify the user name if the
SNMP version is v3.

f. Click Validate and Add to trigger discovery.
Discovery fetches minimal information about the switch like the
supported capabilities.

The validation tests connectivity to the device using the provided
information. If an error indicator appears, correct the information and
click Test to try again.

The Status column represents the discovery results. You can click on the
status icon to view the discovery results.

g. Click Save to trigger polling. Polling is the periodic collection of the
metrics and properties from the switch based on the supported
capabilities that are discovered.

Capabilities
When a switch is successfully discovered in Discovery Center, using SNMP discovery
mode, the Collected Devices tab displays the Capabilities that are being collected from
the switch in abbreviations, as shown below. The number of capabilities discovered
depends on the switch model and SNMP MIBs that are enabled. Manually adding
capabilities that have not been discovered by the SolutionPack will result in errors in
the log files. Deleting discovered capabilities could result in blank reports.
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Abbreviation Capability Data collection
method

SW BROCADE_FCSWITCH_SYSTEM Topology

SW-P BROCADE_FCSWITCH_PORT Performance

AG BROCADE_ACCESSGATEWAY_SYSTEM Topology

AG-P BROCADE_ACCESSGATEWAY_PORT Performance

P-STAT BROCADE_FCSWITCH_PORT_STATUS Performance

GIF GENERIC-INTERFACES Performance

NOIFX GENERIC-INTERFACES-NO-IFXTABLE Performance

SUTIME GENERIC-SYSUPTIME Performance

Passive host discovery configuration options
Enable passive host discovery to see end-to-end topology from hosts to arrays, and
identify chargeback on SAN enabled hosts without active host discovery.

You can passively resolve hosts that are discovered through the SolutionPack for
Brocade FC Switch from zoning records.
The default zone naming patterns in ViPR SRM are:

z_%h%

z_%h%_*

z_%h%_*_*

%h%_*

After you enable passive host discovery, the following options for passive host
configuration are available:

l Enable DNS Resolution: This option, which is enabled by default, resolves the "IP"
property by using the DNS lookup handler. You can uncheck this option to avoid
using the DNS lookup feature.

n Exclude Passive hosts on DNS resolution failure: Enable this option to stop
passive host data from being collected if the DNS resolution for the host fails.

l Exclude Passive Hosts that are actively discovered: Enable this option to stop
passive host data from being collected if that host has been actively discovered.

l Customize zone naming patterns: This option allows you to customize the zone
naming pattern. By default, this option is disabled, and ViPR SRM uses the four
default zone naming patterns. You can enable this option to add, delete, or modify
the default zone naming patterns and hostname positions in zones.

You can enable passive host discovery while installing the SolutionPack, or you can
enable it by reconfiguring the Brocade Data Collection component of an existing
instance of the SolutionPack.

To enable and add/edit customized zone naming patterns:

Procedure

1. Select the Enable Passive Host Discovery checkbox.

2. Select the Customize zone naming patterns checkbox.

The system displays the four default zone naming templates.
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3. To view the zone naming pattern and host position for a template, click the Add
button (plus icon). Edit the pattern or position if desired.
Only Java-based zone naming patterns are supported.

Only plain numbers can be used for the position. Special characters (like $) are
not required.

Table 4 Sample zone naming patterns

Regex is ^(z_)([A-Z0-9a-z]+)$ and hostname
position is 2

Matches all the zone names that start with
'z_' and extracts the hostname from the rest
of the string that follows 'z_'
Example: For zone name z_lingz099, the
hostname that is extracted is lingz099.

Regex is ^([^z_][A-Z0-9a-z]+)_([A-Za-
z0-9]+) and hostname position is 1

Matches all the zone names that do not start
with 'z_' and extracts the hostname from
zone name that is before the first underscore.
Example: For lgloe111_1106, the hostname that
is extracted is lgloe111.

Note

l All of the Capacity and Availability metrics that are related to passive hosts
will go inactive after upgrading from a release before 4.1 to the latest
release.

l Passive Host Discovery considers only the Physical Port WWNs with Format
1, Format 2, and Format 5 according to Network Address Authority (NAA)
naming format.

l For an overview of physical host discovery mechanisms, see Physical host
discovery

l Starting from 4.2 release, Passive host discovery supports discovery of
mapped WWNS (WWNs starting with C/D/E/F are referred to as Mapped
WWNs).

For more information about writing Java's regular expression, refer to
https://docs.oracle.com/javase/tutorial/essential/regex/

Limitations

SMIS severe exceptions are seen in collecting logs while discovering an SMIS provider
where there are no director class switches, FCOE switches, or AG switches added to
it.

Example:

SEVERE – [2014-10-28 06:29:56 EDT] – n::run(): An error occurred 
while fetching data. Data from collecting configuration 
Brocade_Ethernet_Port will not be collected in this cycle.

SEVERE – [2014-04-22 10:17:05 GMT] – n::run(): An error occurred 
while fetching data. Data from collecting configuration 
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Brocade_ModulePort will not be collected in this cycle. 
                     

SEVERE - [2016-09-07 13:14:43 BST] -- n::run(): An error occurred 
while fetching data. Data from collecting configuration 
Brocade_AGSoftwareIdentity will not be collected in this cycle.
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CHAPTER 5

SolutionPack for Cisco MDS/Nexus

This chapter includes the following topics:
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Overview
The SolutionPack for Cisco MDS/Nexus accesses performance data that was
automatically collected and interpreted (using resource grouping and mathematical
calculations) across multiple MDS/Nexus fabrics. Alerts are consolidated from Cisco
MDS/Nexus Switches and shown on the All Alerts Console.

Data collection methods
The SolutionPack for Cisco MDS/Nexus uses SNMP to access performance data
information that was automatically collected and interpreted (using resource grouping
and mathematical calculations) from across multiple fabrics.

There are two methods for discovering Cisco MDS/Nexus devices:

l Device discovery UI using the Generic-SNMP Collector – With this approach you
can perform the device discovery using the device discovery UI and the Generic-
SNMP Collector. If you prefer this method, you do not need to install the Cisco
SNMP data collection block.

l Discovery Center UI using the dedicated Cisco SNMP Collector – With this
approach you must install the Cisco SNMP data collection block that is introduced
in ViPR SRM 4.0. After installing this data collection block, you can use the
Discovery Center UI to discover Cisco MDS/Nexus switches.

Note

Switches should not be discovered simultaneously from SNMP Device Discovery and
Discovery Center.

Note

For an overview of physical host discovery mechanisms, see Physical host discovery.

Performing pre-configuration tasks
Before you discover a Cisco switch in ViPR SRM perform the following checks.

All switches in the Cisco fabric must have SNMP credentials for use with ViPR SRM.
For example, if SNMPv1/v2c is used, all Cisco switches in the fabric should have the
SNMPv1/v2c community name set with a role of network-admin or network-operator.
For example, if SNMPv3 is used, all Cisco switches in the fabric should have the
SNMPv3 user set with the role of network-admin or network-operator.

Procedure

1. Ensure that all hardware and software is listed as supported in the EMC ViPR
SRM Support Matrix.

2. Verify the TCP/IP connectivity to the switches to be discovered. Test by
issuing a ping command to these switches.

3. Determine if SNMP traps are enabled. Log in to the switch and run the
command show snmp trap.

4. Run the command snmp-server enable traps to enable SNMP traps.

SWDevCisco8-9216i# config terminal
Type configuration commands, one per line. End with CNTL/Z.

SWDevCisco8-9216i (config)# snmp-server enable traps
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5. Display the traps that are enabled. Run the show snmp trap command. The
values in the Enabled column should be Yes.

Known issue with user-defined roles

If an SNMPv3 user or SNMPv1/v2c community string that is used for switch
discovery is assigned to a role that has vSAN policy set to deny, there is a possibility
of switch restart and supervisor fail-over.

This condition is due to an issue in Cisco NX-OS 5.2(6) through 6.2(x).

The workaround is to run the following commands in sequence:

linbge197#config t
linbge197#role name <name of the role>
linbge197#no vsan policy deny
linbge197#copy run start
linbge197#exit

Configuring switches for SNMPv1 and SNMPv2c
Configure Cisco switches for SNMPv1 or SNMPv2c to enable switch discovery, and
alert consolidation for the switches. The SNMPv1 or SNMPv2c information you
provide when performing discovery is necessary for ViPR SRM to contact the switch
to obtain information.

Before you begin

If SNMPv1/v2c is used, all Cisco switches in the fabric should have the SNMPv1/v2c
community name set with a role of network-admin/network-operator.

ViPR SRM collects data from the switch using the SNMP community name. It uses
the SNMP port for communication. The default port set is port 161.

Note

The Cisco documentation provides information on configuring Cisco switches for
SNMPv1 and SNMPv2c management.

Procedure

1. Log in to the switch as an administrator.

2. To configure the snmp-server communitystring with read-only privileges,
run the following commands:

Cisco8-9216i# config terminal
Cisco8-9216i(config)# snmp-server community srmuser ro
Type configuration commands, one per line.

3. To verify if the SNMPv1 community string exists, run the command show snmp
community.

A sample output of the command:

Community Group/Access

srmuser network-operator
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Configuring switches for SNMPv3
Configure Cisco switches for SNMPv3 to enable discovery and alert consolidation for
the switches. The SNMPv3 information that you provide when performing discovery is
necessary for ViPR SRM to contact the switch to obtain information.

ViPR SRM collects data from the switch using SNMPv3 secure credentials. ViPR SRM
supports SNMPv3 with all the combinations of Auth (MD5, SHA) and Priv (AES, DES,
NONE).

Note

Create the SNMPv3 users with authentication and privacy passwords on all physical
switches in the fabric. The Cisco documentation provides information on creating
SNMPv3 users on Cisco switches.

This procedure provides an example of creating an SNMPv3 user called srmuser with a
network-operator role, SHA authorization, and AES128 authentication.

Procedure

1. Log in to the switch as an administrator.

Cisco8-9216i# config terminal
Type configuration commands, one per line.

2. Run the snmp-server user commands as follows:

snmp-server user srmuser network-operator auth sha <SHA-
password> priv aes-128 <AES-password>

3. To verify the new user creation, run the command show snmp user.

Table 5 Sample output of show snmp user command

SNMP USERS

User Auth Priv(enforce) Groups

admin md5 no network-admin

srmuser sha aes-128(no) network-operator

NOTIFICATION TARGET USERS (configured for sending V3 Inform)

User Auth Priv

SWDevCisco8-9216
i#
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Configuring Cisco switches for alert consolidation
Use the snmp-server command to forward SNMP v1 alert traps from Cisco FC
switches to ViPR SRM.

Procedure

1. Log in to the Cisco FC switch as the administrator.

2. Type # config, and press Enter.

3. Type snmp-server host <trap recipient IP> traps <SNMP trap
version> <Community String> udp-port <trap listening port >, and
press Enter.

In the command syntax:

Syntax element Input

<trap recipient IP> In a single vApp installation, this element is the ViPR
SRM IP, and in a distributed environment, is the
Backend server's IP.

<SNMP trap version> version 1

<Community String> public

<trap listening port > 2041, which is the ViPR SRM trap listening port.

Example: snmp-server host 10.247.24.190 traps version 1 public
udp-port 2041

4. If you have multiple Cisco FC switches in the storage environment, repeat this
procedure on each switch.

Installing the SolutionPack

Before you begin

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l The ViPR SRM Alerting Guide explains how to configure alerts consolidation.

Beginning with ViPR SRM 4.0, the SolutionPack for Cisco MDS/Nexus includes a
dedicated SNMP Data Collection Manager that allows you to discover Cisco MDS/
Nexus switches via Discovery Center through this SNMP Data Collection block. The
advantage of using Discovery Center is that you can discover all of the switches in a
fabric by entering the IP address of just one switch in the fabric. In addition, topology
and performance polling interval configurations only apply to devices discovered using
Discovery Center. However, you can skip installing this block if you prefer to discover
Cisco MDS/Nexus switches through SNMP Device Discovery and the Generic-SNMP
collector. This option has been provided for backward compatibility.

Procedure

1. Click Administration .

2. Click Centralized Management.
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3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. From the Alerting on data collection drop-down list, select existing settings
that have been specified for other components, or select Add a new alerting
data collection.

If you select Add a new alerting on data collection, Alerting Web-Service
Instance dropdown will have default value. Do not change the value.

11. Click Next. The window displays SNMP data collection details.

Beginning with ViPR SRM 4.0, the SolutionPack for Cisco MDS/Nexus includes
a dedicated SNMP Data Collector that allows you to discover Cisco MDS/
Nexus switches via Discovery Center through this SNMP Data Collection block.
However, you can skip installing this block if you prefer to discover Cisco MDS/
Nexus switches through SNMP Device Discovery and the Generic-SNMP
collector. This option has been provided for backward compatibility.

12. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

13. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

14. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

15. Specify the SNMP Collector name, SNMP Collector port, and the
communication interface IP address. The default collector name is
Watch4NetSnmpCollector-MDS and the default port is 2007.
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16. From the Passive Host Discovery Options drop-down list, select existing
settings that have been specified for other components, or add a new
configuration. If desired, select Enable Passive Host Discovery.

See Passive host discovery configuration options for additional details.

If you opted not to install the Cisco SNMP data collection block, see Enabling
passive host discovery through Generic-SNMP.

17. Select Configure advanced settings to configure polling period and polling
group settings.

The advanced settings are applicable only for the dedicated SNMP Data
Collector and are not applicable for the Generic-SNMP collector. Use caution
when configuring these settings. Improper settings will impact SNMP Collector
performance.

Performance data Polling period defines the frequency with which the
dedicated SNMP Collector polls the performance related data from the switch.

Topology Polling period defines the frequency with which the dedicated
SNMP Collector polls the topology related data from the switch.

All of the capabilities that are supported by the switch will be polled. For more
information about capabilities, refer to Capabilities.

Polling Group configuration consists of a group of switches and some of the
capabilities supported by those switches. You can optimize the resources
consumed by the dedicated SNMP Collector by tuning these settings.

Property refresh time is the time at which the properties will be refreshed for
a polling group. The property refresh time format is HH:MM:SS, where HH is
hours, MM is minutes, and SS is seconds.

Start Polling Group at Defined period when enabled, will start the polling at
the next "round" period. Raw value timestamps will be accurate. For example, if
the polling period is set to 5 minutes, this would mean that the polling cycles will
start at 00:00, 00:05, 00:10, and so on.

Polling Group Start Time offset (s) is used to start different polling groups at
different times to avoid putting an excessive load on the dedicated SNMP
Collector. The polling for the polling groups will start one after the other with a
delay specified by this time offset. When setting a polling group start time
offset, consider the shortest polling period (performance or topology), the time
it takes for the SNMP Collector to poll the switch for the capabilities in the
polling group, and the number of polling groups. If the polling group start time is
too short, the load on the SNMP Collector will increase. If the polling group
start time is too long, the polling groups might not be finished polling within the
polling interval and the next polling period might start.

18. Click Install.

19. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

Adding and configuring devices
Before you begin

The SolutionPack for Cisco MDS/Nexus dedicated SNMP Data Collection Manager
must be installed. For more information about installing the SNMP Data Collection
Manager, refer to Installing the SolutionPack for Cisco MDS/Nexus installation.

SolutionPack for Cisco MDS/Nexus

Adding and configuring devices     55



The following procedure describes how to add switches individually using Discovery
Center. To add multiple switches at a time, use a discovery group. The advantage of
using a discovery group is that you can discover all of the switches in a fabric by
entering the IP address of just one switch per fabric to be discovered. If the switches
share credentials, the credentials only need to be entered once as well. For more
information about creating discovery groups, refer to Add devices using discovery.

Procedure

1. Click Discovery Center > Inventory Management.

2. Click Cisco MDS/Nexus.

3. Click Add new device.

4. Specify the details of the Cisco MDS/Nexus configuration. Do not enter spaces.

a. In the Device location section, select the server and instance where you
want to store the configuration details for this device.

b. In the Switch IP address field field, type the IP address of the device that
is supporting the SNMP agent.

c. In SNMP Port field, type the device SNMP agent listening port.

d. In the SNMP Version and field, type the device SNMP agent version. If you
select v3, select the authentication and encryption protocols, and specify
the passwords.

e. In the Community String/User Namefield, specify the community name if
the SNMP version is v1 or v2c. Specify the username if the SNMP version is
v3.

5. To trigger discovery, click Validate and Add.

Discovery fetches minimal information about the switch like the supported
capabilities.

The validation tests connectivity to the device using the provided information. If
an error indicator appears, correct the information and click Test to try again.

The Status column represents the discovery results. To view the discovery
results, click the status icon.

6. To trigger polling, click Save.

Polling is the periodic collection of the metrics and properties from the switch
based on the supported capabilities that are discovered.

Capabilities
When a switch is successfully discovered in Discovery Center, the Collected Devices
tab displays the Capabilities that are being collected from the switch in abbreviations.
The number of capabilities that are discovered depends on the switch model and
SNMP MIBs that are enabled. Manually adding capabilities that have not been
discovered results in errors in the log files. Deleting discovered capabilities could result
in blank reports.

Abbreviation Capability Data collection
method

ZN CISCO-ACTIVE-ZONE
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Abbreviation Capability Data collection
method

ZSET CISCO-ACTIVE-ZONESET

PHOST CISCO-ACTIVE-ZONE-PASSIVE-
HOST

DALIAS CISCO-DEVICE-ALIAS

FRU CISCO-ENTITY-FRU Performance

SNSR CISCO-ENTITY-SENSOR Performance

FCFE CISCO-FCFE Performance

FCFENPV CISCO-FCFE-NPV Performance

FCS CISCO-FCS Topology

FCSVSAN CISCO-FCS-VSAN Performance

FCTL CISCO-FEATURE-CONTROL Topology

FLASH CISCO-FLASH Performance

NPORT CISCO-MDS-NEXUS-PORTS Performance

NPSTAT CISCO-MDS-NEXUS-PORTS-
STATUS

Performance

NPROC CISCO-MDS-NEXUS-PROCESS Performance

NVSAN CISCO-MDS-NEXUS-VSAN Performance

NS CISCO-MDS-NS-DM Topology

VS-ZSET CISCO-VSAN-ACTIVE-ZONESET

GIF GENERIC-INTERFACES Performance

NOIFX GENERIC-INTERFACES-NO-
IFXTABLE

Performance

SUTIME GENERIC-SYSUPTIME Performance

PPOST CISCO-PROCESS-POST Performance

PENTITY CISCO-PHYSICAL-ENTITY Topology

Passive host discovery configuration options
Enable passive host discovery to see end-to-end topology from hosts to arrays, and
identify chargeback on SAN enabled hosts without active host discovery.

You can passively resolve hosts that are discovered through the SolutionPack for
Cisco MDS/Nexus from zoning records.
The default zone naming patterns in ViPR SRM are:

z_%h%

z_%h%_*

z_%h%_*_*

%h%_*
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After you enable passive host discovery, the following options for passive host
configuration are available:

l Enable DNS Resolution: This option, which is enabled by default, resolves the "IP"
property by using the DNS lookup handler. You can uncheck this option to avoid
using the DNS lookup feature.

n Exclude Passive hosts on DNS resolution failure: Enable this option to stop
passive host data from being collected if the DNS resolution for the host fails.

l Exclude Passive Hosts that are actively discovered: Enable this option to stop
passive host data from being collected if that host has been actively discovered.

l Customize zone naming patterns: This option allows you to customize the zone
naming pattern. By default, this option is disabled, and ViPR SRM uses the four
default zone naming patterns. You can enable this option to add, delete, or modify
the default zone naming patterns and hostname positions in zones.

l Customize vendor OUIs: This option allows you to customize the vendor OUIs. By
default, this option is disabled and ViPR SRM uses the following vendor OUIs by
default: 0000C9, 000A38, 000E03, 00109B, 0090FA, 00C0DD, 00E08B, 001B32,
00E0D5, 001405, 0024FF, 001438, 0060B0, 8C7CFF. If required, you can enable
this option to add additional vendor OUIs.

You can enable passive host discovery while installing the SolutionPack, or you can
enable it by reconfiguring the SNMP Data Collection component of an existing
instance of the SolutionPack.

To enable and add/edit customized zone naming patterns:

Procedure

1. Select the Enable Passive Host Discovery checkbox.

2. Select the Customized zone naming patterns checkbox.

The system displays the four default zone naming templates.

3. To view the zone naming pattern and host position for a template, click the Add
button (plus icon). Edit the pattern or position if desired.

Only Java-based zone naming patterns are supported.

Only plain numbers can be used for the position. Special characters (like $) are
not required.

Table 6 Sample zone naming patterns

Regex is ^(z_)([A-Z0-9a-z]+)$ and hostname
position is 2

Matches all the zone names that start with
'z_' and extracts the hostname from the rest
of the string that follows 'z_'
Example: For zone name z_lingz099, the
hostname that extracted is lingz099.

Regex is ^([^z_][A-Z0-9a-z]+)_([A-Za-
z0-9]+) and hostname position is 1

Matches all the zone names that do not start
with 'z_' and extracts the hostname from
zone name that is before the first underscore.
Example: For lgloe111_1106, the hostname that
extracted is lgloe111.
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Note

l All of the Capacity and Availability metrics that are related to passive hosts
will go inactive after upgrading to the 4.1 release.

l Passive Host Discovery considers only the Physical Port WWNs with Format
1, Format 2, and Format 5 according to Network Address Authority (NAA)
naming format.

For more information about writing Java's regular expression, refer to
https://docs.oracle.com/javase/tutorial/essential/regex/

Enabling passive host discovery through Generic-SNMP
If you opted not to install the Cisco SNMP data collection block, enable passive host
discovery through the Generic-SNMP collector.

Procedure

1. Edit the Generic-SNMP independent SolutionPack block instance.

2. Select the Enable Passive Host Discovery checkbox.

3. Click Reconfigure.

Limitations

l Maintenance operations that cause a large number of changes in the SAN
environment, such as zoning changes and migrations, might degrade APG
database performance. These operations generate new active metrics to represent
the new SAN environment, and previous metrics become inactive. If active plus
inactive metrics exceed 1.5 million entries, slower performance of the database is
expected. If needed, you can clean the database to remove inactive metrics, or
split the database if active metrics are greater than 1.5 million entries.

l The ViPR SRM SNMP Collector causes the switch to restart and the supervisor to
fail. The issue is due to a code bug in Cisco NX-OS from 5.2(6) through 6.2(x) and
MDS configurations with Roles and vSAN policies. If SNMP V2c or V3 credentials
that are used for switch discovery are assigned to a role which has vSAN policy
denied, then the issue occurs.

To check the vSAN policy for each role, run the following command:

show role brief
Workaround is implemented by using the following commands on the problematic
roles and switches:

config t
role name <name of the role>
no vsan policy deny
copy run start
exit

l When triggering discovery for a discovery group, the status icon is not displayed.
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Overview
The SolutionPack for Cisco UCS generates reports that encompass compute,
network, and storage access components of the unified fabric.

The SolutionPack generates uptime reports for the UCS Managers and enables you to
see into the solution as managed by the unified management domain. In addition, the
SolutionPack for Cisco UCS obtains real-time and historical data through various
reports that indicate events and faults in the system.

Data collection methods
UCS XML API

Configuring the UCS Manager
Enable XML API for the Cisco UCS Manager.

Before you begin

Procedure

1. Log in to the Cisco UCS Manager web console.

2. Browse to Admin > Communication Management > Communication
Services.

3. Verify that the HTTP and CIM XML services are enabled.

If the Redirect HTTP to HTTPS option is enabled, use secure communication
when configuring the SolutionPack block.

4. If you want to use secure communications between the collector and the UCS
Manager:

l Choose the secure communication option when adding the UCS Manager.

l Configure HTTPS on the Communication Services page of UCS Manager.

After you finish

EMC recommends that you create a new dedicated service account for SolutionPack
integration. Role-read-only role is sufficient for the SolutionPack to work correctly.

Installing the SolutionPack

Before you begin

ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.
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6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays pre-configured alert details.

9. From the Alerting on data collection drop-down list, select existing settings
that have been specified for other components, or select Add a new alerting
data collection.

If you select Add a new alerting on data collection, Alerting Web-Service
Instance dropdown will have default value. Do not change the value.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

12. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

13. From the Topology Service drop-down list, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new Topology Service, type information about the
Topology Service.

In Topology Service Hostname or IP address, specify the Primary Backend
host and select the Gateway for Web-Service Gateway dropdown.

14. Select the Enable events collection checkbox.

15. In the Event server hostname or IP address field, select the Backend host
where the events server runs. The default port is 52007.

16. In the Even server port number field, type port number for events collection.

17. Select Configure advanced settings to configure polling settings.

18. Click Next.

The window displays event settings.

19. Select an Event database. If you select Add a new Events database, type
information for the new events database. Type the database information for the
events database that runs on the Primary Backend host. The default Database
port is 53306. The default Event server port number is 52007.

20. Click Next.

The window displays reports settings.
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21. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

22. Click Install.

23. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

24. Click Discovery Center > Inventory Management.

25. Click Cisco UCS.

26. Click Add new device.

27. Specify the details of the Cisco UCS configuration.

a. In the Device location section, select the server and instance where you
want to store the configuration details for this device.

b. In the UCS type field, select UCS Manager (Blade Chassis) or UCS C-Series
(Server).

c. In Hostname or IP address type the UCS management host.

d. In the Username and Password fields, type the credentials for the
management server.

e. Select Enable secure connection, if desired.

f. In the Communication port field, type the port number for the management
server.

28. To validate the credentials, click Validate and Add.

29. Click OK.

30. Click Save.

After you finish

If you want to discover the Cisco UCS Fabric Interconnects in the environment via
SNMP, you must install the Cisco MDS /Nexus SolutionPack in the environment. This
provides full SNMP masks and capabilities for the SNMP discovery.

Cisco UCS events are commented out by default in frontend configuration files. To
enable Cisco UCS events, uncomment Cisco UCS events in the following configuration
files: APG.xml, APG-WS.xml, and report-generation-config.xml.

Importing the new database schema

Before you begin

Starting with core software EMC M&R 6.2u4, schema is preloaded. If you installed
from an earlier version, import the new database schema.

Procedure

1. Load the events block file Event-Processing/Generic-Live-Writer/
cisco-ucs/ddl/my-ucs_live.sql.

2. Run mysql-client.sh (mysql-client.cmd on Windows).

3. Type username, database name, and password.

4. Copy the contents of the /my-ucs_live.sql file and paste it into the mysql
client at the mysql> prompt.

The ucs_live table is created.
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5. Start the event processing manager service.

6. To enable events reporting from the frontend:

a. Edit the Web-Application configuration file Web-Servers/Tomcat/
Default/conf/Catalina/localhost/APG.xml.

b. If the cisco-ucs-events section is present, uncomment it.

c. If the cisco-ucs-events section is missing, add the following lines:

<!-- cisco-ucs-events --> 
<ResourceLink name="jdbc/FLOW-UCS-LIVE:{ mapping=FLOW-
UCS.xml, table=ucs_live
 }" global="jdbc/FLOW-EVENTS" type="javax.sql.DataSource" />

7. Restart the tomcat service.

Limitations

l The following message appears in the logs when the SolutionPack for Cisco UCS
collector-manager is first started. This problem is resolved when a device is added
for discovery and the collector-manager is restarted.

WARNING – [2016-04-10 11:26:24 EDT] – SocketConnector::init(): 
Can't connect socket to localhost:52007 
 java.net.ConnectException: Connection refused

l Events reports in the SolutionPack for Cisco UCS are specific to UCS Manager
only.
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Overview
The SolutionPack for Dell SC Series collects storage capacity, performance, and
topology data from the Dell Storage SC series arrays and displays data in easy-to-use
reports in ViPR SRM.

Installing the SolutionPack

Before you begin

l Dell Storage Center Operating System 7.1.x or later must be running. If previous
versions to Dell SCOS 7.1.x are discovered, you might not see expected data as
these versions are not supported.

l Dell Storage Manager Data Collector 2016 R2 or later must be installed and
managing the Storage Centers that you intend to discover in ViPR SRM.

l The Dell SC collector with the default heap size can manage one DSM Data
Collector host across 10 Storage Centers up to 2000 volumes. If the number of
volumes across the Storage Centers exceed 2000, the recommendation is to split
the Storage Centers across two DSM Data Collector hosts.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

12. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.
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If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

13. To configure the Topology Polling Period, Performance Polling Period, and
Volume Performance Polling Period settings, select Use advanced settings.

The default setting for the Volume Performance Polling Period is 15 minutes.
If you have more than 1,000 volumes per DSM Data Collector host, it is
recommended that you set the polling period to 60 minutes. Performance data
will be displayed after the completion of the polling period.

14. Click Next.

The window displays reports settings.

15. Click Install.

16. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

Adding and configuring devices in Discovery Center
To discover Dell SC series arrays that Dell Storage Manager Data Collector manages,
follow the procedure.

Procedure

1. From Centralized Management, Browse to Discovery Center > Inventory
Management > Dell SC Series.

2. Click Add.

3. Type the Hostname or IP address of the Dell Storage Manager Data Collector.

4. Type the Host Port.

The default is 3033, which can be changed.

5. Type in the Username and Password of the Dell Storage Manager Data
Collector.

6. To validate access to the account and services, click Validate and Add.

7. Click Ok.

8. Click Save.

Configuring Storage Center to send SNMP alerts
If you want to monitor Dell SC Series alerts, use the Dell Storage Manager Client to
configure a Storage Center to send SNMP traps to ViPR SRM.

Before you begin

The Storage Center must be added to Enterprise Manager using a Storage Center
user with Administrator privileges.
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Procedure

1. In the Dell Storage Manager desktop client, click Storage.

2. Select a Storage Center.

3. In the Summary tab, click Edit Settings.

4. Select SNMP Server from the menu.

5. In SNMP Version, select SNMP v1/v2c.

6. In Read Only Community String, typepublic.

7. In Read Write Community String, type public.

8. Click Create SNMP Trap Destination.

9. In Trap Destination, type the hostname or IP address of the ViPR SRM Primary
Backend or Alerting Backend.

10. From the Type drop-down, select the trap type to use.

11. In Port, type 2041.

12. In Community String, type public.

13. To save the changes, click OK.

14. If the Agent Running status is Not Running, click Start SNMP.

15. To save the changes, click OK.

Limitations

When an array has a down disk that is waiting to be replaced, the individual capacity
values (Configured Usable, Hot Spare, RAID Overhead, Unconfigured, Unusable) can
add up to be more than the Total Raw Capacity Usage. This issue happens because
the capacity of the down disk is counted as both Unusable capacity and Unconfigured
capacity. Once the down disk is replaced, the individual capacity values will correctly
add up to the Total Raw Capacity Usage.
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Overview
The SolutionPack accesses system summary reports for Resource Management
Groups (RMGs), as well as for the nodes being monitored within the RMGs. In
addition, SolutionPack generates reports summarizing key storage parameters for the
entire Atmos multi-tenant system.

Installing the SolutionPack

Before you begin

l EMC ViPR SRM core modules must be up-to-date in all servers because not all
module dependencies are validated during the SolutionPack installation or update
process.

l Data that are imported in the 2.0 version of this SolutionPack will not be
compatible with the 1.0 version of SolutionPack for EMC Atmos. Data continuity
with previously imported data will be broken.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays data collection details.

9. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

10. Configure polling settings.

11. Click Next.

The window displays reports settings.

12. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

13. Click Install.

14. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.
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Adding and configuring devices in Discovery Center
Procedure

1. Click Discovery Center > Inventory Management.

2. Click EMC Atmos.

3. Click Add.

4. If the Server field appears, select the server where the device will be
dispatched.

5. If the Instance field appears, select the instance of the atmos collect where the
device will be dispatched.

6. In Atmos Platform Name, type the name to identify the Atmos Installation.

7. Select or Unselect Atmos Cloud Delivery Platform Configuration checkbox.

8. If Atmos Cloud Delivery Platform Configuration checkbox selected, provide the
details:

l IP address, Username, and Password for ACDP Management Node

l ACDP Authentication Node IP

9. Type in Atmos System Management Node IP, Username, and Password in
Atmos System Management Interface section.

10. Type in Tenant Name, Username, and Password in Atmos Tenant Administration
Section.

11. To add more tenant and its details, click the Add button (plus icon).

12. To add the device details to the Discovery Center, click Validate and Add.

13. Click Ok.

14. Click Save.

Limitations
l The Atmos SMI interface reports capacity that is based on the storage available

for object creation, while ViPR SRM reports combined object storage capacity
along with the capacity used to store the object's metadata. Therefore the ViPR
SRM number will be higher than the number reported by the Atmos SMI console,
the difference being the capacity dedicated to metadata storage.

l In the Node Details/File Systems report, Total Diskspace does not equal Used
Diskspace plus Free Diskspace.

l The Top-5 Availability Problems (Node) report lists all available nodes.

l In the Subtenant Summary report, the Objects (nb) count does not equal the
Number of Objects count.
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Overview
The SolutionPack accesses the inventory of the Centera storage system and
generates reports on usage capacity for pools and nodes, pool file counts, and C-Clip
counts.

Supported systems
Centera Viewer CLI (v4.3)

Data collection methods
CLI

Preparing Centera arrays for discovery and data collection

Procedure

1. Identify the ViPR SRM Collector host which supports EMC Centera Viewer CLI
software.

2. Identify the username (with monitor role enabled) and password.

3. Record this information. Install the SolutionPack.

Configuring Centera arrays for alert consolidation
Use the set snmp target command to forward SNMP v1 traps from Centera to
ViPR SRM.

Procedure

1. Log in to the Centera as the administrator.

2. Type set snmp target, and press Enter.

3. Type the following details, when prompted:

Option Input

Management station: <trap_recipient_IP_address> : 2041
In a single vApp installation,
<trap_recipient_IP_address> is the ViPR SRM IP
address. In a distributed environment,
<trap_recipient_IP_address> is the Backend server
IP address.

SNMP version (v2, v3)
[v2]:

v2

Community name: public

Issue the command?
(yes, no) [no]:

yes
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Installing the SolutionPack

Before you begin

l Do a package synchronization after you register the Windows VM with the base
vApp. From Centralized Management, click Package Management and then
Synchronization. Check retrieve the lastest package and click Ok.

l ViPR SRM core modules must be up-to-date in all servers because only some
module dependencies are validated during the SolutionPack installation or update
process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

12. Leave Activate the FailOver-Filter that is checked.

13. In EMC Centera specific configuration, edit the data collection polling interval
as required.

14. Click Next.

The window displays reports settings.

15. Click Install.

16. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

17. Click Discovery Center > Inventory Management.

18. Click Centera Configuration.
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These steps describe how to add hosts individually. For information about using
discovery groups to use the same credentials to discover multiple hosts, see 
Adding devices to discovery groups.

19. Click Add New Device.

20. From Server, select the server where the device will be dispatched.

21. From Instance, select the instance of the emc-centera where the device will be
dispatched.

22. In the Centera configuration section, type the IP and credentials of the
Centera array’s Management IP address or hostname.

a. In Management IP address or hostname, type the array management IP or
hostname.

b. Add the username and password of the Centera array.

c. Choose the Connection method from the drop-down list.

23. To validate the credentials, click Validate and Add.

24. Click Ok.

25. Click Save in the Centera Configuration page.

Limitations
l If a Centera system does not have its serial number that is configured, it will be

reported in a separate table. If there are two or more systems that do not have
their serial number that is configured, the Capacity information will be incorrect.

l The Centera Device Summary report in Explore does not display Health alerts. It
only displays Threshold alerts.

l Health alerts are not displayed in the Devices Summary report.
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Overview
The SolutionPack generates real-time and historical reports and accesses file system,
compression, replication, and chassis inventory status details to gain insight into the
management of an EMC Data Domain system.

Data collection method

The SolutionPack for EMC Data Domain uses SNMP to access performance data
information that was automatically collected and interpreted (using resource grouping
and mathematical calculations).

There are two methods for discovering EMC Data Domain devices:

l Device discovery UI using the Generic-SNMP collector – With this approach you
can perform the device discovery using the device discovery UI and the Generic-
SNMP collector. If you prefer this method, you do not need to install the EMC
Data Domain data collection block.

l Discovery Center UI using the dedicated EMC Data Domain SNMP Collector –
With this approach you must install the EMC Data Domain data collection block
that is introduced in ViPR SRM 4.2. After installing this data collection block, you
can use the Discovery Center UI to discover EMC Data Domain systems.

Note

EMC Data Domain systems should not be discovered simultaneously from SNMP
Device Discovery and Discovery Center.

Configuring Data Domain systems for SNMPv1 and
SNMPv2c

Configure Data Domain systems for SNMPv1 or SNMPv2c to enable device discovery,
and alert consolidation for the devices. The SNMPv1 or SNMPv2c information you
provide when performing discovery is necessary for ViPR SRM to contact the device
to obtain information. ViPR SRM collects data from the Data Domain system using the
SNMP community name. It uses the SNMP port for communication. The default port
is 161.

Before you begin

Ensure that the SNMP timeout period is greater than 10,000 ms to prevent timeout
from occurring while discovering the Data Domain system.

Procedure

1. Log in to the Data Domain system as an administrator.

2. To configure the community string with specific privileges, run the following
commands:

snmp add ro-community <community-string-list> [hosts <host-
list>]

snmp add rw-community <community-string-list> [hosts <host-
list>]
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Example:

sysadmin@dd2200# snmp add ro-community <community-string> 
hosts <hostname>

3. To verify if the SNMPv1 or SNMPv2c community string exists, run the following
command:

snmp show config

Table 7  Sample output of snmp show config command

Community Access Hosts

watch4net read/write 10.20.30.40

public read-only 10.20.30.50

Configuring Data Domain systems for SNMPv3
Configure Data Domain systems for SNMPv3 to enable discovery and alert
consolidation for devices. The SNMPv3 information you provide when performing
discovery is necessary for ViPR SRM to contact the device to obtain information.
ViPR SRM collects data from the Data Domain system using SNMPv3 secure
credentials. ViPR SRM supports SNMPv3 with all the combinations of Auth (MD5,
SHA) and Priv (AES, DES, NONE). This procedure provides an example of creating an
SNMPv3 user called watch4net, MD5 authorization, and AES128 authentication.

Before you begin

Ensure that the SNMP timeout period is greater than 10,000 ms to prevent timeout
from occurring while discovering the Data Domain system.

Ensure that the SNMPv3 user has a minimum of 8 characters.

Procedure

1. Log in to the Data Domain system as an administrator.

2. Run the following command:

snmp user add <user-name> access {read-only | read-write} [authentication-
protocol {MD5 | SHA1} authentication-key <auth-key> [privacy-protocol {AES |
DES} privacy-key <priv-key>]]

Example:

sysadmin@dd2200# snmp user add watch4net access read-only 
authentication-protocol MD5 authentication-key <auth-key> 
privacy-protocol AES privacy-key <priv-key>

3. To verify the new user, run the following command:

snmp show config
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Table 8  Sample output of snmp show config command

User Access Authentication
Protocol

Privacy Protocol

watch4net read-only MD5 AES

vipradmin read/write SHA1 DES

Configuring Data Domain devices for alert consolidation
Use the snmp add trap-host command to forward SNMP v2 alert traps from Data
Domain devices to ViPR SRM.

Procedure

1. Log in to the Data Domain as the administrator.

2. Type snmp add trap-host community <Community String> version
<SNMP trap version> <trap recipient IP>:<trap listening port>, and
press Enter.

Where:

l <Community String> is public
l <SNMP trap version> is v2c/v3c
l <trap recipient IP> in a single vApp installation, this parameter is the ViPR

SRM IP, and in a distributed environment, is the Primary Backend server's
IP.

l <trap listening port > is 2041, which is the ViPR SRM trap listening port

Example:

snmp add trap-host community watch4net version v2c 
10.247.24.190:2041

3. If you have multiple Data Domain devices in the storage environment, repeat
this procedure on each device.

Installing the SolutionPack

Before you begin

l Data Domain must be configured to allow the EMC M&R collector host to
communicate to it via SNMP.

n To view the SNMP configuration, use the following command on the Data
Domain system: # snmp show config

n Use the following command to add the EMC M&R host: # snmp add ro-
community <public> hosts <emc m&r.collector.com> where
<public> is the read-only community string

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.
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l Beginning with ViPR SRM 4.2, the SolutionPack for EMC Data Domain includes a
dedicated SNMP Data Collection Manager that allows you to discover EMC Data
Domain devices via Discovery Center through this SNMP Data Collection block.
Performance polling interval configurations only apply to devices discovered using
Discovery Center. However, if you prefer to discover EMC Data Domain devices
through SNMP Device Discovery and the Generic-SNMP collector, you can skip
installing this block. This option has been provided for backward compatibility.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next

The window displays pre-configured alert details.

10. From the Alerting on data collection drop-down list, select existing settings
that have been specified for other components, or select Add a new alerting
data collection.

If you select Add a new alerting on data collection, type information about the
alerting configuration. In Alerting Backend hostname or IP address, specify the
Primary Backend host.

11. Click Next. The window displays SNMP data collection details.

Beginning with ViPR SRM 4.2, the SolutionPack for EMC Data Domain includes
a dedicated SNMP Data Collector that allows you to discover EMC Data Domain
devices via Discovery Center through this SNMP Data Collection block.
However, you can skip installing this block if you prefer to discover EMC Data
Domain devices through SNMP Device Discovery and the Generic-SNMP
collector. This option has been provided for backward compatibility.

12. From the Data collection drop-down list, select existing settings that have been
specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

13. If you select Frontend Web service, drop-down list, select existing settings
that have been specified for other components, or select Add a new Frontend
Web service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

14. From the Topology Service drop-down list, select existing settings that have
been specified for other components, or select Add a new Topology Service.
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If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

15. Specify the SNMP Collector name, SNMP Collector port, and the
communication interface IP address. The default collector name is DataDomain-
SnmpCollector and the default port is 2006.

16. To configure polling period and polling group settings, select Configure
advanced settings.

The advanced settings are applicable only for the dedicated SNMP Data
Collector and are not applicable for the Generic-SNMP collector. Use caution
when configuring these settings. Improper settings will impact SNMP Collector
performance.

Performance data Polling period defines the frequency with which the
dedicated SNMP Collector polls the performance related data from the switch.

Topology Polling period defines the frequency with which the dedicated
SNMP Collector polls the topology related data from the switch.

All of the capabilities that are supported by the switch will be polled. For more
information about capabilities, refer to Capabilities.

Polling Group configuration consists of a group of switches and some of the
capabilities that are supported by those switches. You can optimize the
resources that are consumed by the dedicated SNMP Collector by tuning these
settings.

Property refresh time is the time at which the properties will be refreshed for
a polling group. The property refresh time format is HH:MM:SS, where HH is
hours, MM is minutes, and SS is seconds.

Start Polling Group at Defined period when enabled, will start the polling at
the next "round" period. Raw value timestamps will be accurate. For example, if
the polling period is set to 5 minutes, this would mean that the polling cycles will
start at 00:00, 00:05, 00:10, and so on.

Polling Group Start Time offset (s) is used to start different polling groups at
different times to avoid putting an excessive load on the dedicated SNMP
Collector. The polling for the polling groups will start one after the other with a
delay specified by this time offset. When setting a polling group start time
offset, consider the shortest polling period (performance or topology), the time
it takes for the SNMP Collector to poll the switch for the capabilities in the
polling group, and the number of polling groups. If the polling group start time is
too short, the load on the SNMP Collector will increase. If the polling group
start time is too long, the polling groups might not be finished polling within the
polling interval and the next polling period might start.

17. Click Next.

The window displays reports settings.

18. In Administration Web-Service Instance, select an existing instance.

19. Click Next.

The window displays a note about SNMP masks.

20. Click Install.

21. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.
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Adding and configuring devices
Before you begin

The SolutionPack for EMC Data Domain dedicated SNMP Data Collection Manager
must be installed. For more information about installing the SNMP Data Collection
Manager, refer to Installing the SolutionPack for EMC Data Domain installation.

The following procedure describes how to add devices individually using Discovery
Center. To add multiple devices at a time, use a discovery group. If the devices share
same credentials, the credentials are entered only once. For more information about
creating discovery groups, refer to Add devices using discovery.

Procedure

1. Click Discovery Center > Inventory Management.

2. Click EMC Data Domain.

3. Click Add new device.

4. Specify the details of the EMC Data Domain configuration. Do not enter spaces.

a. In the Device location section, select the server and instance where you
want to store the configuration details for this device.

b. In the Device IP address field, type the IP address of the device that is
supporting the SNMP agent.

c. In SNMP Port field, type the device SNMP agent listening port.

d. In SNMP Version field, type the device SNMP agent version. If you select
v3, select the authentication and encryption protocols, and specify the
passwords.

e. In the Community String/User Name field, specify the community name if
the SNMP version is v1 or v2c. Specify the username if the SNMP version is
v3.

5. To trigger discovery, click Validate and Add.

Discovery fetches minimal information about the device like the supported
capabilities.

The validation tests connectivity to the device using the provided information. If
an error indicator appears, correct the information and click Test to try again.

The Status column represents the discovery results. To view the discovery
results, click the status icon.

6. To trigger polling, click Save.

Polling is the periodic collection of the metrics and properties from the switch
that is based on the supported capabilities that are discovered.

Discover the SNMP Collector
Procedure

1. Log in to EMC M&R.

Use http://<localhost>:58080/device-discovery/.

2. Go to Collector > New Collector.
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This option collects configuration data from the SNMP Collector.

3. Click Save.

4. The Collector is listed with orange color in the STATE column.

5. To verify that the collector is reachable, and if it is, click Send configurations
to the x selected collector(s), click Check reachability of the x selected
collector(s).

The Collector is listed with green color in STATE.

6. Select Devices and click New Device.

7. Fill in the details for the new device on all tabs.

8. Click Save.

If the STATE column is green for the device, no error occurred. If an error
occurred, mouseover the STATE column for the device to display the error.

9. If STATE is green, click Execute Action. This action discovers the device with
the capabilities that are selected.

10. Go to the Dashboard and send the configurations.

11. Go to the device and check that the Collector is listed.

After you finish

If all steps are successful, device details begin to appear in the ViPR SRM User
Interface.

If you encounter any problems, use the Events Log to begin troubleshooting. For
example, the log might point to problems with SNMP communications or configuration
settings. To open the log, scroll to the bottom of the Device Discovery pane
(http://<localhost>:58080/device-discovery/#/devices) and click
Show Events Log.

Limitations

l The Device column of the Alerts report (Report Library >> EMC Data Domain >>
Operations) might be blank for some of the alerts. The source address that is
received from the alert trap notification corresponds to the network interface on
the Data Domain Replicator. The Data Domain Replicator might have multiple
interfaces that are configured. The SNMP service always binds to one address and
send all traps using that address. There is no option currently to select the source
address if the system has multiple interfaces.

l When discovering Data Domain Virtual Edition 3 (version 6.0.0.30-550720), the
following reports will be empty:

n Report Library >> EMC Data Domain >> Inventory >> Chassis Status >>
NVRAM Batteries

n Report Library >> EMC Data Domain >> Inventory >> Disks >> device, part
>> Temperature

n Report Library >> EMC Data Domain >> Inventory >> Disks >> device, part
>> Status >> Error Count

n Report Library >> EMC Data Domain >> Inventory >> NVRAM
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Overview
This SolutionPack enables users to generate real-time and historical reports on
replication technologies, EMC Data Domain backup-to-disk platform, backup
technologies for Symantec Netbackup, and EMC Avamar supported by Data
Protection Advisor.

Data collection methods
The SolutionPack collector uses REST API requests to fetch XML report files from the
DPA server (<EMC DPA Installation directory>\EMC\services\shared
\report-results\scheduled\<backuptechnology-selected>). When DPA
is added to Discovery Center, scheduled reports are created and generated once a
week. Once the scheduled reports are generated, report data is collected hourly.

The Stream Collector uses REST APIs to collect the data for the following:

l Symantec-NetBackup

l EMC-Avamar

l EMC-NetWorker

l IBM-Tivoli-Storage-Manager

l EMC-Recover Point

l Data Domain

Installing the SolutionPack

Before you begin

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l Ensure that libtinfo is present in /lib64/libtinfo. If not, then create a softlink
using the command: sudo ln -s /lib64/libncurses.so.5.6 /lib64/
libtinfo.so.5

Procedure

1. Login to the Primary Backend server via the command line.

2. Browse to the following location:

/opt/APG/bin/
3. Run the following command:

./mysql-client.sh

4. Type the root user password.

The default root user password is watch4net
5. Run the following command:

connect events;

6. Create the following table:
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Note

If you copy and paste the script, carriage return characters may exist at the end
of each line in the pasted version. You must use a text editor such as Notepad
to remove these characters.

CREATE DATABASE IF NOT EXISTS events;
GRANT ALL PRIVILEGES ON events.* TO apg@'localhost'
IDENTIFIED BY 'watch4net';
GRANT FILE ON *.* TO apg@'localhost' IDENTIFIED BY
'watch4net';
use events;
DROP TABLE IF EXISTS generic_backup;
CREATE TABLE IF NOT EXISTS `generic_backup` (
 `id` bigint(20) DEFAULT NULL,
 `appjobid` varchar(256) NOT NULL DEFAULT '',
 `openedat` int(11) NOT NULL,
 `datagrp` varchar(100) DEFAULT NULL,
 `prjobid` int(11) DEFAULT NULL,
 `bkpservr` varchar(100) DEFAULT NULL,
 `bkpos` varchar(100) DEFAULT NULL,
 `bkprev` varchar(100) DEFAULT NULL,
 `dpahost` varchar(100) DEFAULT NULL,
 `collhost` varchar(100) DEFAULT NULL,
 `collinst` varchar(100) DEFAULT NULL,
 `device` varchar(100) DEFAULT NULL,
 `clntos` varchar(100) DEFAULT NULL,
 `part` varchar(100) DEFAULT NULL,
 `ip` varchar(100) DEFAULT NULL,
 `partdesc` varchar(100) DEFAULT NULL,
 `parttype` varchar(100) DEFAULT NULL,
 `policy` varchar(100) DEFAULT NULL,
 `bkptech` varchar(100) DEFAULT NULL,
 `bkptype` varchar(100) DEFAULT NULL,
 `retlevel` varchar(100) DEFAULT NULL,
 `state` varchar(100) DEFAULT NULL,
 `mediasvr` varchar(100) DEFAULT NULL,
 `path` varchar(100) DEFAULT NULL,
 `lwatermk` varchar(100) DEFAULT NULL,
 `hwatermk` varchar(100) DEFAULT NULL,
 `stuid` varchar(100) DEFAULT NULL,
 `stutype` varchar(100) DEFAULT NULL,
 `capacity` varchar(100) DEFAULT NULL,
 `userdefined1` varchar(100) DEFAULT NULL,
`userdefined2` varchar(100) DEFAULT NULL,
 `userdefined3` varchar(100) DEFAULT NULL,
 `userdefined4` varchar(100) DEFAULT NULL,
 `userdefined5` varchar(100) DEFAULT NULL,
 `userdefined6` varchar(100) DEFAULT NULL,
 `userdefined7` varchar(100) DEFAULT NULL,
 `userdefined8` varchar(100) DEFAULT NULL,
 `userdefined9` varchar(100) DEFAULT NULL,
 `userdefined10` varchar(100) DEFAULT NULL,
 `userdefined11` varchar(100) DEFAULT NULL,
 `userdefined12` varchar(100) DEFAULT NULL,
 `userdefined13` varchar(100) DEFAULT NULL,
 `userdefined14` varchar(100) DEFAULT NULL,
 `userdefined15` varchar(100) DEFAULT NULL,
 `systemdefined1` varchar(100) DEFAULT NULL,
 `systemdefined2` varchar(100) DEFAULT NULL,
 `systemdefined3` varchar(100) DEFAULT NULL,
 `systemdefined4` varchar(100) DEFAULT NULL,
 `systemdefined5` varchar(100) DEFAULT NULL,
 PRIMARY KEY (`appjobid`, `openedat`)
) ENGINE=MyISAM DEFAULT CHARSET=utf8;
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7. Click Administration .

8. Click Centralized Management.

9. Click SolutionPack Center.

10. Select the SolutionPack in the Browse and Install SolutionPacks window.

11. Click Install.

12. Type the instance name.

13. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

14. Click Next.

The window displays a note about Alert Consolidation.

15. Click Next.

The window displays data collection details.

16. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

17. In the Event server hostname or IP address text box, accept the default,
which is the Primary Backend.

18. In the Event server port number text box, accept the default port of 22020.

19. From the Event database drop-down list, select the Primary Backend.

20. From the Alert Consolidation drop-down list, select existing settings that have
been specified for other components, or select Add a new Alert consolidation.

If you select Add a new Alert consolidation, type information about the alert
configuration. In Alerting HostName or IP address, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

21. Select the backup technologies to monitor.

If you do not select any of these options, there will be no DPA reports to
collect. If you select all of these options, data will be collected for all DPA
reports.

22. Select Enable EMC DataProtectionAdvisor Alerts.

23. To configure the alert polling interval, select Do you want to configure
advanced settings.

By default, the polling interval for Data Protection Advisor backup alerts is 5
minutes. You can change the polling period to 30 minutes.

24. Click Next.

The window displays reports settings.

25. Click Install.

26. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.
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27. Click Discovery Center > Inventory Management.

28. Click EMC Data Protection Advisor.

29. Click Add new device.

30. In DPA appliance Host name or IP, type the host information for the DPA
appliance.

31. Provide the administrator access credentials for the DPA appliance.

Administrator privileges are needed so that users can schedule reports on the
DPA Server.

32. Provide the protocol and DPA server port.

33. To validate the credentials, click Validate and Add.

34. Click Ok.

35. Click Save.

DPA requires specific licenses to monitor replication technologies, backup
technologies, and Data Domain. These licenses must be installed on DPA for
ViPR SRM to monitor these technologies.

DPA reports may take up to 1 hour to populate. Some of the performance data/
graphs take two collection cycles for the graphs to be plotted.

After installing the SolutionPack for EMC Data Protection Advisor, there may
be scheduling related errors in the collector logs.

Verifying scheduled reports in DPA
Once DPA is added to Discovery Center, ViPR SRM connects to DPA with the
username specified and creates scheduled reports for the backup technology
selected.

Procedure

1. Login to DPA.

2. Browse to Reports > Report Jobs > Scheduled reports.

Report names starting with W4N - should be created hourly.

3. On the DPA server console, XML files should be seen in the directory <EMC
DPA Installation directory>\EMC\services\shared\report-
results\scheduled\<backuptechnology-selected>.

Troubleshooting report generation errors
Reconfigure the data collection options in the SolutionPack for EMC Data Protection
Advisor if reports are not being generated. This procedure applies to each DPA
instance for which reports are not being generated.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPacks.
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4. Click EMC Data Protection Advisor.

5. Within the Instance column, click the edit icon to reconfigure the Data
Collection component.

6. Select the technology that you want to collect data from.

7. Select Do you want to configure advanced settings and enable Number of
collecting threads, if required.

8. Click Reconfigure.

Limitations
l When you click a device in the Alerts tab of the Report Library >> EMC Data

Protection Advisor >> Operations report, the link incorrectly displays the
Explore All Hosts summary report.

l There could be a difference in the number of jobs that are reported by the DPA UI
and the SolutionPack for EMC Data Protection Advisor. This occurs when an All
Jobs report for the last hour is scheduled in DPA. The scheduled All Jobs report
causes completed and failed jobs to be dumped to an XML file on the DPA server,
which is not counted by ViPR SRM, hence the difference.

l When collecting data from newer versions of DPA, such as versions 6.2.2, 6.2.3,
and 6.3, the following reports will be empty because these versions of DPA do not
support them:

n Report Library >> EMC Data Protection Advisor >> Inventory >> Data
Domain >> Hosts >> [host] >> Performance >> Fibre Channel Port
Performance

n Report Library >> EMC Data Protection Advisor >> Inventory >> Data
Domain >> Hosts >> [host] >> Performance >> Total Throughput

n Report Library >> EMC Data Protection Advisor >> Inventory >> Data
Domain >> DD Modes

n Report Library >> EMC Data Protection Advisor >> Inventory >> Data
Domain >> Hosts >> [host] >> Statistics >> MTree Daily Compression
Statistics

n Report Library >> EMC Data Protection Advisor >> Inventory >>
Replication >> RPO Compliance >> Compliance
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Overview
The SolutionPack for EMC ECS collects inventory, capacity, performance, and health
metrics for object storage on EMC ECS systems. Detailed metrics for the virtual data
centers, nodes, and disks for object storage that ECS manages are included.

Installing the SolutionPack for EMC ECS

Before you begin

l EMC ViPR SRM core modules must be up-to-date in all servers because not all
module dependencies are validated during the SolutionPack installation or update
process.

l For each ECS Virtual Data Center (VDC) that you want to collect metrics for:

n Have the public IP address for one of the nodes in one of the ECS racks (as a
convention, you might use the first node in the first rack)

n Have the username and password

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. From the Alerting on data collection drop-down list, select the Primary
Backend host.

11. Click Next.

The window displays data collection details.

12. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

13. In Alerting Backend hostname or IP address, type the Primary Backend host.
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14. In Alert Listener Port, type the port that is used for alert consolidation.

15. From the Topology Service drop-down list, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology Service, type information about the topology
service. In Topology Service hostname or IP address, specify the Primary
Backend host.

16. To configure polling settings or to disable a polling type, select Use advanced
settings.

17. In each polling period drop-down list, select a polling period or select Disabled
to turn off the polling.

18. Click Next.

The window displays reports settings.

19. Click Install.

20. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

21. Click Discovery Center > Inventory Management.

22. Click EMC ECS.

23. Click Add new device.

For ECS, a device is a VDC, and the term ECS system refers to a VDC. A VDC
consists of one or more ECS appliances (racks) with 4 or eight nodes each and
attached storage systems.

In a multi-site federation of VDCs, provide information for each VDC as a
separate device.

24. Verify that the first two fields are correct for the collection instance.

25. In Virtual Data Center name, type the VDC name as configured in ECS.

26. In IP address or host name, provide the public IP address for one of the nodes
in one of the ECS racks in the VDC. For example, use the public IP address for
the first node in the first rack in the VDC.

27. For Username and Password, provide the credentials that are configured for
the VDC.

User with System Monitor role is required as the minimum privilege.

28. For Configured for remote replication, check this box if the VDC is part of a
geo-replicated federation of VDCs.

When you check this box, the Collect namespace and bucket data field
appears.

29. In Collect namespace and bucket data, check this box for only one of the
VDCs in a geo-replicated federation of VDCs.

This field configures the 1 VDC in the geo-replicated federation that provides
the namespace and bucket metrics for reporting.

Note

Enabling namespace and bucket data from multiple VDCs in a geo-replicated
federation causes duplicate counting and duplication of billing data.
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30. To validate the credentials, click Validate and Add.

31. Click Ok.

32. Click Save.

It takes approximately 3 hours for data to start appearing on reports from the
new VDC.

33. To add another VDC, click Add new device and provide information for another
VDC.

Note

In a multi-site federation, add each VDC in the federation, but collect
namespace and bucket data for only one of them.

Remove old ECS hosts from the Physical Host SP
This procedure applies if you are upgrading from ECS powered by ViPR 2.1.

In the older system, the ECS hosts were added manually to the Physical Host list and
monitored by the Physical Host SolutionPack. In ECS 2.0 and later systems, the ECS
hosts monitors the SolutionPack for ECS automatically. Remove the hosts from the
Physical Host list.

Note

This step is optional. However, metrics will no longer be reported for these hosts from
this location, so there is no benefit to leaving them.

Procedure

1. In the ViPR SRM Console, browse to Administration  > Centralized
Management  > Discovery Center > Inventory Management .

2. Click the first column for each ECS host.

3. Click Delete, and then click Save.

Expand ECS
You can expand an existing VDC by adding more storage, more nodes, or more ECS
racks, without any additional configurations in ViPR SRM.

A new VDC must be added into Discovery Center as a new device before ViPR SRM
can collect metrics for it.

Procedure

1. Browse to Administration  > Centralized Management > Discovery Center.

2. Click EMC ECS.

3. Click Add new device.

4. Verify that the first two fields are correct for the collection instance.

5. In Virtual Data Center name, type the VDC name as configured in ECS.

6. In IP address or host name, provide the public IP address for one of the nodes
in one of the ECS racks in the VDC. For example, use the public IP address for
the first node in the first rack in the VDC.
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7. For Username and Password, provide the credentials that are configured for
the VDC.

User with System Monitor role is required as the minimum privilege.

8. For Configured for remote replication, check this box if the VDC is part of a
geo-diverse federation of VDCs.

When you check this box, the Collect namespace and bucket data field
appears.

9. In Collect namespace and bucket data, check this box for only one of the
VDCs in a geo-replicated federation of VDCs.

Configure 1 VDC in the federation to provide the namespace and bucket
metrics.

Note

Enabling namespace and bucket data from multiple VDCs in a geo-replicated
federation causes duplicate counting and duplication of billing data.

10. Click Test to validate the credentials.

11. Click Ok.

12. Click Save.

It takes approximately take 3 hours for data to start appearing on reports from
the new VDC.

13. To add another VDC, click Add new device and provide information for another
VDC.

Note

In a replicated federation, add each VDC in the federation, but configure
namespace and bucket data for only one of them.

Limitations

l The SolutionPack for EMC ECS has visibility into the ECS storage capacity that is
configured for objects, and not for other types of storage. Consequently, in the
Enterprise Capacity Dashboard, the SolutionPack for EMC ECS only contributes
to the Configured Usable, Used, Pool Free, Used For Object, and Primary Used
capacities.
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SolutionPack for EMC Host Interface
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Overview
This SolutionPack discovers physical servers through the EMC Host Interface, and
provides a global view of hosts in a data center. The EMC Host Interface deploys an
SMI compliant provider on Windows hosts to collect data.

The SolutionPack provides the ability to analyze on host topology, capacity utilization,
and performance measurements on hosts. In addition, the SolutionPack reports host
capacity by summarizing storage LUNs mapped on host file systems and provides a
detailed report on storage capacity.

Note

This SolutionPack does not contain reports. Install the reports from the SolutionPack
for Physical Hosts.

Note

For an overview of physical host discovery mechanisms, see Physical host discovery.

Installing the EMC Host Interface on Windows Server
The EMC Host Interface is host agent software which enables ViPR SRM to collect
data from supported hosts without requiring host credentials.

The EMC Host Interface software is installed as a Windows service on supported
Windows hosts to enable data collection between the host and Storage Resource
Management Suite.

The installer automatically installs a prerequisite (Microsoft Visual C++
Redistributable) before installing the EMC Host Interface software.

Note

While upgrading the EHI Agent to 1.4.1 using interactive mode, you must manually
remove the old installation using the Programs and Features option in Control Panel
to avoid a restart.

Installing or upgrading using the command line
You can choose local or LDAP authentication when installing or upgrading the EMC
Host Interface using the command line. For both local and LDAP authentication, local
database files are protected and encrypted using the RSA Common Security Toolkit.

Local authentication
The local authentication option installs a database on the local host which maintains
authentication with a username and password.

LDAP authentication
The LDAP authentication option configures authentication using an LDAP server
providing centralized control of authentication credentials.
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Installing or upgrading with LDAP authentication
Install the EMC Host Interface and configure LDAP authentication using the command
line.

Before you begin

Consult the EMC ViPR SRM Support Matrix for information on supported Windows
host operating systems on which you can install EMC Host Interface software.

This procedure describes the commands and parameters that are used to install the
EMC Host Interface on a single server. You can also run the installer using remote
push technology that supports MSI/EXE and use the parameters and push technology
options to control the installation.

Procedure

1. Download the EMC Host Interface Setup File to a temporary location on the
local host.

2. Open a command prompt and browse to the temporary location.

3. Construct the executable syntax from the command line using the following
security parameters.

Option Description

SECURITY LDAP - Use provided LDAP Authority.

USER Represents LDAP user to be given access rights.

LBPASS Password to be given to secure lockbox store holding
LDAP configuration information, min length 8, max
length 40, alpha number mix required, mixed case
required. Default: #1Password

PORT Port number of the LDAP service. Default: 389

SERVER Hostname or IP Address of the LDAP server to use for
authentication. There is no default value.

DOMAIN Distinguished Name (DN) of the privileged account used
to perform operations, such as searching users and
groups, on the LDAP directory. There is no default value.

BINDPASS Password of the privileged account for accessing LDAP
server. There is no default value.

USERSEARCH DN of the node at which to begin user searches.

GROUPSEARCH DN of the node at which to begin group searches. There
is no default value.

CONFIGNAME Name of this LDAP configuration/authority, when
logging with agent pack use CONFIGNAME/USER. There
is no default value.

USEROBJCLASS
(EHI 1.2)

VALUE of the objectClass attribute of a user. Any of the
attribute values on your LDAP server (person,
organizationalPerson, user) can be specified.

USERNAMEATTR
(EHI 1.2)

Similar to USERIDATTR, supply an attribute name that
contains the value of the username.
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Option Description

USERIDATTR
(EHI 1.2)

Attribute name that contains a value of the username.
On LDAP servers, any one of the following attribute
names can be used: cn, displayName, givenName, name,
sAMAccountName. All of these attributes appear to
contain the value of the username.

GROUPOBJCLASS
(EHI 1.2)

VALUE of the objectClass attribute of a group. On LDAP
servers, 'group' indicates a group class.

GROUPNAMEATTR
(EHI 1.2)

Attribute name of a group entry that contains a value of
the group name. Instead of mapping each user
individually to a role, a group can be mapped to the
administrator role. After mapping a group, all users
within this group have administrator rights. On LDAP
servers, the attribute 'cn' appears to contain the group
name.

GROUPMEMATTR
(EHI 1.2)

Attribute name of a group entry that contains the list of
users within a group.

INSTALLDIR
(EHI 1.2)

User defined directory for EHI installation.

4. Establish LDAP authentication as shown in the following example:

If you want to run the installation or upgrade in silent mode, use the /quiet
option at the end of the command. (Upgrade is only supported on 64-bit hosts.)

For EHI 1.1:

Emc-host-interface.exe SECURITY=LDAP USER=myldapuser LBPASS=
$4Secret PORT=389 SERVER=ldap.company.com DOMAIN=”uid=admin, 
ou=Administrators,ou=TopologyManagement,o=netscaperoot” 
BINDPASS=Password 
USERSEARCH=”ou=People,dc=emc,dc=localdomain” 
GROUPSEARCH=”ou=Groups,dc=emc,dc=localdomain” 
CONFIGNAME=”company.localdomain”

For EHI 1.2:

Emc-host-interface.exe SECURITY=LDAP USER=myldapuser LBPASS=
$4Secret PORT=389 SERVER=ldap.company.com DOMAIN=”uid=admin,
ou=Administrators,ou=TopologyManagement,o=netscaperoot”
BINDPASS=Password USERSEARCH=”ou=People,dc=emc,dc=localdomain”
GROUPSEARCH=”ou=Groups,dc=emc,dc=localdomain”
CONFIGNAME=”company.localdomain” USEROBJCLASS="objectClass 
attribute of a user" USERNAMEATTR="attribute name" 
USERIDATTR="attribute name"
GROUPOBJCLASS="objectClass attribute of a group" 
GROUPNAMEATTR="attribute name of a group entry that contains 
a value of the group name"
GROUPMEMATTR="attribute name of a group entry that contains 
the list of users within a group" INSTALLDIR="Instalation 
Directory"

Results

You can use these credentials when accessing the host using the SolutionPack for
Physical Hosts. For example, use credentials:
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Username: company.localdomain/myldapuser or
myldapuser@company.localdomain
Password: ldap_user_password

After you finish

Verify installation by accessing the log file in: install_dir\log
\installation.log
Troubleshoot runtime issues by accessing the log file in: install_dir\log
\cimomlog.txt

Installing or upgrading with local authentication
Install or upgrade the EMC Host Interface from the command line using the LOCAL
authentication option.

Before you begin

Consult the EMC ViPR SRM Support Matrix for information on supported Windows
host operating systems on which you can install EMC Host Interface software.

This procedure describes the commands and parameters that are used to install the
EMC Host Interface on a single server. You can also run the installer using remote
push technology that supports MSI/EXE and use the parameters and push technology
options to control the installation.

Procedure

1. Download the EMC Host Interface Setup File to a temporary location on the
local host.

2. Open a command prompt and browse to the temporary location.

3. Construct the executable syntax from the command line using the following
security parameters.

Option Description

SECURITY LOCAL - database that is maintained on local server

USER Username for authentication. Default: admin

LBPASS Password to be specified to LOCAL user, min length 8, max
length 40, alpha number mix required, mixed case required.
Default: #1Password

4. Do one of the following:

If you want to run the installation or upgrade in silent mode, use the /quiet
option at the end of the command. (Upgrade is only supported on 64-bit hosts.)

l Establish local authentication using the default credentials (admin/
#1Password) as shown in the following example: C:/temp/Emc-host-
interface.exe

l Specify local authentication and provide the own credentials as shown in the
following example: C:/temp/Emc-host-interface.exe
SECURITY=LOCAL USER=myaccount LBPASS=$4Secret

Results

You can use these credentials when accessing the host using the SolutionPack for
Physical Hosts.
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After you finish

Verify installation by accessing the log file in: install_dir\log
\installation.log
Troubleshoot runtime issues by accessing the log file in: install_dir\log
\cimomlog.txt

Installing or upgrading the EMC Host Interface using the
GUI

Install or Upgrade the EMC Host Interface using the GUI.

Before you begin

Consult the EMC ViPR SRM Support Matrix for information on supported Windows
host operating systems on which you can install EMC Host Interface software.

The GUI installation is not supported with Server Core installations of Windows
Server. Server Core installations require the command line installation.

Procedure

1. Download the EMC Host Interface executable (emc_host_interface-
versionplatform) to a temporary location on the local host.

2. Browse to the temporary location, double-click the executable, and click Run.

The EMC Host Interface installation wizard displays.

3. Click Next.

4. Accept the license agreement.

5. Click Next.

6. Specify the installation directory.

For upgrades, you must accept the default installation directory where the
previous version was installed.

7. Click Install.

8. After the installation is complete, click Finish.

9. Click Close.

10. Verify that two EMC Host Interface processes (EMCHost.exe) have been
created and are running.

In earlier versions of the EMC Host Interface, the processes were named
ECOM.exe.

Installing the SolutionPack

Note

The SolutionPack for EMC Host Interface supports alerts and uses the same alerting
component as the SolutionPack for Physical Hosts. To configure alerts for the
SolutionPack for EMC Host Interface, install the alerting block from the SolutionPack
for Physical Hosts.
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Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays data collection details.

9. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

10. Leave Enable Topology Backend on data collected checked.

11. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

12. To configure polling settings, specify the number of collecting threads, and
specify the time to wait for data to be received, click Do you want to configure
advanced settings.

13. Click Install.

14. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

15. Click Discovery Center > Inventory Management.

16. Click Host Agent (EHI).

These steps describe how to add hosts individually. For information about using
discovery groups to use the same credentials to discover multiple hosts, refer to
the "Adding new devices" topic in the online help.

17. Click Add new device.

18. Select the server and collector instance where you want to store the
configuration details for this device, and then enter the hostname or IP address
of the host, supply the login credentials, and specify the appropriate
configuration settings.
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19. To validate the credentials, click Validate and Add.

20. Click OK.

21. Click Save.

Recommendations
l Do not discover the same host using agentless discovery and agent-based

discovery. Simultaneous discovery results in duplicate data collection. If you
switch from agentless discovery to agent-based discovery (or vice versa), the
metrics that are collected from the previous discovery mechanism become
inactive.

Limitations
l Windows hosts discovered via the EHI Agent display all of the IP addresses (IPv4

and IPv6) in reports. This is unlike hosts that are discovered via agentless
discovery, which only display the primary IP address.

l The Related Host report is not populated for hosts that are discovered via the EHI
Agent.

l If you add or remove a LUN and this information is not reflected on reports, you
must manually restart the EHI Agent on the host.

l The Path Performance metrics in the Explore reports are not populated for hosts
that are discovered through EMC Host Interface.
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CHAPTER 14

SolutionPack for EMC Isilon

This chapter includes the following topics:

l Overview.......................................................................................................... 108
l Installing the SolutionPack................................................................................108
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Overview
The SolutionPack for EMC Isilon optimizes service availability for the EMC Isilon
scale-out NAS storage solution and displays the data in easy-to-use reports within
ViPR SRM.

This SolutionPack enables you to see and understand performance and utilization
across EMC Isilon devices in real-time, to know which node is the bottleneck in a
cluster, what the peak/busy hours are, and more.

Installing the SolutionPack

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

12. Leave Enable Topology Backend on data collected checked.

13. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.
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14. In Alert Consolidation server hostname or IP address, type the Primary
Backend host.

15. In Alert Consolidation server port number, type the port that is used for alert
consolidation.

16. Optionally, select Use advanced settings to configure polling.

17. Click Next.

The window displays reports settings.

18. Click Install.

19. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

20. Click Discovery Center > Inventory Management.

21. Click EMC Isilon.

These steps describe how to add hosts individually. For information about using
discovery groups to use the same credentials to discover multiple hosts, see 
Adding devices to discovery groups.

22. Click Add New Device.

23. In the Cluster hostname or IP address field, type the hostname or IP address
of the SmartConnect service, or of any node in the cluster.

24. Type the username (default is admin).

25. Type the password.

26. To validate the credentials, click Validate and Add.

27. Click Ok.

28. Click Save.

Limitations

l Isilon RestAPI has a limitation that it cannot get StoragePool information for
OneFS 7.0. So the Isilon SolutionPack cannot show any StoragePool information
on OneFS 7.0. StoragePool information is only available for OneFS 7.1 and above.

l When discovering Isilon OneFS 7.x arrays, it is possible that the following errors
will occur when testing authentication with the device:
javax.net.ssl.SSLProtocolException: handshake alert:
unrecognized_name. These messages can be safely ignored unless they are
also found in the SolutionPack for EMC Isilon collecting logs.

l Starting from SRM 4.2, while discovering EMC Isilon devices which now use
Stream Collector for data collection, if BufferOverflowException is seen in logs
with the error as shown, increase the buffer_zize value set in socketconnector.xml
with respective to Collector Manager. New value to be increased such that the
issue no more occurs, considering the available system memory.

AbstractStreamHandlerJob::prepareNextStep(): Error executing 
handler XmlReader
java.nio.BufferOverflowException
at java.nio.HeapByteBuffer.put(HeapByteBuffer.java:189)
at java.nio.ByteBuffer.put(ByteBuffer.java:859)
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at 
com.watch4net.apg.v2.collector.plugins.SocketConnector.pushData(
SocketConnector.java:392)
at 
com.watch4net.apg.v2.collector.AbstractCollector.pushNext(Abstra
ctCollector.java:56)

Note

If the size of the response that is obtained over API is greater than 32KB for any
API request that is issued during Isilon data collection, increasing the buffer size
value will fix the issue. Do not look into the metrics for incrementing the buffer
size as the metrics will never get collected if parsing fails.
BufferOverFlowException occurs in the stage of data parsing. Hence, if issue
occurs, APIs responses to be examined and buffer_size set accordingly.
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CHAPTER 15

SolutionPack for EMC M&R Health

This chapter includes the following topics:
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Overview
This SolutionPack monitors the health of the EMC M&R infrastructure. Take
advantage of this no-charge SolutionPack to keep the EMC M&R services performing
optimally, so you have instant access to performance data and reports when you need
it.

Installing the SolutionPack
Install this SolutionPack on all core software hosts in the environment.

Before you begin

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays pre-configured alert details.

9. Click Next.

The window displays data collection details.

10. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

11. From the Alerting on data collection drop-down menu, select existing settings
that have been specified for other components, or select Add a new alerting
data collection.

If you select Add a new alerting on data collection, type information about the
alerting configuration. In Alerting Backend hostname or IP address, specify
the Primary Backend host.

12. Select Configure advanced settings to configure polling settings.

13. Click Next.

The window displays reports settings.
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14. Click Install.

15. Click Ok once installation is complete.

Performance data will be displayed in about an hour.
The following message might appear in the collection log during operation:

WARNING -- [2014-04-25 05:26:38 EDT] -- f::a(): JVM IO ERROR 
'No such process'. ID: '17032', NAME: 'lib/module-manager.jar 
exit'. 

You can ignore this message.
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Overview
The SolutionPack for EMC RecoverPoint enables users to generate real-time and
historical reports on the performance of the mechanisms that replicate data from any
supported SAN-based arrays to other SAN-based arrays.

Summary reports for key components--such as RecoverPoint Appliance (RPA),
Clusters, and Consistency Group Metrics, as well as I/O throughput analysis for SAN
system traffic--provide a deeper understanding of replication schemes and the
policies that govern them.

Installing the SolutionPack
Before you begin

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l Ensure that the RecoverPoint appliance is reachable and that you can execute
REST API commands from the Collector host. The ports used by RecoverPoint
and the Collector host should be unblocked. For more information about
RecoverPoint REST API commands, refer to the RecoverPoint 4.0 REST API Guide
(https://community.emc.com/docs/DOC-62710).

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays data collection details.

9. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

10. Select Use advanced settings to configure capacity and performance polling
settings.

11. Click Next.

The window displays reports settings.

12. From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add a new Web-Service
Gateway.

SolutionPack for EMC RecoverPoint

116 EMC ViPR SRM 4.2.1  SolutionPack Guide

https://community.emc.com/docs/DOC-62710


If you select Add a new Web-Service Gateway, type information about the
web-service gateway.

13. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

14. Click Install.

15. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

16. From Centralized Management, click Discovery Center > Inventory
Management.

17. Click EMC RecoverPoint.

18. Click Add new device.

19. Enter the FQDN hostname and authentication details for your RecoverPoint
system.

20. Click Validate and Add to validate the credentials.

21. Click Ok.

22. Click Save.

It will take approximately three hours for data to start appearing in reports.

Note

Only one RPA Cluster management IP address is required to discover data from
the whole RecoverPoint System. Adding each RPA Cluster in the RecoverPoint
System as a separate device is not required.

Configuring RecoverPoint appliance for alert consolidation
Procedure

1. Log in to the EMC RecoverPoint appliance as an administrator.

2. Type #get_snmp_settings, and press Enter.

3. Type #config_snmp_trap_dest, and press Enter.

l Type the clustname when prompted.

l Type the primary backend: port (primary backend is the default node for
installation of alerts blocks for RecoverPoint SolutionPack).

Example: 10.10.10.10:2041 (where 10.10.10.10 is the IP of primary backend, 2041
is the default port for alert processing in SRM. In a single vApp installation, this
parameter is the ViPR SRM IP, and in a distributed environment, is the Backend
server's IP).

4. Type #enable_snmp, and press Enter.

To test the configuration, enable SNMP Test in alerting frontend (

Alert definitions -> EMC Recoverpoint alert definitions -> Test -> Other
).

Type the command #test_snmp on RecoverPoint console and this test alert will
show up in Report Library -> EMC RecoverPoint -> Operations -> Alerts.
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Limitations
l RecoverPoint SolutionPack displays one consolidated splitter per ESXi cluster.
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l Installing the SolutionPack for EMC ScaleIO.................................................... 120
l Limitations.........................................................................................................121
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Overview
The SolutionPack for EMC ScaleIO collects capacity, inventory, and performance data
from ScaleIO REST Gateways and displays the data in easy-to-use reports within ViPR
SRM.

Capacity reports provide details on free capacity, used capacity, and spare capacity at
system level. Capacity reports per storage pools, per data servers, per drive, and per
protection domain levels provide details on free capacity and used capacity. Inventory
reports provide details on the data servers, storage pools, protection domains, drive
components, snapshots, and volumes. Performance reports provide detailed ScaleIO
performance metrics.

Installing the SolutionPack for EMC ScaleIO
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.

Before you begin

l Core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays data collection details.

9. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

10. From the Frontend Web service drop-down list, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

11. From the Topology Service drop-down list, select existing settings that have
been specified for other components, or select Add a new Topology Service.
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If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down list, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

12. In Alert consolidation server hostname or IP address, select the Primary
Backend host.

13. In Alert consolidation server port number, select the port that is used for
alert consolidation (default: 2020)

14. Select Do you want to configure advanced settings to configure polling
settings.

15. Click Install.

16. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

Adding and configuring devices in Discovery Center
Procedure

1. Click Discovery Center > Inventory Management.

2. Click EMC ScaleIO.

3. Click Add new device.

4. In ScaleIO REST Gateway IP or hostname, type the IP Address, name, or
FQDN of the ScaleIO REST Gateway host to be configured.

5. Type Failover ScaleIO rest Gateway IP or Hostname, if you have configured
one in the environment.

6. In ScaleIO username, type the username for the ScaleIO REST Gateway.

7. In ScaleIO password, type the password to access the ScaleIO REST Gateway.

8. To validate the credentials, click Validate and Add.

9. Click Ok.

10. Click Save.

Limitations

l CSV files that were exported from Discovery Center with a release earlier to ViPR
SRM 3.7 cannot be used to import devices into ViPR SRM 4.0. To import devices
using the earlier ViPR SRM CSV file, delete the "version" column prior to
importing.

l The Availability metric for ScaleIO disks is not available from the ScaleIO array.
Therefore, the Availability metric cannot be displayed in the All LUNs and IP
based disk host reports.

l If multiple Storage Pools have the same name, and the respective Protection
Domains names are missing or null, only one of the Storage Pools will be listed in
the Storage Pools report.

l In the Operations >> Inactive Devices and Components >> Devices with
Inactive Metrics Global report, the count of inactive metrics is less than that
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shown in the Report Library >> EMC ScaleIO >> Operations >> Inactive
Metrics report. This is because only the ScaleIO capacity related metrics are
passed to the Global inactive metric report as others are filtered out by the
w4ncert property. By design, the ScaleIO report has no such filter so that all of
the inactive metrics are displayed.

l If alerts get cleared or acknowledged in the ScaleIO Dashboard (Element
manager) the same will not be immediately reflected in the ViPR SRM alerts
dashboard. To clear the generated ScaleIO alert, you must either manually close/
acknowledge the alert in the ViPR SRM alerts dashboard or wait for ViPR SRM to
clear the alert automatically."

l The UsedCapacity value for ScaleIO is temporarily increased with the addition of a
ScaleIO Data Server Node. The UsedCapacity value returns to the correct value
after some time.

l Storage Pool names in the reports are shown as prefixed with the respective
protection domain names (<PD name>-<SP name>) to ensure uniqueness of
Storage Pool names across different protection domains:

n Dashboards >> Storage >> Enterprise Capacity Dashboard >> Usable
Capacity by Pool

n Explore >> Storage Capacity >> Storage Pools

n Explore >> Storage >> Storage Systems >> <ScaleIO Device> >> Capacity
>> Usable Capacity by Pool

n Report Library >> EMC ScaleIO >> Capacity >> Enterprise Capacity
Dashboard >> Usable Capacity by Pool
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Overview

The SolutionPack collects performance, topology, and capacity data from your Unity,
VNX, and VNXe systems and displays the data in easy-to-use reports.

With this SolutionPack, you can unify your view of multiple Unity, VNX, and VNXe
systems, including physical storage to host relationships. Capacity reports, such as
Raw Capacity Usage, Usable Capacity, and Usable Capacity by Pool, help you to
improve the availability of business critical applications and services by ensuring that
those applications have the storage resources they need to operate effectively.
Performance reports provide key performance indicators for such fundamental
resources as LUNs, Disks, and File Systems.

VNX prerequisites
The following sections apply when discovering VNX Block Only, VNX Unified/File, and
VNX NAS Gateway/eNAS array types. These sections do not apply for Unity/VNXe2
array types. There are no discovery prerequisites for Unity/VNXe2 array types.

l Preparing your VNX for discovery and data collection

l Configuring simple authentication

l Unisphere security file authentication

l Configuring VNX arrays for file storage discovery

Preparing your VNX for discovery and data collection
Identify the information required to support resource discovery and data collection
before installing the SolutionPack and perform the necessary pre-configuration.

ViPR SRM uses Navisphere Secure CLI (NavisecCLI) to access the VNX arrays.
NavisecCLI needs to be configured to the "low" security level to properly
communicate with the arrays. In a vApp deployment, this is the default setting.
However, for a binary install, be sure that you install NavisecCLI with the "low"
security level.

EMC recommends matching Naviseccli versions with Block Operating Environment
versions of VNX systems configured in the Collector. For information on compatible
Block OE and Naviseccli versions, refer to the VNX OE for Block Release Notes and the
Unisphere Host Agent/CLI and Utilities Release Notes on EMC Online Support.

For block and unified data collection, you must enable statistics logging on the array.
To enable statistics logging, refer to Unisphere documentation.

To prevent ViPR SRM discovery issues after a VNX control station failover, ensure
that the srmuser home directory exists on both the active and secondary control
stations. When a Global or LDAP user is first created on a VNX, the user's home
directory is created on the active control station. When the first failover to the
secondary control station occurs, the VNX does not create the user's home directory
on the secondary control station. Manually create the home directory on the
secondary control station if needed.
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Configuring simple authentication
You can configure simple authentication with VNX arrays using the default ViPR SRM
account.

In order to poll and collect performance statistics from a VNX array, administrator
privileges are required for the user account used to access the arrays.

Note

The preferred method for secure polling and collection of data from VNX arrays is to
configure authentication using a Unisphere security file. Refer to Unisphere security
file authentication.

Procedure

1. Configure the default ViPR SRM account (apg) with administrator privileges to
access the VNX array as described in the Unisphere documentation.

2. Validate access to the VNX array by running the following block command:
naviseccli -h (host) -user username -password password -scope 0
getagent

Unisphere security file authentication
A Unisphere security file is the preferred method to provide secure polling and data
collection from VNX arrays.

When you create a security file, the username you use to log in to the current host is
automatically stored in the security file, or you can specify an alternative username for
the security file in the -AddUserSecurity request using the optional -user switch.
If you omit the -user switch, the security file uses your current username. You can
also target the security file at a specific storage system using the -ip option.

You can store the security file on the Collector host and edit parser XML files to
include this path which will provide the required authentication to access the arrays.

Note the following:

l By default, the security file is stored in your default home directory. With
NavisecCLI, you can specify an alternative file path using the optional -
secfilepath switch.

l Security files are generated exclusively for use by the user who creates them. By
default, the EMC VNX collector manager runs under the accounts apg (for Linux)
or SYSTEM (for Windows). In order to use a Navisphere CLI security file in this
default configuration, the security file must be created using the above
account(s). If the collector is configured to run as a different user (such as in the
scenario described in the EMC White Paper Running Windows Collector Services
Using Least Privileges, https://community.emc.com/docs/DOC-36060), the
security file to be used by the collector must have also been created by that same
user account.

l Important: For VNX collectors running on Windows, explicitly specifying the full
security file path is required when configuring VNX discoveries, even if the
security file resides in the default %USERPROFILE% directory.

l Once the security file exists, you can edit XML configuration files that are used to
poll and collect data to specify the path to the security file on the Collector host.
The security file handles authentication.
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l For details on configuring a security file on a host, refer to the Unisphere
documentation.

Configuring VNX arrays for file storage discovery
Learn how to configure VNX arrays for file storage discovery.

Procedure

1. Log into Control Station as the root user.

2. Open the nas_mcd.cfg configuration file in the /nas/sys/ directory.

3. Enable the XML–API service by uncommenting the following entry:

daemon "XML API Server"
        executable      "/nas/sbin/start_xml_api_server"
        optional        yes
        canexit         yes
        autorestart     yes
        ioaccess        no

4. Type # service nas start, and press Enter to restart the XML-API service.

5. If you have multiple VNX arrays in your storage environment, repeat this
procedure on each VNX array.

Installing the SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.

Before you begin

l Core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l The ViPR SRM Alerting Guide explains how to configure alerts consolidation.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. Make a selection in the Alerting on data collection field.
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If you select Add a new Alerting on data collection, select the appropriate
value from the drop-down menu in the Alerting Web-Service Instance field.

11. Click Next.

The window displays data collection details.

12. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

13. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

14. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

15. In Event server hostname or IP address, select the Backend host on which
the Events Listener is installed.

16. In Event server port number select the port number for the event server.

17. Select Configure Alert consolidation.

18. In Alert consolidation server hostname or IP address, select the Primary
Backend host.

19. In Alert consolidation server port number, select the port used for alert
consolidation.

20. In Naviseccli Path, type the path if using a non-default path, or leave blank if
you are using the default path.

21. Optionally, select Use advanced settings to configure polling settings.

22. Click Next.

23. From the Event database drop-down menu, select existing settings that have
been specified for other components, or select Add a new Event database.

If you select Add a new Event database, type the information about the new
event database.

24. Click Next.

25. In Administration Web-Service Instance, select the Frontend host.

26. Click Install.

27. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.
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After you finish

After installing or updating a SolutionPack, new data will not be available for
approximately three polling cycles. The data is available to the UI every hour with the
Property Store task. This task can be run earlier, if desired, by selecting the Property
Store task found on the Frontend host.

Adding and configuring devices in Discovery Center

Procedure

1. From Discovery Center > Inventory Management, click EMC VNX.

2. Click Add new device.

3. If the Server field appears, select the server where the device will be
dispatched.

4. If the Instance field appears, select the instance of the emc-vnx-collect where
the device will be dispatched.

5. In VNX type, select VNX Block Only, VNX NAS Gateway/eNAS, VNX
Unified/File, or Unity/VNXe2.

If the following fields appear, enter the information specified:

a. In Unique friendly name for the VNX system, type the name.

b. In SP A IP, type the IP address of the SPA.

c. In SP B IP, type the IP address of the SPB.

d. In Use Naviseccli security file, select this checkbox if you are using the
security file.

e. In Naviseccli User Scope, select LDAP, Global or Local.

f. In Naviseccli Username and Naviseccli Password, type the Naviseccli
credentials for the block storage systems.

g. In Primary control station IP, type the IP address of the primary control
station.

h. In Secondary control station IP, type the IP address of the secondary
control station.

i. In VNX File User Scope, select LDAP, Global, or Local.

j. In VNX File Username and VNX File Password, type the credentials for the
file storage system.

k. In Management IP or hostname, type the IP address for the Unity/VNXe2
system.

l. In Username, type the username for the Unity/VNXe2 system.

m. In Password, type the password for the Unity/VNXe2 system.

6. Click Validate and Add to validate the credentials.
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Note

This button tests array connectivity and credentials using the default user apg
(Linux) or SYSTEM (Windows). If the VNX collector-manager is configured to
run under a custom user (not the default) and uses a Naviseccli security file
that is configured for that user, the test results will show failures. However,
these can safely be ignored if the underlying collector-manager user & security
file are correctly configured.

7. Click Ok.

8. Click Save.

9. In the tree, click SolutionPacks and navigate to the EMC VNX SolutionPack to
verify the installation.

Changing VNX object credentials using Discovery Center
Using Discovery Center, you can export, modify, and then import VNX credentials.

Procedure

1. From Centralized Management, click Discovery Center > Inventory
Management > EMC VNX.

2. Click Export and save the .csv file.

3. Open the .csv file in a text editor, such as Notepad++.

4. In the file, identify the credentials that need to be changed.

In the example below, the username and password for test-user has been
identified.

Server,Instance,type,friendlyname,block.spa,block.spb,block.us
e_secfile,block.secfilepath,block.userscope,block.username,blo
ck.password,file.csprimary,file.cssecondary,file.username,file
.password,unity.management,unity.username,unity.password 
‘servername.emc.com’,'emc-
vnx','unified','FNM00130900273','lglad065','lglad066','false',
,'global','test-
user','{5D6FAF32A927B424BFD17D71D5F6C85AC37CE3232E9012FE490DE4
825098BCA753E17FDC23F4E60C53320DA7E9FCC4AA}','lglad064',,'nasa
dmin','{9039753E3695E8B7027D0B95749AF1620E2A392FB1224E6DF4A192
66F1F4859F6C6F7916124ACB801DB00BCADFBA6DCC}',,, 
‘servername.emc.com’,'emc-
vnx','block','FNM00083700047','lglad053','lglad054','false',,'
global','emc','{A921446A3F75CF9174C9365B8073E3F33732087BB8C269
4B8215AFA8051D970E4128A57E63342BE997C0BFE3C10F6468}',,,,,,,

5. Change the credentials in the .csv file.

In the example below, test-user has been changed to test2 and the
password has been changed to password456.

Server,Instance,type,friendlyname,block.spa,block.spb,block.us
e_secfile,block.secfilepath,block.userscope,block.username,blo
ck.password,file.csprimary,file.cssecondary,file.username,file
.password,unity.management,unity.username,unity.password
‘servername.emc.com’,'emc-
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vnx','unified','FNM00130900273','lglad065','lglad066','false',
,'global','test2','password456','lglad064',,'nasadmin','{90397
53E3695E8B7027D0B95749AF1620E2A392FB1224E6DF4A19266F1F4859F6C6
F7916124ACB801DB00BCADFBA6DCC}',,,
‘servername.emc.com’,'emc-
vnx','block','FNM00083700047','lglad053','lglad054','false',,'
global','emc','{A921446A3F75CF9174C9365B8073E3F33732087BB8C269
4B8215AFA8051D970E4128A57E63342BE997C0BFE3C10F6468}',,,,,,,

6. Save the .csv file.

7. In Discovery Center, click Import.

8. Select the Merge the devices with the existing ones? checkbox.

9. Click Browse to find the .csv file with the new credentials.

10. Click Ok.

A dialog appears indicating that the devices have been replaced (all of them will
be refreshed, even if the credentials were only updated for one object).

11. Click Continue.

The Discovery Center credentials page refreshes, displaying all contents in
italics.

12. Click Save for the changes to take effect.

This will restart the VNX collector instance(s) and update the credentials that
are used.

Discovery troubleshooting
l Discovering same device again with a different “Unique Friendly Name” allows to

add, but is not recommended since it results in duplicate reports in SRM frontend
for the device.

l It is not recommended for “Unique Friendly Name” to contain “+” (plus sign)
(Known issue SRS-33450 listed in SolutionPack Release Notes).

l When discovering VNXe2 arrays, it is possible to see errors when testing
authentication with the device (Known issue EMP-21015 listed in SolutionPack
Release Notes).

l The Test button results pop-up could incorrectly display Unity OE 4.1 as 4.0.2.
This can happen if OE 4.0.1 was upgraded to 4.0.2 and then upgraded to 4.1.x
(Known issue SRS-32062 listed in SolutionPack Release Notes).

l For binary SRM installations on Linux or Windows platforms, discovering VNX
Unified or Block arrays requires users to manually install NaviSphereCLI as
explained in the “Preparing your VNX for discovery and data collection” section of
this document.

Troubleshooting
Use this section to troubleshoot common errors.
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Resolving collector communication errors
There may be cases where the collector runs into issues reaching the array. Some
known examples are listed below.

When a VNX storage processor is not reachable via Navisphere Secure CLI
(NavisecCLI) or when the NavisecCLI security file has not been properly configured,
error messages like those shown below will appear in the collection logs.

SEVERE -- [2015-10-06 10:30:22 EDT] -- DataListener
$ValueFormatter::createValues(): No value found for key agent-spa-
memory, context VNX1 and properties {topopass=value, 
friendlyname=APM00140634211, scopeflag=, spb=losat164.lss.emc.com, 
spa=losat163.lss.emc.com, topouser=value, POLLING_COUNTER=0, 
deviceid=1, command=/opt/Navisphere/bin/naviseccli, 
topoport=localhost:48443, secfilepath=/tmp, userflag=, 
sstype=Unified, password=, 
cimauthorization=@{user}:@{password}:@{scope}, passwordflag=, 
nopollflag=-nopoll, scope=, secfilepathflag=-secfilepath, user=} 

SEVERE   -- [2015-10-06 11:50:22 EDT] -- 
AbstractStreamHandlerJob::prepareNextStep(): Error executing 
handler XslStreamTransformer containing 1 sub handlers
com.watch4net.apg.ubertext.parsing.StreamHandlerException: Error 
while transforming stream
        at 
com.watch4net.apg.ubertext.parsing.transformer.XslStreamTransformer.
execute(XslStreamTransformer.java:58)
        at 
com.watch4net.apg.ubertext.parsing.AbstractSimpleStreamHandler.handl
eExecution(AbstractSimpleStreamHandler.java:39)
        at 
com.watch4net.apg.ubertext.parsing.concurrent.AbstractStreamHandlerJ
ob.prepareNextStep(AbstractStreamHandlerJob.java:180)
        at 
com.watch4net.apg.ubertext.parsing.concurrent.SimpleStreamHandlerJob
.step(SimpleStreamHandlerJob.java:41)
        at com.watch4net.apg.concurrent.executor.AbstractJobExecutor
$SequentialJob.step(AbstractJobExecutor.java:419)
        at 
com.watch4net.apg.concurrent.executor.AbstractJobExecutor.executeJob
Runner(AbstractJobExecutor.java:122)
        at 
com.watch4net.apg.concurrent.executor.AbstractJobExecutor.access
$500(AbstractJobExecutor.java:22)
        at com.watch4net.apg.concurrent.executor.AbstractJobExecutor
$JobRunnerImpl.run(AbstractJobExecutor.java:274)
        at 
java.util.concurrent.ThreadPoolExecutor.runWorker(ThreadPoolExecutor
.java:1142)
        at java.util.concurrent.ThreadPoolExecutor
$Worker.run(ThreadPoolExecutor.java:617)
        at java.lang.Thread.run(Thread.java:745)
Caused by: net.sf.saxon.trans.XPathException: Error reported by XML 
parser: Content is not allowed in prolog.

To resolve the communication issues shown above, follow the steps below.
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Procedure

1. Using the collection logs, identify the VNX storage processor that is not able to
communicate with the collector, as shown in the example error below:

SEVERE -- [2015-10-06 10:30:22 EDT] -- DataListener
$ValueFormatter::createValues(): No value found for key agent-
spa-memory, context VNX1 and properties {topopass=value, 
friendlyname=APM00140634211, scopeflag=, 
spb=losat164.lss.emc.com, spa=losat163.lss.emc.com, 
topouser=value, POLLING_COUNTER=0, deviceid=1, command=/opt/
Navisphere/bin/naviseccli, topoport=localhost:48443, 
secfilepath=/tmp, userflag=, sstype=Unified, password=, 
cimauthorization=@{user}:@{password}:@{scope}, passwordflag=, 
nopollflag=-nopoll, scope=, secfilepathflag=-secfilepath, 
user=} 

In this example, storage processor A on the array APM00140634211 cannot
communicate with the collector.

2. Ensure the storage processor is reachable via NavisecCLI from the VNX
collector host given the same credentials used in ViPR SRM.

3. Ensure that the NavisecCLI security file has been properly configured. For more
information on configuring the security file, refer to Unisphere security file
authentication.

Resolving creating stream errors

An error message, like the one shown below, will appear in the collection logs when
the /opt/APG/Collecting/Stream-Collector/emc-vnx/./conf/output/vnxalerts-block-
deviceid-1-laststarttime.xml files are deleted.

SEVERE – [2015-11-02 10:30:02 EST] – 
AbstractStreamHandlerJob::prepareNextStep(): Error executing 
handler FileReaderRetriever containing 1 sub handlers
 com.watch4net.apg.ubertext.parsing.StreamHandlerException: Error 
while creating the stream for file /opt/APG/Collecting/Stream-
Collector/emc-vnx/./conf/output/vnxalerts-block-deviceid-1-
laststarttime.xml
 at 
com.watch4net.apg.ubertext.parsing.retriever.FileReaderRetriever.new
FileToRead(FileReaderRetriever.java:340)
 at 
com.watch4net.apg.ubertext.parsing.retriever.FileReaderRetriever.exe
cute(FileReaderRetriever.java:189)
 at 
com.watch4net.apg.ubertext.parsing.retriever.FileReaderRetriever.exe
cute(FileReaderRetriever.java:46)
 at 
com.watch4net.apg.ubertext.parsing.AbstractForkingStreamHandler.hand
leExecution(AbstractForkingStreamHandler.java:122)
 at 
com.watch4net.apg.ubertext.parsing.concurrent.AbstractStreamHandlerJ
ob.prepareNextStep(AbstractStreamHandlerJob.java:180)
 at 
com.watch4net.apg.ubertext.parsing.concurrent.ForkingStreamHandlerJo
b.step(ForkingStreamHandlerJob.java:46)
 at 
com.watch4net.apg.concurrent.executor.DefaultScheduledJobExecutor
$ScheduledJob.step(DefaultScheduledJobExecutor.java:249)
 at 
com.watch4net.apg.concurrent.executor.AbstractJobExecutor.executeJob
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Runner(AbstractJobExecutor.java:122)
 at com.watch4net.apg.concurrent.executor.AbstractJobExecutor.access
$500(AbstractJobExecutor.java:22)
 at com.watch4net.apg.concurrent.executor.AbstractJobExecutor
$JobRunnerImpl.run(AbstractJobExecutor.java:274)
 at 
java.util.concurrent.ThreadPoolExecutor.runWorker(ThreadPoolExecutor
.java:1142)
 at java.util.concurrent.ThreadPoolExecutor
$Worker.run(ThreadPoolExecutor.java:617)
 at java.lang.Thread.run(Thread.java:745)
 Caused by: java.io.FileNotFoundException: /opt/APG/Collecting/
Stream-Collector/emc-vnx/./conf/output/vnxalerts-block-deviceid-1-
laststarttime.xml (No such file or directory)
 at java.io.FileInputStream.open0(Native Method)
 at java.io.FileInputStream.open(FileInputStream.java:195)
 at java.io.FileInputStream.<init>(FileInputStream.java:138)
 at 
com.watch4net.apg.ubertext.parsing.retriever.FileReaderRetriever.new
FileToRead(FileReaderRetriever.java:336)
 ... 12 more

To resolve this issue, follow the steps below.

Procedure

1. From Centralized Management, click SolutionPacks > Storage > EMC VNX.

2. Click the pencil icon for the Data collection component to reconfigure the
SolutionPack.

The missing files are recreated.

Limitations

l DataMover fail-over leads to persistence of duplicate capacity metrics in the APG
Database. Depending on the time period settings for changing the vstatus, these
duplicate capacity metrics would become inactive.

l VNX Free Raw Disk Capacity values are not the same as EMC Unisphere Free Raw
Capacity values. Unisphere Free Raw Capacity counts both internal operation
space (vault drives) and the space available for user LUNs. Free Raw Disk
Capacity only counts the space available for user LUNs.

l Hot Spare values are incorrect for VNX arrays running Operating Environment for
Block / FLARE 05.33.x. In that version, the VNX series supports a new hot spare
policy where any unbound disk is available for use as a hot spare. Therefore, disks
are not specifically marked as hot spares, but rather as unbound disks. As a result,
hot spare disks are incorrectly counted as unconfigured capacity.

l VNX Statistics Logging will stop when VNX Performance Logging stops if
Performance Logging was enabled before Statistics Logging was enabled. To
prevent this from happening, manually enable Statistics Logging via Unisphere or
NaviCLI (using the setstats -on command) before enabling Performance
Logging (which is optional). In this way, even if the optional Performance Logging
stops, performance metrics will continue to be collected.

l CSV files that were exported from Discovery Center with a release prior to ViPR
SRM 3.7 cannot be used to import devices into ViPR SRM 4.0.
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l The following error message appears in the logs during the first couple polling
cycles when an array is discovered; after that the message will stop:

SEVERE   -- [2016-01-28 10:44:39 EST] -- 
FileDownloadingTask::run(): 
com.watch4net.apg.ssh.api.exception.SSHException: Remote 
directory './emc-srm/server_2/3600' does not exist. 
com.watch4net.apg.file.retriever.ClientException: 
com.watch4net.apg.ssh.api.exception.SSHException: Remote 
directory './emc-srm/server_2/3600' does not exist.

l The discovery of VNX/Unity/VNXe arrays using an IPv6 address in Discovery
Center is not supported. Use the hostname which resolves to the respective IPv6
address when entering the details for SPA, SPB and Control Station (for VNX) or
for Management Host (for Unity/VNXe2).

l The following message appears in the logs when the SolutionPack collector-
manager is first started. This problem is resolved when a device is added for
discovery and the collector-manager is restarted.

WARNING – [2016-04-10 11:26:24 EDT] – SocketConnector::init(): 
Can't connect socket to localhost:52001 
 java.net.ConnectException: Connection refused

l If the "Current Owner" of a LUN on a Unity or VNXe2 array changes, the
'memberof' property will display multiple values for a while until the collection has
time to normalize things. For Unity, that means that for approximately one hour
(by default, or up to four hours if 60 mins topology polling period is selected), the
reports will show multiple values for the 'memberof' property. For VNXe2, that
means that until the LUN metrics are marked inactive (approximately 24 hours),
the reports will show multiple values for the 'memberof' property.

l It is possible for existing VNX array LUNs to appear in the Inactive Devices &
Components report. This occurs because the memberof property is part of the
LUN variable id. If a LUN trespasses between storage processors, the old instance
of the metric will be tagged with an inactive vstatus property.

l The following warning might appear in the logs when the Primary control station of
a VNX Unified or NAS Gateway is not reachable or does not respond to XML API
requests:

WARNING  -- [2016-06-06 09:08:38 EDT] -- 
HttpRequestGroup::executeRequest(): Error running command 
https://@{cssecondary}/Login?user
java.lang.IllegalArgumentException: Host name may not be 
null....

This can occur when the VNX Unified or NAS Gateway has only one control
station, and the Secondary control station IP field is blank.

Difference in calculation of array-level "Used" Capacity between Unisphere and SRM

SRM Report Location: Explore -> Storage -> Storage Systems -> <VNX/Unity Array
ID> -> Device Summary -> <Array Name> -> Capacity -> Storage Capacity Dashboard
-> Charts with details -> Usable Capacity -> Used

For Unified/Block Arrays:

Used (in Unisphere) = TotalCapacity - UnusedDiskCapacity - FreeRGCapacity - Free
Space for File (applicable for Unified systems only)

Used (in SRM) = Sum of all LUNs’ "UsedCapacity" metric where isused==1, plus
PoolOverhead.
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Reasons for LUN to be considered "Used" (isused==1):

l LUN is both masked and mapped – means it is host accessible. This is for both thin
and thick LUNs

l System Resource

l Pool Contributor for snap pool and replica pool

l Used by File or Virtual system

l Part of a replica chain and its primary LUN is used – replica chain determined by
Topology Service using replica LUN source/target

For Unity Arrays:

Used (in Unisphere) = Sum of all Pools’ consumed space

Used (in SRM): For calculation, considered LUNs where isused==1 only, (either (a)
when it is both mapped and masked or (b) when it is Used by File or Virtual System.),
and not all possible LUNs carved out of the pool.

Generally, the main interest when looking at the array-level "Used" capacity is to
understand how much space is used across all Storage Pools and/or RAID Groups on
the array. If this is the desired information, navigate to Explore > Storage Capacity >
Enterprise Capacity and scroll over to view the 'Pool Used (GB)' column.
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CHAPTER 19

SolutionPack for EMC ViPR Controller

This chapter includes the following topics:
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l Installing the SolutionPack for EMC ViPR Controller........................................ 138
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Overview
The SolutionPack for EMC ViPR Controller provides a global view of the underlying
EMC ViPR Controller host and disk infrastructure, and detailed insight into ViPR-
defined virtual data centers, including the projects, tenants, virtual arrays, and virtual
pools.

Installing the SolutionPack for EMC ViPR Controller
Before you begin

l Before installing the SolutionPack, ensure that the ViPR Controller version is
supported.

l You must have ViPR SRM 3.6.3 or later.

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l Deploy the vApp as described in the article on installing ViPR SRM as a virtual
appliance.

l Know the connection details for the instance of ViPR from which you want to
collect data:

n Virtual IPv4 address of the ViPR Controller.

n Credentials for a ViPR account with the System Monitor and System Auditor
Role.

n The core software and license should be installed.

l Know the frontend hostname and admin credentials for the core software instance
to which you are adding the SolutionPack.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. From the Alerting on data collection drop-down list, select the Primary
Backend host.

11. Click Next.

The window displays data collection details.
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12. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

13. From the Alert Consolidation drop-down list, select existing settings that have
been specified for other components, or select Add a new Alert consolidation.

If you select Add a new Alert consolidation, type information about the
alerting configuration. In Alerting Backend hostname or IP address, specify
the Primary Backend host.

14. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

15. Leave Enable Topology Backend on data collected checked.

16. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

17. To configure polling settings or to disable a polling type, select Use advanced
settings.

18. In each polling period drop-down list, select a polling period or select Disabled
to turn off the polling.

19. Click Next.

The window displays reports settings.

20. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

21. Click Install.

22. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

23. Click Discovery Center > Inventory Management.

24. Click ViPR.

25. Click Add new device.

26. In Server, select the ViPR Collector.

27. In Instance, select the ViPR instance.

28. For each ViPR Controller server from which you want to collect data, type a
unique name, its public virtual IPv4 address, and credentials for an account with
the System Administrator role.
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29. To validate the credentials, click Validate and Add.

30. Click Ok, and then Save.

Limitations

l Inactive metrics for ViPR Controller are not supported in the following reports:

n All >> Operations >> Inactive Devices and Components >> Devices with
Inactive Metrics

n Explore >> Storage >> Storage Systems >> <ViPR Device> >> Operations
>> Inactive Metrics

l In rare conditions, the service logs payload from ViPR Controller overwhelms the
ViPR SRM collector, resulting in a Java out of memory error. The following
message appears in the collecting.log file:

SEVERE – [2015-05-29 17:16:31 EDT] – n::run(): VIPR_LOGINFO:
Unexpected failure java.lang.OutOfMemoryError: Java heap
space
Disable service log collection by reconfiguring the ViPR Controller SolutionPack:

1. Browse to Administration > Centralized Management > SolutionPacks >
Storage > EMC ViPR.

2. In the table, click the Edit icon on the Data collection row.

3. When the SolutionPack Reconfiguration screen appears, check Use advanced
settings, click the drop-down list for Service logs polling period, and select
Disabled.

4. Click Reconfigure.

l The Report Library >> EMC ViPR Controller >> Performance >> Top 10 >>
Block Volume Utilization chart includes performance metrics for both Block
Volumes and Backend Block Volumes, though Backend Block Volumes are listed
separately in other reports.

l In the reports, Used for Block and Used for File capacity values are incorrectly
shown as zero:

n Explore >> Storage >> Storage Systems >> <ViPR device> >> Capacity >>
Storage Capacity Dashboard >> Usable Capacity Trend

n Report Library >> EMC ViPR Controller >> Capacity >> Storage Capacity
Dashboard >> Usable Capacity Trend

l Performance graphs in ViPR Controller SolutionPack is delayed when there is no
data that is sent by ViPR Controller.
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Overview
The SolutionPack for EMC VMAX collects and reports capacity, topology, alerts, and
performance data for Symmetrix DMX, VMAX, VMAX3, and VMAX All Flash arrays
and components such as pools, disks, directors, ports, storage groups, devices, and
replication.

Configuring the access credentials
EMC M&R uses different accounts when running SolutionPacks.

SMI-S Provider default credentials are provided during SolutionPack installation:

l Username - the default is admin
l Password - the default is #1Password
Unisphere for VMAX credentials:

l Username - the default is smc
l Password - the default is smc

Preparing EMC VMAX for discovery and data collection
Identify the information that is required to support data collection before installing the
SolutionPack for EMC VMAX and perform the necessary pre-configuration.

The host running Unisphere for VMAX and the ViPR SRM collector host must have the
same date and time and must be in same time zone. Otherwise, if the ViPR SRM
collector host's clock is too far ahead of the Unisphere host's clock, the ViPR SRM
collector may not return performance data.

VMAX/VMAX3/VMAX All Flash discovery scenario

Array Provider Host
VMAX, VMAX3, and VMAX All Flash arrays are collected using the VMAX SMI-S
Provider and optionally Unisphere for VMAX. The SMI-S Provider is used to collect
capacity, topology, basic performance data, and LUN performance data. Unisphere for
VMAX can be used to collect the basic performance data as well as several additional
performance data, but it cannot collect LUN performance data. Therefore, the VMAX
collector should be configured to use both the SMI-S Provider and Unisphere for
VMAX so that all VMAX report fields will have data. It is recommended that both the
SMI-S Provider and Unisphere for VMAX are installed to the same Array Provider
Host. This Array Provider Host should have six or more dedicated gatekeepers for
each VMAX array that is connected to it.

"Remote Discovery Configuration" is referred to when SMI-S Provider and Unisphere
are installed on an Array Provider Host which is separate from the VMAX Collector
Host. The minimum Array Provider Host configuration is 4 CPUs and 16 GB memory.
More memory will be required when managing more than 50k total devices, with a
maximum of 100k devices per Array Provider Host. Refer to the Unisphere for VMAX
Release Notes to determine the Array Provider Host's scalability and CPU/Memory
requirements.

The SMI-S Provider and Unisphere for VMAX can be installed on the ViPR SRM
Collector Host (this is referred to as "Local Discovery Configuration"). Local
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Discovery Configuration requires a minimum of 4 to 8 CPUs and 32GB memory to
support the VMAX Collector as well as the SMI-S Provider and Unisphere for VMAX.
Sufficient memory and CPU must be provided on the Collector Host to support all of
these components as well as any other hosted collectors or processes.

Unisphere for VMAX and the SMI-S Provider will gather performance data for arrays
that are directly SAN-attached to the Array Provider Host (called a "Local
connection" to the array). Performance data is not available for arrays that are
indirectly attached to the Array Provider Host through another array's SRDF
connection (called a "Remote connection" to the array). Arrays must be registered in
the Unisphere for VMAX Performance UI to provide performance data. Once
performance data is available in Unisphere/SMI-S and the array is collected, it may
take 2 to 3 hours before the performance data will be seen in the VMAX reports.

Collector Host (Remote Discovery Configuration)
Collector Hosts are installed with the SolutionPack for EMC VMAX and configured to
connect to the SMI-S Provider and Unisphere for VMAX on the Array Provider Host.
Refer to the ViPR SRM Performance & Scalability Guidelines for SolutionPack for EMC
VMAX planning based upon the number of arrays and array configurations being
managed. As a rule, ViPR SRM Collector Hosts should be installed as near as possible
to the Array Provider Host to avoid network latency between the collector and SMI-S
Provider and Unisphere. It is highly recommended that Collector Hosts be in the same
data center as the Unisphere and SMI-S Provider. At minimum the Unisphere Host
should be in the same time zone as the Collector Host. Or, the Unisphere Host should
have its clock synchronized with the Collector Host.

Verifying the configuration
Verify the VMAX collector configuration is correct by using the Discovery Center Test
option for each VMAX array. Tests performed include basic SMI-S/Unisphere
connectivity tests, SMI-S/Unisphere version checks, and an array existence test. The
configured discovery settings can be confirmed by using the Test utility as described
in Troubleshooting Discovery Center connectivity failures. Alternately, the SMI-S
TestSmiProvider utility's dv command can be used to confirm the software
version and connected arrays on the Array Provider Host.

# cd /opt/emc/ECIM/ECOM/bin or ?:\Program Files\EMC\ECIM\ECOM\bin
#./TestSmiProvider or TestSmiProvider.exe
SolutionPack for EMC VMAX
Configuring the access credentials 103
Connection Type (ssl,no_ssl,native) [no_ssl]:
Host [localhost]:
Port [5988]:
Username [admin]:
Password [#1Password]:
Log output to console [y|n (default y)]:
Log output to file [y|n (default y)]:
Logfile path [Testsmiprovider.log]:
Connecting to localhost:5988
….
Namespace: root/emc
repeat count: 1
(localhost:5988) ? dv
++++ Display version information ++++
Solutions Enabler version: V8.x.y.z

Firmware version information:
(Local) VMAX 000283700466 (VMAX200K) : 5977.477.457
(Local) VMAX 000283700467 (VMAX200K) : 5977.477.457
(Local) VMAX 000283700472 (VMAX200K) : 5977.477.457
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Verify connectivity with the SMI-S Provider and Unisphere on the ViPR SRM
Collector Appliance via Discovery Center using the Test button.

DMX discovery scenario

Array Provider Host
DMX arrays are collected using the Solutions Enabler SYMCLI and optionally
Unisphere for VMAX. The Solutions Enabler SYMCLI is used to collect capacity and
topology data. Unisphere for VMAX can be used to collect the basic performance
details as well as several additional performance metrics, but it cannot collect LUN
performance data. Therefore, the VMAX collector should be configured to use
Solutions Enabler and Unisphere for VMAX so that all VMAX report fields will have
data. Unisphere for VMAX requires Solutions Enabler to be installed. It is
recommended that the SYMCLI topology collection be configured to use the
Unisphere server's Solutions Enabler. This Array Provider Host should have six or
more dedicated gatekeepers for each DMX array that is connected to it.

"Remote Discovery Configuration" is referred to when the Solutions Enabler and
Unisphere are installed on an Array Provider Host which is separate from the VMAX
Collector Host. The minimum Array Provider Host configuration is 4 CPUs and 16 GB
memory. More memory will be required when managing more than 50k total devices,
with a maximum of 100k devices per Array Provider Host. Refer to the Unisphere for
VMAX Release Notes to determine the Array Provider Host's scalability and CPU/
Memory requirements.

The Solutions Enabler and Unisphere for VMAX can be installed on the ViPR SRM
Collector Host (this is referred to as "Local Discovery Configuration"). Local
Discovery Configuration requires a minimum of 4 to 8 CPUs and 32GB memory to
support the VMAX Collector as well as SMI-S Provider and Unisphere for VMAX.
Sufficient memory and CPU must be provided on the Collector Host to support all of
these components as well as any other hosted collectors or processes.

Unisphere for VMAX will gather performance data for arrays that are directly SAN-
attached to the Array Provider Host (called a "Local connection" to the array).
Performance data is not available for arrays that are indirectly attached to the Array
Provider Host through another array's SRDF connection (called a "Remote
connection" to the array). Arrays must be registered in the Unisphere for VMAX
Performance UI to provide performance data. Once performance data is available in
Unisphere and the array is collected, it may take 2 to 3 hours before the performance
data will be seen in the VMAX reports.

Collector Host (Remote Discovery Configuration)
The SolutionPack for VMAX is deployed to the Collector Host and configured to the
Unisphere for VMAX on the Array Provider Host. Refer to the ViPR SRM Performance
& Scalability Guidelines for SolutionPack for VMAX planning based upon the number of
arrays and array configurations being managed. As a rule, ViPR SRM Collector Hosts
should be installed as near as possible to the Array Provider Host to avoid network
latency between the collector and Unisphere. For example, if there is high network
latency (100 ms or greater) from the local datacenter to the remote datacenter then
the VMAX Collector Host and Array Provider Host should be collocated within the
remote datacenter.

Verifying the configuration
Verify the VMAX collector configuration is correct by using the Discovery Center Test
option for each DMX array. Tests performed include basic SYMCLI/Unisphere
connectivity tests, SYMCLI/Unisphere version checks, and an array existence test.
The configured discovery settings can be confirmed by using the Test utility as
described in Troubleshooting Discovery Center connectivity failures. Alternately, the
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SYMCLI symcfg list -v command can be used to confirm the software version
and connected arrays on the Array Provider Host.

Creating collectors for discovery of Symmetrix arrays (local discovery
configuration)

The following procedure describes how to create VMAX collectors for discovery of all
Symmetrix arrays (DMX, VMAX, VMAX3, and VMAX All Flash) in ViPR SRM.

Procedure

1. Create a Windows (2008, 2012, 2012R2) or Linux (RH 5+, Suse 10+) Vmguest
with eight RDM gatekeepers allocated to the server from each local Symmetrix
array (have been tested for 60,000 volumes total).

2. Size the server as follows: 4–8 CPUs, 32 GB RAM, 200 GB Storage.

3. Install Solutions Enabler with SMI-S and Unisphere for VMAX on the VMAX
collector server. This server will only be used for ViPR SRM data collection (no
production allocation use).

4. Ensure the server can see no more than 50,000 Symmetrix volumes (64,000 for
jumbo arrays) and be sure to leave room for growth. Run symcfg list from
Solutions Enabler to verify.

5. Create a symavoid file if too many Symmetrix arrays are visible until you get the
volume count on the server below 50,000 volumes (64,000 for jumbo arrays)
and be sure to allow for growth. You will be blocking the remote arrays as well in
the symavoid file. Remote arrays will be discovered in remote datacenters
locally by a VMAX collector server there.

6. Install ViPR SRM collector software on this server. Add this server to ViPR
SRM as a scale out collector.

7. Install only the VMAX SolutionPack collector on this server.

8. Set the Java heap for the VMAX collector to 8 GB (8192).

The VMAX Collector's default Java heap size is configured as 4 GB (4096).
Additional heap may be required for large Solutions Enabler environments with
multiple arrays. Refer to the ViPR SRM Performance and Scalability guidelines for
more information.

9. In ViPR SRM, use only the local discovery option and type the Solutions Enabler
install directory, if it is not the default.

10. This server will be used to fill in the Unisphere for VMAX and SMI-S fields for
discovery in ViPR SRM.

Solutions Enabler proxy scenario
The Solutions Enabler proxy scenario only applies to DMX arrays. VMAX arrays are
collected only through SMI-S Provider and no longer uses Solutions Enabler SYMCLI.

In this scenario, no ViPR SRM software is installed on the SYMAPI server. Instead, a
client host and server host proxy relationship is configured.

l Client host - You install Solutions Enabler on the ViPR SRM Collector host
designated to collect data. The client host has no direct connectivity to the array.
The Solutions Enabler client is installed by default in vApp deployment.

l Server host - Solutions Enabler already exists on the SYMAPI server with
connectivity and gatekeeper access to the array.
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The client host is then configured for proxy communicate with the server host over
TCP/IP (port 2707, which is the default). In this scenario, map two additional
gatekeeper devices to your SYMAPI server.

Configuring Solutions Enabler proxy support
Configure support for the Solutions Enabler proxy scenario.

Before you begin

l Install a supported version of EMC Solutions Enabler on the ViPR SRM Collector
host. Refer to the EMC ViPR SRM Support Matrix for supported versions used with
ViPR SRM.

l In a proxy configuration, you must maintain the same Solutions Enabler family
version. A mixed 32-bit and 64-bit Solution Enabler is supported in a proxy
configuration.

l Map two additional gatekeeper devices for ViPR SRM and present them to your
SYMAPI server.

l Ensure the storsrvd daemon is running on the Server host. You can confirm this
by issuing the stordaemon list command on the Server host.

This procedure is applicable for Solutions Enabler or the Solutions Enabler installed
with the EMC SMI-S Provider.

Procedure

1. On the client host on which you installed Solutions Enabler, navigate to the
netcnfg file.

On Linux, the file is located at: /var/symapi/config/netcnfg.

On Windows the file is located at: ..\Program Files\EMC\SYMAPI
\config

2. Edit the file to add the remote host to which Solutions Enabler will
communicate. Add a line similar to the last line in the following example:

# This is a sample config -- where WWW.XXX.YYY.ZZZ is a valid 
IP address.     #
# Please use this format for your 
host.                                       #
#                                                             
                #
# <SYMAPI_SERVER>  -  TCPIP  node001  WWW.XXX.YYY.ZZZ  2707  
-                  #
# SYMAPI_SECURE  -  TCPIP  node001  WWW.XXX.YYY.ZZZ  2707  
SECURE             #
 
SYMAPI_SERVER - TCPIP hostname IP-address 2707 NONSECURE

Select NONSECURE when the server side is configured for NONSECURE, or ANY on
the deamons_options file in the SECURITY_LEVEL section.

3. On the SYMAPI server host, ensure that the SERVER license key is registered
by reviewing the symapi\config\symapi_licenses.dat file. If it is not
there, use the symlmf utility to add the license key.

You can also control the Solutions Enabler licenses from the array.
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Verifying the Solutions Enabler proxy configuration
Verify proxy configuration success and, if necessary, identify and resolve any
configuration issues.

Procedure

1. From the SYMAPI server host, type sympd list to display a list of devices that
are visible to the host. Note the results.

2. On the client host, type sympd list.

l If the results match, the configuration is complete.

l If the command issued from the client returns a message such as no
devices found, continue to the next step.

3. To isolate the issue:

a. Verify that the same command works on the host with the FC connection to
the Symmetrix array.

b. Verify that the environment variables for Solutions Enabler are set using the
symcli -def command.

c. Verify that the netcfg file has been edited using the symcfg -services
list command.

d. Verify the arrays you intend to monitor using the symcfg list command.

e. Verify that two additional gatekeepers are provisioned from each Symmetrix
array using the sympd list command.

Configuring VMAX arrays for consolidation of availability alerts
Use this procedure to configure forwarding of availability alert traps (SNMP v1) from
VMAX arrays.

VMAX performance alerts are collected using the discovery data collection
configuration.

Procedure

1. Log into Solutions Enabler on the array provider host as an administrator.

2. Navigate to the daemon_options file in the C:\Program Files\EMC
\SYMAPI\config\ directory.

3. In the parameter section SNMP_TRAP_CLIENT_REGISTRATION:

a. Uncomment the line storevntd:SNMP_TRAP_CLIENT_REGISTRATION
b. Add the ViPR SRM trap recipient IP to the trap filter. In a single vApp

installation, this is the ViPR SRM IP, and in a distributed environment, is the
Primary Backend server's IP.

The syntax is <IP>,<port>,<filter>,<state>, where <filter> is the
filtering level for trap forwarding defined in the FCMGMT-MIB file.

Example: 10.31.90.148, 2041,10,ACTIVE
4. In the parameter section LOG_EVENT_TARGETS, uncomment the line

storevntd:LOG_EVENT_TARGETS = snmp file.

5. To identify the arrays from which traps should be forwarded to the suite, type
symcfg list, and press Enter.
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6. For each array that should forward alert traps to ViPR SRM:

a. Type symcfg list, and press Enter.

b. In the parameter section LOG_SYMMETRIX_EVENTS, specify the
appropriate event categories in the format:

sid=<SYM serial number>, <event category 1>, <event
category 2>\
Example: SID=000194900854, disk, device, device pool,
director, srdf consistency group, srdfa session, srdf
link, srdf system, service processor, environmental,
diagnostic, checksum, status, events, array subsystem,
groups, optimizer, thresh_critical=3, thresh_major=2,
thresh_warning=1, thresh_info=0 ;\

7. To reload the changes to the daemon_options file, type stordaemon action
storevntd -cmd reload, and press Enter.

8. Ensure that the storevntd Event Daemon is running on the provider host.

9. If you have multiple VMAX array provider hosts in your storage environment,
repeat this procedure on each array provider host.

Installing the SolutionPack
Before you begin

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l The ViPR SRM Alerting Guide explains how to configure alerts consolidation.

l Data collection instances are based on the topology collection type.

Note

Use only one SolutionPack, either the SolutionPack for EMC VMAX or the
SolutionPack for EMC VMAX HYPERMAX, to collect data from VMAX3 and VMAX All
Flash arrays. Using both SolutionPacks to collect data from the same array consumes
significant collector resources and can have potential consequences to reports and
chargeback calculations.
The SolutionPack for EMC VMAX HYPERMAX comes with some limitations when
compared to the existing SolutionPack for EMC VMAX. Notably, there is no LUN
performance, Disk, Disk Group, or Data Pool metrics that will be collected. LUN
capacity and topology metrics are still collected. Storage Group performance and SLO
compliance metrics should be used in lieu of LUN performance metrics. And, Storage
Resource Pool (SRP) capacity and performance metrics should be used as an
alternative to the metrics for the SRP’s underlying subcomponents (i.e., Disks, Disk
Groups, and Data Pools that make up the SRP).

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.
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5. Click Install.

6. Type the instance name.

The instance is based on topology type SMI-S or SYMCLI. The DMX instance
must be SYMCLI.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

12. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

13. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

14. From the Type of topology collection drop-down menu, select SMI-S or
SYMCLI (SYMCLI support removed for VMAX arrays) depending on the
array:

Array Type of topology collection

DMX SYMCLI

VMAX2 SMI-S

VMAX3 SMI-S

VMAX All Flash SMI-S

15. Configure the collection intervals as needed.
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16. Click Next.

The window displays reports settings.

17. Click Install.

18. Click Ok when the installation is complete.

Adding and configuring devices in Discovery Center
Use the following procedures to add and configure DMX, VMAX, VMAX3, and VMAX
All Flash devices in Discovery Center.

Adding DMX arrays

Before you begin

DMX can only be collected using VMAX Collector's that are configured for SYMCLI
topology collection.

Procedure

1. Click Discovery Center > Inventory Management.

2. Click EMC VMAX.

3. Click Add new device.

4. In Server, select the server where the device will be dispatched.

5. In Instance, select the instance of the emc-vmax-collect where the device will
be dispatched.

6. In Type of Symmetrix array to collect, select DMX.

7. In Array full serial number, type the full serial number for which data will be
collected.

To view the list of arrays, enter * in place of the serial number and click
Validate and Add or run the SYMCLI command symcfg list.

Note

EMC recommends not to exceed six medium-sized (30K-40K devices) VMAX
arrays for each VMAX collector.

8. In Type of performance collection (excluding LUN), select the type of source
for performance metrics related to the array and its components (except LUN).

Option Description

None Do not collect performance metrics

Unisphere for VMAX Collect performance metrics using Unisphere for
VMAX

DMX array performance can only be collected using Unisphere for VMAX since
8.x SMI Provider no longer supports DMX arrays.

9. In Type of performance collection for LUN, select None.

DMX array LUN performance cannot be collected in 8.x SMI Providers and is
therefore no longer supported.
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10. Check Enable SRDF Groups Collection if you want to see fully populated
SRDF reports.

11. If Solutions Enabler was installed in the default location, leave the Solutions
Enabler bin directory empty. If Solutions Enabler was installed in another
location, type the path to the bin directory.

12. In SYMCLI connection type, select Remote if you are using the Solutions
Enabler proxy scenario or Local if you are using a local Solutions Enabler
scenario. Refer to Preparing EMC VMAX for discovery and data collection on
page 142.

13. If you are using Remote connection, type the remote connection name in
SYMCLI connection name. This is the name of a SYMCLI service, which is
configured in the netconfig file (netcnfg). This is not a host name. To view the
name that is configured, use the symcfg list -services command.

14. Check Use SYMCLI-offline mode as needed.

Enabling SYMCLI offline mode reduces CPU load on front-end directors where
Solutions Enabler gatekeeper devices are located. Use this option only if the
SMI-S Provider or Unisphere for VMAX are running on the same Solutions
Enabler where the SYMCLI commands will be executed.

15. If you are collecting performance data using SMI-S, enter the following settings
in the SMI-S configuration section:

a. In SMI-S Provider/CIMOM host, type the name, FQDN, or IP address of
the SMI-S provider host.

b. In SMI-S Provider username and SMI-S Provider password, type the
SMI-S credentials to use.

c. Check Use advanced settings.

d. In SMI-S Provider/CIMOM port, type the port on which the SMI-S
provider is listening if it is different from the default port.

e. Check SMI-S Provider enable secure connection (SSL) to enable SSL for
all communications between the collector and the SMI-S provider.

16. If you are collecting performance data using Unisphere for VMAX, enter the
following settings in the Unisphere for VMAX configuration section:

a. In Unisphere hostname or IP address, type the name, FQDN, or IP address
of the Unisphere for VMAX host.

b. In Unisphere username and Unisphere password, type the Unisphere for
VMAX credentials to use.

c. Check Use advanced settings.

d. In Unisphere network port, type the port on which Unisphere for VMAX is
listening.

e. Check Collect MAX values from Unisphere to collect additional
performance metrics (maximum values of some of the metrics usually
collected).

17. Click Validate and Add to validate the credentials.

For information about connectivity test failures, refer to Troubleshooting
Discovery Center connectivity failures on page 155.

18. Click Ok.
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19. Click Save.

Performance data will be displayed in about an hour.

Discovery of large (> 20K devices) Symmetrix arrays may take long periods of
time due to the number of volumes. To address this, discover the Symmetrix on
its own instance. This will prevent the discovery from impacting the discovery
of other arrays on the same SYMAPI connection and allows the smaller arrays
to complete during the polling schedule.

Adding VMAX/VMAX3 arrays

Procedure

1. Click Discovery Center > Inventory Management.

2. Click EMC VMAX.

3. Click Add new device.

4. In Server, select the server where the device will be dispatched.

5. In Instance, select the instance of the emc-vmax-collect where the device will
be dispatched.

6. In Type of Symmetrix array to collect, select VMAX/VMAX3.

7. In Array full serial number, type the full serial number for which data will be
collected.

To view the list of arrays, enter * in place of the serial number and click
Validate and Add.

Note

EMC recommends not to exceed six medium-sized (30K-40K devices) VMAX
arrays for each VMAX collector.

8. In Type of performance collection (excluding LUN), select the type of source
for performance metrics related to the array and its components (except LUN).

Option Description

None Do not collect performance metrics

SMI-S Collect performance metrics using SMI-S

Unisphere for VMAX Collect performance metrics using Unisphere for
VMAX

9. In Type of performance collection for LUN, select the type of source for
performance metrics related to the array LUNs.

Option Description

None Do not collect LUN performance metrics

SMI-S Collect LUN performance metrics using SMI-S

10. Check Enable SRDF Groups Collection if you want to see fully populated
SRDF reports.
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11. Enter the following settings in the SMI-S configuration section:

a. In SMI-S Provider/CIMOM host, type the name, FQDN, or IP address of
the SMI-S provider host.

b. In SMI-S Provider username and SMI-S Provider password, type the
SMI-S credentials to use.

c. Check Use advanced settings.

d. In SMI-S Provider/CIMOM port, type the port on which the SMI-S
provider is listening if it is different from the default port.

e. Check SMI-S Provider enable secure connection (SSL) to enable SSL for
all communications between the collector and the SMI-S provider.

12. If you are collecting performance data using Unisphere for VMAX, enter the
following settings in the Unisphere for VMAX configuration section:

a. In Unisphere hostname or IP address, type the name, FQDN, or IP address
of the Unisphere for VMAX host.

b. In Unisphere username and Unisphere password, type the Unisphere for
VMAX credentials to use.

c. Check Use advanced settings.

d. In Unisphere network port, type the port on which Unisphere for VMAX is
listening.

e. Check Collect MAX values from Unisphere to collect additional
performance metrics (maximum values of some of the metrics usually
collected).

13. Click Validate and Add to validate the credentials.

For information about connectivity test failures, refer to Troubleshooting
Discovery Center connectivity failures on page 155.

14. Click Ok.

15. Click Save.

Performance data will be displayed in about an hour.

Discovery of large (> 20K devices) Symmetrix arrays may take long periods of
time due to the number of volumes. To address this, discover the Symmetrix on
its own instance. This will prevent the discovery from impacting the discovery
of other arrays on the same SYMAPI connection and allows the smaller arrays
to complete during the polling schedule.

Adding VMAX ALL Flash Arrays
Procedure

1. Click Discovery Center > Inventory Management.

2. Click EMC VMAX.

3. Click Add new device.

4. In Server, select the server where the device will be dispatched.

5. In Instance, select the instance of the emc-vmax-collect where the device will
be dispatched.

6. In Type of Symmetrix array to collect, select VMAX ALL Flash.
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7. In Array full serial number, type the full serial number for which data will be
collected.

To view the list of arrays, enter * in place of the serial number and click
Validate and Add.

Note

EMC recommends not to exceed six medium-sized (30K-40K devices) VMAX
arrays for each VMAX collector.

8. Enter the following settings in the SMI-S configuration section:

a. In SMI-S Provider/CIMOM host, type the name, FQDN, or IP address of
the SMI-S provider host.

b. In SMI-S Provider username and SMI-S Provider password, type the
SMI-S credentials to use.

c. Check Use advanced settings.

d. In SMI-S Provider/CIMOM port, type the port on which the SMI-S
provider is listening if it is different from the default port.

e. Check SMI-S Provider enable secure connection (SSL) to enable SSL for
all communications between the collector and the SMI-S provider.

9. Enter the following settings in the Unisphere for VMAX configuration section:

a. In Unisphere hostname or IP address, type the name, FQDN, or IP address
of the Unisphere for VMAX host.

b. In Unisphere username and Unisphere password, type the Unisphere for
VMAX credentials to use.

c. Check Use advanced settings.

d. In Unisphere network port, type the port on which Unisphere for VMAX is
listening.

e. Check Collect MAX values from Unisphere to collect additional
performance metrics (maximum values of some of the metrics usually
collected).

10. Click Validate and Add to validate the credentials.

For information about connectivity test failures, refer to Troubleshooting
Discovery Center connectivity failures on page 155.

11. Click Ok.

12. Click Save.

Performance data will be displayed in about an hour.

Discovery of large (> 20K devices) Symmetrix arrays may take long periods of
time due to the number of volumes. To address this, discover the Symmetrix on
its own instance. This will prevent the discovery from impacting the discovery
of other arrays on the same SYMAPI connection and allows the smaller arrays
to complete during the polling schedule.
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Troubleshooting Discovery Center connectivity failures
Discovery Center enables you to test connectivity between the ViPR SRM VMAX
collector and the VMAX array providers.

Viewing the Test button test results
Test results are displayed in the Test button tool tip.

In addition to providing error and warning messages, the test results tool tip also
provides useful information such as: SYMCLI version, SYMAPI version, SYMAPI Run
Time version, SYMAPI Server version, number of dedicated gate keepers per array,
and SYMAUTH users.

Procedure

1. Navigate to Centralized Management > Discovery Center > Inventory
Management > EMC VMAX.

2. Select a device and click Test.

3. Once the connectivity test is completed, hover over the Test button or click the
status icon to display the test results tool tip.

4. Click Click to show/hide the full result.

The tool tip expands to display the full test results.

Example 1  Example test results

SYMCLI tests skipped: SYMCLI not configured on the selected instance

Testing SMI-S configuration
Trying to connect to SMI-S provider at https://losam033:5989/cimom
Successfully connected to SMI-S provider and verified it is an ECOM SMI-S Provider
Detected Solutions Enabler version V8.4.0.0
Detected SMI-S Provider version V8.4.0.0
Validated SE V8.4.0.0 with SMI-S Provider V8.4.0.0 is at or above the recommended version
Retrieved all array instance names
Validated serial number 000196701343 was found on SMI-S Provider
Detected 000196701343 microcode version: 5977.1124.1125
Detected VMAX3 array based on microcode >= 5977
Validated detected VMAX3 array type matches selected type.
Serial number 000196701343 is a VMAX3 array (SRP storage pool detected).
Serial number 000196701343 is LOCAL to SMI-S provider losam033

Testing Unisphere configuration(s)
Trying to connect to Unisphere at https://losam033:8443/univmax
Successfully connected to Unisphere
Found UNIVMAXPA version V8.4.0.4 registered with Unisphere
Validated Unisphere V8.4.0.4 is at recommended version 8.4.0.0 or a slightly higher 
version.
Serial number 000196701343 is registered for Performance with Unisphere losam033
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Understanding the test messages
This section describes common test result messages.

Serial number errors

>>>ERROR: Serial number <serial_number> NOT found on SYMCLI 
provider. Enter * to see the list of available serial numbers.

The above message is displayed when the provided serial number cannot be found on
the Solutions Enabler server.

To get a complete list of the available serial numbers behind the Solutions Enabler
host, enter * in Array Full Serial Number and click Test.

>>>ERROR: <serial_number> was detected as VMAX3 based on microcode 
'5997' but VMAX/VMAX2 was selected.

The above message is displayed when a VMAX3 serial number is entered when VMAX/
VMAX2 was selected during SolutionPack installation.

Solutions Enabler path and file errors (DMX arrays only)

>>>ERROR: No files found in the specified path <specified_path>, 
please check manually.

The above message is displayed when the Solutions Enabler bin directory path that
you specified during SolutionPack installation cannot be found. The default Solutions
Enabler path for Linux is /opt/emc/SYMCLI/bin and the default path for Windows
is C:\Program Files\EMC\SYMCLI\bin.

>>>ERROR: symcfg file not found in the specified path 
<specified_path>, please check manually.

The above message is displayed when the specified path exists, but the symcfg
execution file cannot be found.

netcnfg errors (DMX arrays only)

>>>ERROR: Did not find netcnfg file, please check manually.

The above message is displayed when the netcnfg file cannot be found in the default
path. The default path for Linux is /var/symapi/config and the default path for
Windows is C:\Program Files\EMC\SYMAPI\config.

>>>ERROR: Could not find Service Name <service_name> in /var/symapi/
config/netcnfg

The above message is displayed when there are no SYMAPI Connection name entries
present in the netcnfg file or when there is no matching entry to what was specified
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during SolutionPack installation. You can get the netcnfg entries using the following
symcli command: symcfg list -services

>>>WARNING: Connect_string <connect_string> matches multiple 
entries in netcnfg file

The above message is displayed when there are multiple entries in the netcnfg file with
the same connect string, but with different cases (uppercase and lowercase
characters). The connectivity test will not fail if there are multiple netcnfg entries
because netcnfg entries are case insensitive, however symcli will use the first entry.
You can verify the port and security level mentioned in the netcnfg entry from the
Solutions Enabler server. On Linux, check: /opt/emc/symapi/daemon_options.
On Windows, check C:\Program Files\EMC\SYMAPI\config
\daemon_options.

Number of dedicated gatekeepers (DMX arrays only)

Number of dedicated GKs for Array <array_serial_number>:0 

The above message indicates the number of dedicated gatekeepers for an array. The
connectivity test will not fail if the number of dedicated gatekeepers is zero because
there could be non-dedicated gatekeepers available. The number of gatekeepers
recommended for an array for a Solution Enabler host is six. These include both
dedicated and non-dedicated gatekeepers.

To check dedicated gatekeepers, run the symcli command syminq –sym –symmids
and grep for a specific array serial number. On top of it grep for ‘GK’.

For more information on gatekeepers, run the following command on the Solutions
Enabler host: stordaemon action storapid -cmd show -gk_stats -sid
<serial_number>
For detailed information on gatekeeper management, refer to the EMC Solutions
Enabler Installation Guide.

Unisphere connectivity failure

>>>ERROR: Could not connect to Unisphere at https://losam034:8443/
univmax. Verify the Unisphere configuration. Also ensure that the 
Unisphere Performance Analysis has been licensed and enabled.

Ensure that the Unisphere's host's Unisphere service/daemon is running and is
network accessible. Verify port, SSL, credentials, and firewall configuration. In order
for ViPR SRM to obtain all performance data, arrays should be registered with
Unisphere for performance collection.

In order for performance to be available through Unisphere the array must have
LOCAL connectivity. In other words, the array should have gatekeeper devices on the
Unisphere host.

SMI-S Provider connectivity failure

>>> ERROR: Could not connect to SMI-S provider at https://
losam034:5989/cimom. Verify the SMI-S configuration.
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Ensure that the SMI-S Provider host's ECOM service/daemon is running and is
network accessible. Verify port, SSL, and firewall configuration.

Updating SolutionPack alert definitions
During SolutionPack update, any new alert definitions supported in the updated
version do not get updated by default. This is expected behavior.

To add newly introduced alert definitions after updating, follow the steps below.

Procedure

1. In Centralized Management, navigate to SolutionPacks > Storage > EMC
VMAX in the tree.

2. In the table, click the pen icon button to the left of Pre-configured alerts.

3. Click Reconfigure.

4. In the Alerting Frontend, navigate to Local Mananger > Alert definitions >
EMC VMAX to see the newly added alert definitions.

Configuring Solutions Enabler client access for VMAX
Symmetrix Authorization using symauth provides secure user-based authorization and
symacl provides host-based authorization. Use this procedure in environments in
which Symmetrix Authorization is enabled.

Before you begin

Ensure that you have configured an appropriate Solutions Enabler scenario as
described in Preparing EMC VMAX for discovery and data collection on page 142.

For more detailed information about Solutions Enabler, refer to the following
documents:

l EMC Solutions Enabler Symmetrix Array Management Product Guide

l EMC Solutions Enabler Symmetrix Security Configuration Guide

The following configuration procedures are specific to a Solutions Enabler proxy
configuration. However, you can also use these procedures for a local Solutions
Enabler configuration in which the ViPR SRM Collector software is installed directly
on the existing SYMAPI Solutions Enabler server. The term "client" refers to the host
where the Collector software has been installed.

When symauth is enabled, check that the user ‘apg’ is present in the user list and that
the role is Monitor or Storage Admin or Admin to access masking and mapping data.
You can check the user role using the Discovery Center Test button. For more
information, see Viewing the Test button test results on page 155.

Procedure

1. Validate if Symmetrix Authorization is enabled by running the symauth list
command on the host that has direct FC connectivity to the arrays to be
managed.

2. Check the status displayed in the the Authorization Control section to
determine the required action:

Option Description

Disabled Symmetrix Authorization is not configured. In this case, do nothing.
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Option Description

Enabled Symmetrix Authorization is configured. In this case, you must
configure the apg user and ViPR SRM hosts that will be issuing
commands. Continue to step 3.

3. If Symmetrix Authorization is enabled, use the following procedures to complete
the configuration:

a. Configuring host access on page 159

b. Adding client hosts to existing SYMAUTH configuration on page 159

c. Enabling client authorization on page 160

d. Validating Symmetrix access controls on page 161

Configuring host access
Enable the ViPR SRM apg account to access the local Solutions Enabler resources and
logs.

This procedure provides an example of configuring access on a host using the Linux
operating system.

Procedure

1. Log in to the Solutions Enabler client host.

2. Navigate to /var/symapi
3. Grant the apg user write access to the following Solutions Enabler directories

and contents:

a. chown -R apg <SYMAPI_HOME>/config
b. chown -R apg <SYMAPI_HOME>/db

4. Repeat steps 1-3 for each VMAX Collector server.

5. Grant the apg user authorization for the Solutions Enabler storapid daemon by
navigating to <SYMAPI_HOME>/config/daemon_users and adding the
following line to the storapid[Base Daemon] section of the file:

apg storapid <all>
6. Save and exit the daemon_users file.

7. Set a password for the apg user.

8. Repeat steps 5-7 for each VMAX collector server.

9. Log out and log in as the apg user and run symauth show -username to
determine the fully-qualified account name.

10. Make note of the value displayed in your current username. For example:
H:system_name\apg

11. Repeat steps 9-11 for each VMAX Collector server.

Adding client hosts to existing SYMAUTH configuration
Enable the apg user with read-only monitoring access for VMAX arrays using Solutions
Enabler User Authorization.

Before you begin

Complete the procedure described in Configuring host access on page 159.
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You must be logged in as Root or Administrator.

Perform the following procedure for each VMAX you want to enable ViPR SRM to
access.

Procedure

1. Run the symauth -sid <SID> list command to determine if User
Authorization Control is enabled on the local client system.

l If User Authorization Control is disabled (Disabled) for the specific VMAX,
proceed to Enabling client authorization on page 160.

l If User Authorization Control is enabled (Enabled) and in use (Enforced)
for the specific VMAX, continue with this procedure.

2. Ensure that you are logged in with an existing privileged account (e.g., root or
administrator).

3. Use the find / -name auth.txt command to find the auth.txt file.

4. Navigate to the folder with the auth.txt file.

5. Edit the file to include a line based on the results obtained from performing the
procedure described in Configuring host access on page 159. For example:

assign user H:system_name\apg to role Admin;
6. Save the file.

7. Use the symauth -sid <SID> -f auth.txt command to commit changes to
the User Authorization User-to-Role map.

8. Repeat this procedure for each VMAX array.

Enabling client authorization
Use this procedure when User Authorization Control is disabled (Disabled) for the
specific VMAX and you want to restrict the apg user to a monitoring role without
limiting other accounts in the environment.

Before you begin

You determined that User Authorization Control is disabled by performing the task
described in Adding client hosts to existing SYMAUTH configuration on page 159.

You are logged in to the client host with local root or administrator credentials.

Procedure

1. Create an auth.txt file with the following contents:

assign user * to role Admin;

set enforcement enforce;

assign user H:system_name\apg to role Admin;

2. Repeat step 1 for each VMAX Collector server.

3. Use the symauth -sid <SID> -f auth.txt command to commit changes to
the User Authorization User-to-Role map.

4. Repeat step 3 for each VMAX array.

5. Use the symauth -sid <SID> enable command to enable User Authorization
Control for a specific VMAX array.

6. Repeat step 5 for each VMAX array.
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7. Use the symauth list command to validate that User Authorization Control is
enabled and enforced.

   S Y M M E T R I X   A U T H O R I Z A T I O N   S T A T U S

Symmetrix ID: 000195700363

  Authorization Control           : Enabled

  Time Enabled                    : Mon Aug  5 12:51:08 2013
  Time Disabled                   : Thu Aug  1 15:54:23 2013
  Time Updated                    : Mon Aug  5 12:51:08 2013

  Enforcement Mode                : Enforce
  Server Policy                   : Trust clients

Validating Symmetrix access controls
Validate that the Symmetrix Access Control (SymACL) security feature is enabled and
in use on VMAX systems.

Before you begin

You are logged in to the client host with local root or administrator credentials.

In order for all masking and mapping details to be collected, the Solutions Enabler host
should belong to an Access Group that has been granted VLOGIX permissions for the
ALL_DEVS access pool.

Procedure

1. Run the symacl list command for each VMAX array. Status information is
displayed.

   S Y M M E T R I X   A C C E S S   C O N T R O L   S T A T 
U S

Symmetrix ID: 000195700363

    Access    Session
    Control   Locked   Time Last Updated
    --------  -------  -------------------------
    N/A       N/A      N/A

Symmetrix ID: 000195700932

    Access    Session
    Control   Locked   Time Last Updated
    --------  -------  -------------------------
    N/A       N/A      N/A

l If the Access Control field indicates N/A, SymACL is not enabled on this
VMAX system. No action is necessary.

l If the Access Control field indicates Enabled, continue this procedure to
secure ViPR SRM client systems from a host system in the existing SymACL
AdminGrp for each VMAX system.

2. Create a SymACL access group appropriate to contain the ViPR SRM client
systems (e.g., SRMGRP)

3. Add each client system's unique identifier to the access group.

4. Repeat for each ViPR SRM client host system.
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5. Grant BASE access rights to the access group just created for all devices
(ALL_DEVS).

6. Repeat this procedure for each VMAX system monitored by ViPR SRM.

Limitation: some alerts not displayed
ViPR SRM fails to receive and display some alerts

If a trap is lost in the network communication, Solutions Enabler is not aware of the
host and is not able to resend the lost information.

Resolving SMI-S Provider port conflicts
Some versions of Microsoft Windows may have a WMI component that causes a port
conflict with the SMI-S Provider. This has been observed on Windows Server 2012 R2
with the 8.x SMI-S Provider.

When there is a port conflict, the SMI-S Provider service will start and then
immediately shut down. The cimom.log file on the Provider host will have errors similar
to: CIMOM: Failure to start listener on port - 5985, as shown in the
following example:

15-Sep-2015 14:39:26.474 -8488-E- WebServer: Http Server Listener 
unable to listen on address and port: [0:0:0:0:0:0:0:0]:5985
15-Sep-2015 14:39:26.474 -8488-E- WebServer: NAVSocket::bind() 
returned error Permission denied (on [0:0:0:0:0:0:0:0]:5985) : 
15-Sep-2015 14:39:33.443 -2892-E- CIMOM: Failure to start listener 
on port - 5985, interface - ::.
15-Sep-2015 14:39:33.458 -2892-E- 
NAVHTTPServerListenerJoiner::setTotal: Total NAVHTTPServerListener 
threads: 18446744073709551615, code=1
15-Sep-2015 14:39:33.458 -2892-E- CIMOM: Shutting down ECOM...

Procedure

1. Login to the SMI-S Provider host.

2. In Windows Explorer, navigate to C:\Program Files\EMC\ECIM\ECOM
\conf\Port_settings.xml, right-click the file, select Properties, uncheck
the Read only attribute, and click OK.

3. Open C:\Program Files\EMC\ECIM\ECOM\conf\Port_settings.xml
in a text editor and change the "Port2" <port> value from 5985 to 6985, as
shown below:

<ECOMSetting Name="Port2">
<!--
       <portRange>5985</portRange>
-->
    <port>6985</port>
    <secure>false</secure>
    <slp>true</slp>
</ECOMSetting>

4. Restart the SMI-S Provider service and verify that it does not shutdown within
a few seconds of being started.
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Limitations

l CSV files that were exported from Discovery Center with ViPR SRM 4.0 cannot be
used to import devices into ViPR SRM 4.1 or later.

l When using SMI-S for data collection of VMAX2 devices, the # Devices column
displays 0 for FICON Directors and FICON director ports. The SMI-S provider
does not currently provide this information.

l After upgrading, it is possible that some VMAX devices will not collect Unisphere
for VMAX performance metrics. This can occur because only the first Unisphere
for VMAX host in the SolutionPack configuration is configured to collect metrics
after the upgrade while others are ignored. It is recommended to run the Test
script in Discovery Center on all VMAX devices to identify the devices that must
be reconfigured.

l With the new support for Federated Tier Storage (FTS) in VMAX/XtremeIO, the
flash storage from XtremeIO can be mapped into VMAX as external capacity. With
both XtremeIO and VMAX arrays discovered into ViPR SRM, the FTS capacity will
be accounted for in both VMAX and XtremeIO array capacities, which will result in
the Total rows in the global reports double counting the capacities.

l The Subscribed column of the Pools report (Report Library >> EMC VMAX >>
Inventory) is incorrect when the pool is over subscribed. The SMI-S Provider
included with the required Solutions Enabler 8.2.0.18 includes this fix.

l EMC VMAX > Inventory > Ports report will show empty columns for the iSCSI
virtual ports. Port, WWN, WWPN, Port Status, and Availability columns will be
empty for virtual ports. Masking and Mapping details are also not available for
these iSCSI ports.

l Performance > SG SLO Compliance report is designed to exclude storage groups
having an SLO Compliance of “NONE”.

l EMC VMAX SolutionPack only collects Storage Group performance using
Unisphere. Storage Group performance is not collected using SMI-S Provider.
Performance collection using SMI-S Provider only collects performance data for
Array, BE director, FE Director, FE Ports, RDF Director, Disk, and Volume.
Unisphere provides many additional performance metrics over the SMI-S Provider.

l Port Reports shows empty columns for the iSCSI virtual ports if the array has
iSCSI virtual port attached to Directors. Port, WWNN, WWPN, Port status, and
Availability columns will be blank.

l Based on new metrics calculation in 9.0 SE, Subscribed and Oversubscribed
values differs for Non-PowerMax arrays discovered under 9.0 SMI compared to
8.4 SMI.
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CHAPTER 21

SolutionPack for EMC VMAX HYPERMAX

This chapter includes the following topics:
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l Troubleshooting Discovery Center connectivity failures.................................... 171
l Updating SolutionPack alert definitions............................................................ 172
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SolutionPack for EMC VMAX HYPERMAX     165



Overview
The SolutionPack for EMC VMAX HYPERMAX collects capacity, topology, and
performance information for arrays using the HYPERMAX OS (microcode 5977).
Supported array families include VMAX3 and VMAX All Flash arrays.

Configuring the access credentials
EMC M&R uses different accounts when running SolutionPacks.

Unisphere for VMAX credentials:

l Username - the default is smc
l Password - the default is smc

Preparing EMC VMAX HYPERMAX for discovery and data
collection

Identify the information that is required to support data collection before installing the
SolutionPack for EMC VMAX HYPERMAX and perform the necessary pre-
configuration.

VMAX3/VMAX All Flash discovery scenario

Array Provider Host
All the metrics for VMAX3 and VMAX All Flash arrays are collected using the
Unisphere REST API. Hence the HYPERMAX collector should be configured to use
Unisphere so that all HYPERMAX report fields will have data. This Array Provider Host
should have six or more dedicated gatekeeper devices for each HYPERMAX array that
is connected to it.

Remote discovery configuration is referred to when Unisphere is installed on an Array
Provider Host which is separate from the HYPERMAX Collector Host. The minimum
Array Provider Host configuration is 4 CPUs and 16 GB memory. More memory will be
required when managing more than 50k total devices, with a maximum of 100k devices
per Array Provider Host. Refer to the Unisphere for VMAX Release Notes to
determine the Array Provider Host's scalability and CPU/Memory requirements.

The HYPERMAX Collector can be installed directly on an existing Unisphere for VMAX
host (referred to as local discovery configuration) if it has enough resources to support
the collector processes. Local Discovery Configuration requires a minimum of 4 to 8
CPUs and 32GB memory to support the HYPERMAX Collector as well as Unisphere
for VMAX. More memory and CPU may be necessary to support other hosted
collectors and/or any non-ViPR SRM processes.

Unisphere performance
Unisphere for VMAX will gather performance data for arrays that are:

l Directly SAN-attached to the Array Provider Host
l Gatekeeper devices that are created on the Unisphere host (creating a "Local

connection" to the array)
l Registered with Unisphere for performance collection

Performance data is not available for arrays that are:
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l Indirectly attached to the Array Provider Host through a local array's SRDF
connection (called a "Remote connection" to the array)

l Not registered with Unisphere for performance collection

Once performance data is available in Unisphere and the array is collected by the
HYPERMAX collector, it may take 1 hour to 2 hours before the performance data will
be seen in the HYPERMAX reports.

Collector Host (Remote Discovery Configuration)
Collector Hosts are installed with the SolutionPack for EMC VMAX HYPERMAX and
configured to connect to the Unisphere for VMAX on the Array Provider Host. Refer
to the ViPR SRM Performance & Scalability Guidelines for SolutionPack for EMC VMAX
HYPERMAX planning that is based on the number of arrays and array configurations
being managed. As a rule, ViPR SRM Collector Hosts should be installed as near as
possible to the Array Provider Host to avoid network latency between the collector
and Unisphere. For example, if there is high network latency (100 ms or greater) from
the local data center to the remote data center then the HYPERMAX Collector Host
and Array Provider Host should be co-located within the remote data center. The host
running Unisphere for VMAX and the ViPR SRM collector host must have the same
date and time and must be in same time zone, otherwise, the ViPR SRM collector may
not return performance data if the ViPR SRM collector host's clock is too far ahead of
the Unisphere host's clock.

Verifying the configuration
Verify that the HYPERMAX collector configuration is correct by using the Discovery
Center Test option for each HYPERMAX array. Tests that are performed include basic
Unisphere connectivity tests, Unisphere version checks, Unisphere performance
registration tests, and an array existence test. The configured discovery settings can
be confirmed by using the Test utility as described in Troubleshooting Discovery
Center connectivity failures.

Creating collectors for discovery of Symmetrix arrays (local discovery
configuration)

The following procedure describes how to create HYPERMAX collectors for discovery
of all VMAX3 and VMAX All Flash arrays in ViPR SRM.

Procedure

1. Create a Windows (2008, 2012, 2012R2) or Linux (RH 5+, Suse 10+) Vmguest
with eight RDM gatekeepers that are allocated to the server from each local
Symmetrix array (have been tested for 60,000 volumes total).

2. Size the server as follows: 4–8 CPUs, 32 GB RAM, 200 GB Storage.

3. Install Unisphere for VMAX on the HYPERMAX collector server. This server will
only be used for ViPR SRM data collection (no production allocation use).

4. Ensure that the server can see no more than 466,000 volumes and be sure to
leave room for growth. Run symcfg list from Solutions Enabler to verify.

5. Create a symavoid file if too many Symmetrix arrays are visible until you get the
volume count on the server below 466,000 volumes and be sure to allow for
growth. You will be blocking the remote arrays as well in the symavoid file.
Remote arrays will be discovered in remote datacenters locally by a HYPERMAX
collector server there.

6. Install ViPR SRM collector software on this server. Add this server to ViPR
SRM as a scale out collector.

7. Install only the SolutionPack for EMC VMAX HYPERMAX collector on this
server.
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8. Set the Java heap for the HYPERMAX collector to 2 GB (refer to the ViPR SRM
Performance and Scalability guidelines for more information).

9. In ViPR SRM, use only the local discovery option and enter the Solutions
Enabler install directory, if it is not the default.

10. This server will be used to fill in the Unisphere for VMAX for discovery in ViPR
SRM.

Configuring HYPERMAX arrays for consolidation of availability alerts
Use this procedure to configure forwarding of availability alert traps (SNMP v1) from
HYPERMAX arrays to ViPR SRM.

HYPERMAX performance alerts are collected using the discovery data collection
configuration.

Procedure

1. Log in to Solutions Enabler on the array provider host as an administrator.

2. Browse to the daemon_options file in the C:\Program Files\EMC
\SYMAPI\config\ directory.

3. In the parameter section SNMP_TRAP_CLIENT_REGISTRATION:

a. Uncomment the line storevntd:SNMP_TRAP_CLIENT_REGISTRATION
b. Add the ViPR SRM trap recipient IP to the trap filter. In a single vApp

installation, this parameter is the ViPR SRM IP, and in a distributed
environment, is the Primary Backend server's IP.

The syntax is <IP>,<port>,<filter>,<state>, where <filter> is the
filtering level for trap forwarding that is defined in the FCMGMT-MIB file.

Example: 10.31.90.148, 2041,10,ACTIVE
4. In the parameter section LOG_EVENT_TARGETS, uncomment the line

storevntd:LOG_EVENT_TARGETS = snmp file.

5. To identify the arrays from which traps should be forwarded to ViPR SRM, type
symcfg list, and press Enter.

6. For each array that should forward alert traps to ViPR SRM:

a. Type symcfg list, and press Enter.

b. In the parameter section LOG_SYMMETRIX_EVENTS, specify the event
categories in the format:

sid=<SYM serial number>, <event category 1>, <event
category 2>\
Example: SID=000194900854, disk, device, device pool,
director, srdf consistency group, srdfa session, srdf
link, srdf system, service processor, environmental,
diagnostic, checksum, status, events, array subsystem,
groups, optimizer, thresh_critical=3, thresh_major=2,
thresh_warning=1, thresh_info=0 ;\

7. To reload the changes to the daemon_options file, type stordaemon action
storevntd -cmd reload, and press Enter.

8. Ensure that the storevntd Event Daemon is running on the provider host.
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9. If you have multiple HYPERMAX array provider hosts in the storage
environment, repeat this procedure on each array provider host.

Installing the SolutionPack
Before you begin

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l The ViPR SRM Alerting Guide explains how to configure alerts consolidation.

Note

Use only one SolutionPack, either the SolutionPack for EMC VMAX or the
SolutionPack for EMC VMAX HYPERMAX, to collect data from VMAX3 and VMAX All
Flash arrays. Using both SolutionPacks to collect data from the same array consumes
significant collector resources and can have potential consequences to reports and
chargeback calculations.
The SolutionPack for EMC VMAX HYPERMAX comes with some limitations when
compared to the existing SolutionPack for EMC VMAX. Notably, there is no LUN
performance, Disk, Disk Group, or Data Pool metrics that will be collected. LUN
capacity and topology metrics are still collected. Storage Group performance and SLO
compliance metrics should be used in lieu of LUN performance metrics. And, Storage
Resource Pool (SRP) capacity and performance metrics should be used as an
alternative to the metrics for the SRP’s underlying subcomponents (that is, Disks,
Disk Groups, and Data Pools that make up the SRP).

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

7. Click Next.

The window displays a note about Alert Consolidation.

8. Click Next.

The window displays pre-configured alert details.

9. Click Next.

The window displays data collection details.

10. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.
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11. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

12. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

13. Configure the collection interval as needed.

14. Click Next.

The window displays reports settings.

15. Click Install.

16. Click Ok when the installation is complete.

Adding and configuring devices in Discovery Center
Use the following procedure to add and configure VMAX3 and VMAX All Flash devices
in Discovery Center.

Procedure

1. Click Discovery Center > Inventory Management.

2. Click EMC VMAX HYPERMAX.

3. Click Add new device.

4. In Unisphere hostname or IP address, type the name, FQDN, or IP address of
the Unisphere for VMAX host.

5. In Unisphere network port, type the port on which Unisphere for VMAX is
listening.

6. In Array full serial number, type the full serial numbers for the arrays that will
be collected.

If multiple arrays will be collected from the same Unisphere instance, serial
numbers may be separated by spaces.

To view the list of arrays visible to the Unisphere instance and registered for
performance collection, type * in place of the serial numbers and click Validate
and Add.

7. To validate the credentials, click Validate and Add.

8. Click Ok.

9. Click Save.

Performance data should be displayed in about an hour.
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Troubleshooting Discovery Center connectivity failures
Discovery Center enables you to test connectivity between the ViPR SRM VMAX
collector and Unisphere.

Viewing the Test button test results
Test results are displayed in the Test button tool tip.

In addition to providing error and warning messages, the test results tool tip also
provides useful information such as: Unisphere version, VMAX3, and VMAX All Flash
arrays visible to Unisphere, arrays registered with Unisphere for performance
collection.

Procedure

1. Browse to Centralized Management > Discovery Center > Inventory
Management > EMC VMAX HYPERMAX.

2. Select a device and click Test.

3. Once the connectivity test is completed, hover over the Test button or click the
status icon to display the test results tool tip.

4. Click Click to show/hide the full result.

The tool tip expands to display the full test results.

Example 2  Example test results

Execution steps

Testing Unisphere connection
Checking Unisphere Performance license
Checking Unisphere for VMAX3 and VMAX All Flash Array registrations
Checking Unisphere for performance registrations
Validating serial numbers to collect
Tests completed successfully. See details in full result.

Testing Unisphere configuration
Trying to connect to Unisphere at https://losam033:8443/univmax
Successfully connected to Unisphere
Found UNIVMAXPA version V8.4.0.4 registered with Unisphere
Validated Unisphere V8.4.0.4 is at recommended version 8.4.0.0 or a slightly higher 
version.

Detected VMAX3 and VMAX All Flash arrays visible to Unisphere:
 - 000196701343
 - 000196701405

Detected arrays registered for Unisphere performance data collection:
 - 000195700949
 - 000195701185
 - 000196701343
 - 000196701405

Validating all entered VMAX3/VMAX All Flash serial numbers:
* All entered serial numbers are registered with Unisphere
* All entered serial numbers are registered for Unisphere Performance stats collection
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Understanding the test messages
This section describes common test result messages.

Serial number errors
The message is displayed when the provided serial number cannot be found on the
Solutions Enabler server.

>>>ERROR: Serial number <serial_number> NOT found on UNISPHERE. 
Enter * to see the list of available serial numbers.

To get a complete list of the available serial numbers behind the Solutions Enabler
host, type * in Array Full Serial Number and click Test.

>>>ERROR: One or more entered VMAX3/VMAX All Flash serial numbers 
were not found on the Unisphere instance.

>>>ERROR: Serial number 000195700930 does not match any of these 
detected serial numbers: 000196701343,000196701405,000196800574

The message is displayed when a serial number is entered when VMAX3/All Flash was
selected during SolutionPack installation and the serial number was not included in the
list of detected HYPERMAX array serial numbers that are returned from Unisphere.

Updating SolutionPack alert definitions
During SolutionPack update, any new alert definitions that are supported in the
updated version do not get updated by default. This is expected behavior.

To add newly introduced alert definitions after updating, follow the steps:

Procedure

1. In Centralized Management, browse to SolutionPacks > Storage > EMC
VMAX HYPERMAX in the tree.

2. In the table, click the pen icon button to the left of Pre-configured alerts.

3. Click Reconfigure.

4. In the Alerting Frontend, browse to Local Mananger > Alert definitions > EMC
VMAX HYPERMAX to see the newly added alert definitions.

Limitations

l The REST calls used by the SolutionPack for EMC VMAX HYPERMAX do not
collect some metrics, such as disk group capacity, unusable capacity, and hot
spare capacity that are collected by the SolutionPack for EMC VMAX. These
values are used to calculate RAID overhead capacity, configured including RAID.
Therefore, values that are displayed in the SolutionPack for EMC VMAX
HYPERMAX for a VMAX array will vary from the values that are displayed in the
SolutionPack for EMC VMAX.

l When both the SolutionPack for EMC VMAX HYPERMAX and the SolutionPack
for EMC VMAX are installed, and alerts are enabled, both SolutionPacks process
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the alerts and either one of them will report the alert in the SolutionPack's
Operations > Alerts report.

l Performance > SG SLO Compliance report is designed to exclude storage groups
having an SLO Compliance of NONE.

Limitations specific for 9.0 SE
l Based on the new metrics calculation in 9.0 SE, Subscribed capacity and Overall

Efficiency Ratio value differs for Non-PowerMax arrays that are discovered
under 9.0 Unisphere compared to 8.4 Unisphere.

l Spare disks count mismatch at Array level.

l For arrays that are discovered under 9.0 SE, mentioned metrics are not available:

n EffectiveUsedCapacityPercent

n VPSavedPercent

n VPSharedRatio

n SnapshotSavedPercent

n SnapshotSharedRatio

n VPCompressionRatio

n SnapshotCompressionRatio

n SnapshotAllocatedPercent
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Overview
The SolutionPack for EMC VPLEX collects performance, topology, and capacity data
from your VPLEX systems and displays the data in easy-to-use reports.

With this SolutionPack, you can unify your view of multiple VPLEX systems, including
physical storage to virtual storage relationships. Capacity reports, such as Thick, Thin,
Allocated and Not Allocated, help you to improve the availability of business critical
applications and services by ensuring that those applications have the storage
resources they need to operate effectively.

Installing the SolutionPack

Before you begin

l Before installing confirm that the VPLEX model is supported.

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l Identify the VPLEX type (Metro or Local), VPLEX Cluster IP/Hostname, VPLEX
Cluster Serial Number, and valid credentials.

l Check that a sink file is listed for each of the directors on the cluster.
If the sink file is not listed for a director, check that the clusters and their
associated directors are operating correctly. If the monitors are not created the
SolutionPack can still be installed, but the performance data will be missing for the
corresponding directors. For instance, if cluster-2 is down then you could still
install the SolutionPack but it will not collect any performance data for directors
on that cluster.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays pre-configured alert details.

9. From the Alerting Consolidation drop-down menu, select the Primary Backend
host.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
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2020, which is the Collector host where the Load Balancer Connector is
installed.

12. Leave Enable Topology Backend on data collected checked.

13. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

14. Select Use advanced settings to configure polling settings.

15. Click Next.

The window displays reports settings.

16. Click Install.

17. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

Troubleshooting performance data collection issues

Ensure that on each VPLEX cluster, VPLEX Perpetual monitors are not stopped and
are logging director and virtual volume performance data. To do this, login to VPLEX
and look for the Perpetual Monitor log files located at /var/log/VPlex/cli/
director*PERPETUAL*.log. There are separate perpetual monitor log files for
VPLEX Directors and VPLEX virtual volumes. And for each type, there is one log file
per director. These log files are used to collect performance data. Ensure that the last
modified time stamp for all such log files is not older than a few minutes.

In case the perpetual monitor log files are old, it means that the perpetual monitors
have stopped and you may not this data be collected. VPLEX KB articles have more
information on how to resolve this issue.

Adding and configuring devices in Centralized Management

Before you begin

l While adding a new device, ensure that cluster 1 IP and serial number are not
interchanged with the cluster 2 IP and Serial Number.

Procedure

1. Click Centralized Management > Inventory Management.

2. Click VPLEX.

3. Click Add... button.

4. In the VPLEX section, provide the cluster host and authentication details for
your VPLEX system.

The default username for the VPLEX is service and the default password is
Mi@Dim7T. For the ViPR SRM username to have all of the required permissions
on the array, you must use service as the username. The password can be
changed from the default.

SolutionPack for EMC VPLEX

Troubleshooting performance data collection issues     177

https://emc.my.salesforce.com/_ui/search/ui/UnifiedSearchResults?str=perpetual+monitors+vplex#!/fen=ka&initialViewMode=detail&str=perpetual%20monitors%20vplex%20


It is important to enter the cluster information correctly, clusters are mapped to
their correct number. Interchanging cluster IPs and SN results in a failure to
collect performance data.

Be sure to select the correct VPLEX type while adding the device. If you are
adding a VPLEX Metro, select the Metro VPLEX type from the drop-down and
enter both VPLEX cluster details. If you are adding a VPLEX Local, select the
Local VPLEX type from the drop-down and enter the VPLEX cluster details. Do
not add a Metro VPLEX System as two separate Local VPLEX Systems.

5. Click Validate and Add to validate the credentials.

6. Click Ok.

7. Click Save.

It will take approximately take three hours for data to start appearing on
reports.

After you finish

Note

Threshold based alerts are disabled by default. To manually enable threshold based
alerts, go to Administration > Modules > Alerting > Alert Definitions > EMC VPLEX
Alert Definitions. (SNMP based alerts are enabled by default.)

Configure VPLEX SNMP
Configure your VPLEX server to send SNMP traps to ViPR SRM on port 2041.

For more information about configuring SNMP on VPLEX, refer to the EMC VPLEX
Administration Guide.

Procedure

1. Log into the VPLEX CLI.

2. From the VPlexcli:/> prompt, enter: cd notifications/call-home/snmp-
traps/

3. Create a trap using the command: create <trap-name>
Where <trap-name> is any string that you want to use.

4. cd to <trap-name>.

5. Configure the trap to send notifications to ViPR SRM using the command: set
remote-host <IP address>
Where <IP address> is the IP address of the server receiving the traps. For
example, on a four VM deployment, this is the IP address of the Primary
Backend.

6. Configure the trap to send data to port 2041 using the command: set remote-
port 2041

7. Start sending notifications by using the command: set started true

Limitations

This SolutionPack supports the following backend arrays: EMC VMAX, EMC VNX,
EMC Unity, NetApp, EMC XtremIO, IBM XIV, Hitachi Device Manager, HP
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StorageWorks P9000, and HP 3PAR. This SolutionPack does not support EMC
ScaleIO, IBM DS arrays, or EMC Isilon at the backend of EMC VPLEX.

Only encapsulated virtual volumes are supported. LVM virtual volumes are not
supported.

Chargeback, path details, and end-to-end reports only support encapsulated virtual
volumes. Virtual Volumes created using logical volume management is not supported.

When an underlying virtual disk, on which the virtual volume is created, is also
contributing to other virtual volumes, VPLEX and Host path details show incorrect
values in the Storage View column for that particular virtual volume. Instead of listing
only the Storage Views that it belongs to, it shows a pipe separated list of all the
Storage Views that the underlying virtual disk is contributing to.
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Overview
The SolutionPack for XtremIO generates real-time and historical reports and access
capacity, performance, and inventory details. This feature gives insight into the
management of the EMC XtremIO flash based storage platform.

Installing the SolutionPack

Before you begin

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down, select existing settings that have been
specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection.

l FailOver-Filter must be enabled, which is the default.

l Hostname or the IP address to send data to must point to the host where
the collector is installed (localhost in a one-VM deployment and collector
host in a multi-VM deployment).

l Network port to send data to must be set to the port to which the
collected data is sent. Specify the Arbiter port or legacy Backend data port.
If you have chosen a port other than 2020 for Arbiter, then the same port
has to be configured in this field.

12. Leave Enable Topology Backend on data collected checked.

13. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.
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If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

14. To configure polling settings, select Do you want to configure advanced
settings.

For XtremIO 4.0 arrays, use Performance Polling Interval (4.0 or later) to
configure the performance interval separately. Intervals of 5 (default), 15, and
30 minutes are available.

15. Click Next.

The window displays reports settings.

16. Click Install.

17. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

Adding and configuring devices

Procedure

1. Click Discovery Center > Inventory Management.

2. Click XtremIO.

3. Click Add new device.

4. From Server, select the server where the device will be dispatched.

5. From Instance, select the instance of the emc-xtremio-collect where the
device will be dispatched.

6. In the section XtremIO configuration, type the IP and credentials of the
XtremIO array’s Management IP address or hostname.

l In Management IP address or hostname, type the array management IP or
hostname.

l Add the username and password of the XtremIO array

l Select the time zone of the XtremIO system in UTC format

7. To validate the credentials, click Validate and Add.

8. Click Save.

9. Click Ok.

Limitations

l CSV files that were exported from Discovery Center with a release earlier to ViPR
SRM 4.1.1 cannot be used to import devices into ViPR SRM 4.2 as is. To import
devices using the earlier CSV file, delete "version" column in the CSV file.

l As part of XtremIO 4.0 support, the following new reports have been added to the
SolutionPack: Battery Backup Unit, Disk Array Enclosure, Local Disks, and Folders.
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When XtremIO 3.0 or earlier arrays are discovered, these new reports will not
display any data.

l Performance and capacity polling is separated starting in ViPR SRM 3.7 due to the
new XtremIO 4.0 RESTful API Ver. 2.0. While discovering, you can configure the
performance interval separately (the default is 5 minutes). Although you are can
see the performance interval to be selected while discovering an earlier version of
XtremIO (3.0 or less), it will not be taken as performance polling and will work like
the earlier versions.

l As part of XtremIO X2 support, DAE Row Controllers and NVRAM are the new
reports added to the SolutionPack. When XtremIO 4.0 or earlier arrays are
discovered, these new reports will not be displayed.
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Overview
The SolutionPack for Hitachi Device Manager accesses performance data,
configuration data, and capacity planning data pertaining to the Volumes, Disks, Ports,
Dynamically Provisioned Pools, and Parity Groups of Hitachi storage systems.

Preparing Hitachi Device Manager for discovery and data
collection

Identify the information that is required to support resource discovery and data
collection before installing the SolutionPack for Hitachi Device Manager

ViPR SRM communicates with the Hitachi Device Manager to poll information for HDS
arrays.

Procedure

1. Identify read only account credentials with the ability to view all on the Hitachi
Device Manager system

2. Record the IP address/hostname for SSH and CIMOM communication

Installing the SolutionPack

Before you begin

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays pre-configured alert details.

9. From the Alerting on data collection drop-down list, select existing settings
that have been specified for other components, or select Add a new alerting
data collection.

If you select Add a new alerting on data collection, Alerting Web-Service
Instance dropdown will have default value. Do not change the values.

10. Click Next.

The window displays data collection details.
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11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

12. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

13. Leave Enable Topology Backend on data collected checked.

14. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

15. Select Use advanced settings to configure polling and alert settings.

16. Click Next.

The window displays reports settings.

17. Click Install.

18. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

19. Click Discovery Center > Inventory Management.

20. Click Hitachi Device Manager.

These steps describe how to add hosts individually. For information about using
discovery groups to use the same credentials to discover multiple hosts, see 
Adding devices to discovery groups.

21. Click Add new device.

22. Select the server and collector instance where you want to store the
configuration details for this device.

23. From the HDS type drop-down list, select Device Manager Collection, and
type a unique friendly name (such as the host or IP address) for the system.

a. Supply the login credentials, and specify the appropriate configuration
settings.

b. If you want to discover a single array (than all of the devices that are
managed by Hitachi Device Manager), check Discover Single Array, and
specify the serial number of the array that you want to discover.

c. If you want to enable the discovery of passive hosts and logical groups from
Hitachi Device Manager, check Enable Passive Hosts & Logical Groups
Discovery.
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Note

EMC recommends that you only enable this option once for arrays that are
managed by a single Hitachi Device Manager instance that is configured
against a collector. If the arrays discovered on a collector host are managed
by different Hitachi Device Managers, you should enable this option on one
array for each Hitachi Device Manager.

d. If you want to collect array performance data from the specified Hitachi
Device Manager, check Enable Performance Collection.

Note

EMC recommends that you only enable this option once for arrays that are
managed by a single Hitachi Device Manager instance that is configured
against a collector. If the arrays discovered on a collector host are managed
by different Hitachi Device Managers, you should enable this option on one
array for each Hitachi Device Manager.

24. If you want to configure Performance Collection against a specific array, select
Embedded Performance Collection from the HDS type drop-down list, and
type a unique friendly name (such as the host or IP address) for the system.
Supply the login credentials, and specify the appropriate configuration settings.
For the Array IP Address or FQDN type the IP address of the array. For
additional details, see Embedded Performance Collection.

25. To validate the credentials, click Validate and Add.

26. Click OK.

27. Click Save.

Troubleshooting Device Manager collection
Learn how to troubleshoot Device Manager collection issues.

Procedure

1. Use a web browser to log in to Device Manager with http://<hitachi
device manager IP or hostname>:<port #(example:23015)>/
DeviceManagerWebService/index.jsp

2. Type the same username and password credentials that is used for ViPR SRM
discovery.

3. Validate that you can view all of the expected Hitachi Storage Systems under
the Resources tab.

Embedded Performance Collection
Performance statistics are provided for the HUS VM, VSP, and VSP G1000 through
the Embedded SMI-S Provider.

The following components are supported:

l Storage system

l Front end port
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l Volume

An SMI-S license is required, but it comes with the array for free. It must be enabled in
Storage Navigator.

In Hitachi Storage Navigator, a user with the role of "Storage Administrator with view
only permission" is required.

Enabling the SMI-S certificate
Learn how to enable the SMI-S certificate on the array.

Procedure

1. Refer to the Hitachi Command Suite Administrator Guide for details.

The following chapters are related to enabling the SMI-S certificate:

l Uploading the signed certificate

l Returning the certificate to the default

Restarting the SMI-S provider
Learn how to restart the SMI-S provider.

Procedure

1. Close all of the Device Manager - Storage Navigator sessions on the SVP
(service processor).

2. Start the web browser.

3. In the browser on the Device Manager - Storage Navigator computer, type the
following URL:

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

4. Click Update Certificate Files for SMI-S.

5. In the Login dialog box, type the administrator user ID and password, and click
Login.

6. Click Return to the default certificate, and click OK.

Enabling performance monitoring in Storage Navigator
Learn how to enable performance monitoring in Storage Navigator.

Procedure

1. Open Performance Monitoring and check to see if Monitoring Switch is set
to Enabled.
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2. If Monitoring Switch is not set to Enabled, enable it by clicking Edit
Monitoring Switch.

Configuring embedded performance monitoring
Learn how to configure embedded performance monitoring.

Procedure

1. Navigate to Discovery Center > Inventory Management > Hitachi Device
Manager.

2. Discover the Device Manager that manages the arrays that you want to
monitor.

a. Click Add new device.

b. For HDS type, select Device Manager Collection.

c. Enter the configuration details for the device manager, and select the
Collect performance check box.

d. Click Test to verify the connection.

3. Discover embedded performance collection.

a. Click Add new device.

b. For HDS type, select Embedded Performance Collection.

c. Enter the configuration details for the array.

d. Click OK.

4. Click Save.

Troubleshooting the Embedded SMI-S Provider
Use EMC ECOM Explorer (or any CIM/SMI-S browser) to verify that the Embedded
SMI-S Provider is enabled and performance statistics are populated on the array.

Procedure

1. Open ECOM Explorer and choose File > Login.

2. In the Host Name field, type the IP address or FQDN of the array.

3. Type the port number. The default is 5988 or 5989 (SSL) depending on the
configuration.
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4. In the Interop Namespace field, type interop.

5. Type the same username and password that you used for ViPR SRM discovery.

6. Once you have successfully logged in, ensure that the following classes are
listed under the root/hitachi/smis tree:

l Classes:

n HITACHI_BlockStaticsticalDataStorageSystem

n HITACHI_BlockStaticsticalDataFCPort

n HITACHI_BlockStaticsticalDataStorageVolume

Limitations

l LUNs from Hitachi AMS200 arrays do not appear in path details and end-to-end
reports.

l The Performance Collection Troubleshooting report does not apply to the
performance metrics pulled from the Embedded Performance Collector.

l Enterprise capacity numbers are incorrect when all the capacity for the Hitachi
storage system is provided by the external storage.
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Overview
This SolutionPack enables you to generate real-time and historical reports and access
capacity, performance, and inventory details about the HP 3PAR StoreServ systems.

Preparing the system for discovery and data collection
Identify the information that is required to support resource discovery and data
collection before installing the SolutionPack for HP 3PAR StoreServ.

ViPR SRM communicates with the HP 3PAR StoreServ system using an account with
read-only privileges on the system.

Procedure

1. Identify an account with browse privileges for the HP 3PAR StoreServ system.

2. Ensure that the array can be accessed on port 22 using SSH.

3. Ensure that the CIM server is enabled and can be accessed on the array.

Installing the SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The windows displays alert details.

9. From the Alerting on data collection drop-down menu, select existing settings
that have been specified for other components, or select Add a new alerting
data collection.

If you select Add a new alerting on data collection, type information about the
alerting configuration. In Alerting Backend hostname or IP address, specify
the Primary Backend host.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port

SolutionPack for HP 3PAR StoreServ

194 EMC ViPR SRM 4.2.1  SolutionPack Guide



2020, which is the Collector host where the Load Balancer Connector is
installed.

12. Leave Enable Topology Backend on data collected checked.

13. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

14. Select Use Advanced Settings to configure the polling interval, specify the
number of collecting threads, or enable the collection of logical drives.

15. Click Next.

The window displays reports settings.

16. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

17. Click Install.

18. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

19. Click Discovery Center > Inventory Management.

20. Click HP 3PAR.

These steps describe how to add hosts individually. For information about using
discovery groups to use the same credentials to discover multiple hosts, see 
Adding devices to discovery groups.

21. Click Add new device.

22. Select the server and collector instance where you want to store the
configuration details for this device, and then type the IP address of the array,
supply the login credentials, and specify the appropriate configuration settings.

23. To validate the credentials, click Validate and Add.

24. Click OK.

25. Click Save.

After you finish

Depending on the numbers of Storage elements that is managed, you may need to edit
the unix-services.properties file to increase the Heap Memory to a suitable
level. The file is at: /APG/Collecting/Collector-Manager/your_instance/
conf/unix-services.properties.
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Overview
The SolutionPack for HP StorageWorks P9000 enables you to access performance,
configuration data, and capacity planning data pertaining to the volumes, disks, ports,
dynamically provisioned pools, and parity groups of arrays monitored by the HP
StorageWorks P9000 XP software.

Installing the SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays pre-configured alert details.

9. From the Data collection drop-down list, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new alerting on data collection, Alerting Web-Service
Instance dropdown will have default values. Do not change the values.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

12. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

13. Leave Enable Topology Backend on data collected checked.

14. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

SolutionPack for HP Storageworks XP

198 EMC ViPR SRM 4.2.1  SolutionPack Guide



If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

15. Select Use advanced settings to configure polling and alert settings.

16. Click Next.

The window displays reports settings.

17. Click Install.

18. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

19. Click Discovery Center > Inventory Management.

20. Click HP StorageWorks.

These steps describe how to add hosts individually. For information about using
discovery groups to use the same credentials to discover multiple hosts, see 
Adding devices to discovery groups.

21. Click Add new device.

22. Select the server and collector instance where you want to store the
configuration details for this device.

23. From the HP type drop-down list, select Device Manager Collection, and type
a unique friendly name (such as the host or IP address) for the system.

a. Supply the login credentials, and specify the configuration settings.

b. If you want to discover a single array (than all of the devices that are
managed by HP StorageWorks), check Discover Single Array, and specify
the serial number of the array that you want to discover.

c. If you want to enable the discovery of passive hosts and logical groups from
HP StorageWorks, check Enable Passive Hosts & Logical Groups
Discovery.

Note

EMC recommends that you only enable this option once for arrays that are
managed by a single HP StorageWorks instance that is configured against a
collector. If the arrays discovered on a collector host are managed by
different HP StorageWorks, you should enable this option on one array for
each HP StorageWorks.

d. If you want to collect array performance data from the specified HP
StorageWorks, check Enable Performance Collection.
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Note

EMC recommends that you only enable this option once for arrays that are
managed by a single HP StorageWorks instance that is configured against a
collector. If the arrays discovered on a collector host are managed by
different HP StorageWorks, you should enable this option on one array for
each HP StorageWorks.

24. If you want to configure Performance Collection against a specific array, select
Embedded Performance Collection from the HP type drop-down list, and
type a unique friendly name (such as the host or IP address) for the system.
Supply the login credentials, and specify the configuration settings. For the
Array IP Address or FQDN, type the IP address of the array. For additional
details, see Embedded Performance Collection.

25. To validate the credentials, click Validate and Add.

26. Click OK.

27. Click Save.

Troubleshooting Device Manager collection
Learn how to troubleshoot Device Manager collection issues.

Procedure

1. Use a web browser to log in to HP Command View Advanced Edition Suite
(CVAE):

http://<HP CVAE suite IP or hostname>:<port # (example:
23015)>/DeviceManagerWebService/index.jsp

2. Type the same username and password credentials that you used for ViPR SRM
discovery.

3. Validate that you can view all of the expected HP Storage Systems under the
Resources tab.

Embedded Performance Collection
Performance statistics are provided for the P9500 through the Embedded SMI-S
Provider.

The following components are supported:

l Storage system

l Front end port

l Volume

An SMI-S license is required, but it comes with the array for free. It must be enabled in
Storage Navigator.

In Storage Navigator, a user with the role of Storage Administrator with view only
permission is required.
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Enabling the SMI-S certificate
Learn how to enable the SMI-S certificate on the array.

Procedure

1. Refer to the HP Command View Advanced Edition Administrator Guide for details.

The following chapters are related to enabling the SMI-S certificate:

l Uploading the signed certificate

l Returning the certificate to the default

Restarting the SMI-S provider
Learn how to restart the SMI-S provider.

Procedure

1. Close all of the Device Manager - Storage Navigator sessions on the SVP
(service processor).

2. Start the web browser.

3. In the browser on the Device Manager - Storage Navigator computer, type the
following URL:

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

4. Click Update Certificate Files for SMI-S.

5. In the Login dialog box, type the administrator user ID and password, and click
Login.

6. Click Return to the default certificate, and click OK.

Enabling performance monitoring in Storage Navigator
Learn how to enable performance monitoring in Storage Navigator.

Procedure

1. Open Performance Monitoring and check to see if Monitoring Switch is set
to Enabled.

2. If Monitoring Switch is not set to Enabled, enable it by clicking Edit
Monitoring Switch.
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Configuring embedded performance monitoring
Learn how to configure embedded performance monitoring.

Procedure

1. Browse to Discovery Center > Inventory Management > HP StorageWorks.

2. Discover the CvAE that manages the arrays that you want to monitor.

a. Click Add new device.

b. For HP type, select Device Manager Collection.

c. Type the configuration details for the CvAE, and select the Collect
performance checkbox.

d. To verify the connection, click Test.

3. Discover embedded performance collection.

a. Click Add new device.

b. For HP type, select Embedded Performance Collection.

c. Type the configuration details for the array.

d. Click OK.

4. Click Save.

Troubleshooting the Embedded SMI-S Provider
Use EMC ECOM Explorer (or any CIM/SMI-S browser) to verify that the Embedded
SMI-S Provider is enabled and performance statistics are populated on the array.

Procedure

1. Open ECOM Explorer and choose File > Login.

2. In the Host Name field, type the IP address or FQDN of the array.

3. Type the port number. The default is 5988 or 5989 (SSL) depending on the
configuration.

4. In the Interop Namespace field, type interop.

5. Type the same username and password that you used for ViPR SRM discovery.

6. Once you have successfully logged in, ensure that the following classes are
listed under the root/hitachi/smis tree:

l Classes:
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n HITACHI_BlockStaticsticalDataStorageSystem

n HITACHI_BlockStaticsticalDataFCPort

n HITACHI_BlockStaticsticalDataStorageVolume

Limitations

l The Performance Collection Troubleshooting report does not apply to the
performance metrics pulled from the Embedded Performance Collector.
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CHAPTER 27

SolutionPack for IBM DS

This chapter includes the following topics:

l Overview..........................................................................................................206
l Preparing the IBM DS system for discovery and data collection...................... 206
l Installing the SolutionPack...............................................................................206
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Overview
The SolutionPack for IBM DS enables you to generate real-time and historical reports
and access capacity, performance, and inventory details about the IBM DS systems.

Preparing the IBM DS system for discovery and data
collection

Identify the information that is required to support resource discovery and data
collection before installing the SolutionPack for IBM DS.

ViPR SRM communicates with the IBM CIM/SMI-S provider that queries the storage
array.

Procedure

1. Depending on the IBM DS model, do one of the following:

l IBM DS 3K/4K/5K models: Manually install and configure the IBM CIM/SMI-
S provider on a management server.

l IBM DS 6K/8K models: The CIM/SMI-S provider is built into the Hardware
Management Console (HMC).

Note

Ensure that the CIM agent is enabled, as it was disabled by default in
releases earlier to Release 4, Bundle 62.0.175.0.

2. Identify the CIM username and password that is used to access the array.

3. Record this information for use when you install the SolutionPack.

Installing the SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.
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The window displays pre-configured alert details.

10. From the Alerting on data collection drop-down list, select the Primary
Backend host.

11. Click Next.

The window displays data collection details.

12. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

13. From the Topology Service drop-down list, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend host.

14. From the Web-Service Gateway drop-down list, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

15. To configure polling settings, in the IBM DS specific configuration section, click
Use advanced settings.

16. Click Next.

The window displays reports settings.

17. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

18. Click Install.

19. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

20. Click Discovery Center > Inventory Management.

21. Click IBM DS.

22. Click Add new device.

23. From the IBM DS Model drop-down list, select the respective model. Type the
hostname or IP address of the host, supply the login credentials, and specify the
configuration settings.

24. To validate the credentials, click Validate and Add.

25. Click OK.

26. Click Save.
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CHAPTER 28

SolutionPack for IBM LPAR

This chapter includes the following topics:

l Overview.......................................................................................................... 210
l Configuring HMC for discovery........................................................................ 210
l Configuring LPARs for discovery.......................................................................211
l Verify adapter IDs in NPIV configuration...........................................................212
l Installing the SolutionPack for IBM LPAR......................................................... 212
l Adding and configuring HMC device in Discovery Center................................. 213
l Adding and configuring VIO Server/Client in Discovery Center........................ 213
l SolutionPack Reconfiguration...........................................................................213
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Overview
The SolutionPack for IBM LPAR discovers and collects Inventory details about IBM's
Power-Servers managed by Hardware Management Console (HMC) and displays the
data in easy-to-use reports in ViPR SRM.

With this SolutionPack, you can generate reports to highlight key relationships in the
virtual environment such as:

l Power Systems managed by an HMC

l LPARs and VIOS residing on a Power System

l LPARs to the VIOS that provide the resource sharing capabilities for constituent
LPARs

Capacity reports, such as File System Usage, help you to improve the availability of
business critical applications and services by ensuring that applications have the
storage resources they require to operate effectively.

Note

SolutionPack for IBM LPAR only discovers HMC data. SolutionPack for Physical Host
is required to discover each VIO Server and Clients (LPARS) managed by HMC.

Configuring HMC for discovery
HMC can be discovered through the following authentication mechanism:

l Password based: hscroot user is used for discovery. No other pre-requisites are
required.

l Public key based: Public-Private key pair that is required to be generated for
hscroot user.

Generating a public and private key pair for HMC
For the public key method of discovering HMC hosts, you must generate a valid public
and private key pair. You can choose any key generation tool to generate a valid public
and private key pair.

Before you begin

Before you begin HMC discovery, you must have a public key present on HMC to be
discovered using the private key.

These steps describe the procedure to generate a public and private key pair for HMC
using the ssh-keygen tool.

Procedure

1. A Public-Private key can be generated using the following command:

ssh-keygen -t rsa -f <location_of_the_private_key/name_of_
private_key_file> -N ""
For example: ssh-keygen -t rsa -f /root/.ssh/id_rsa -N ””

2. Ensure that the public and private key pair that is generated has the following
permissions:

l chmod 600 /root/.ssh/id_rsa
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l chmod 644 /root/.ssh/id_rsa.pub
The private key file is id_rsa.

The public key file is id_rsa.pub.

3. To make the key pair functional, append the public key to <user's home
directory>/.ssh/authorized_keys in the target UNIX host using the
command mkauthkeys --add "string" where string is the content of
id_rsa.pub file.

Next, import the private key to the Collector used for discovery.

Note

The public key is to be added to the authorized_keys or authorized_keys2
(depending on the HMC version) file on the target HMC hosts intended for
discovery. The private key is to be imported to the collector VMs where
discovery is triggered.

Importing a private key into the Collector

Procedure

1. The private key should be placed inside APG's HOME directory (where APG is
installed).

For example: UNIX: /opt/APG/.

2. Type chown apg:apg <private_key_file>.

This command changes the owner.

The HMC is now ready for successful data collection.

Configuring LPARs for discovery

Configuring LPARs (VIO Server and Clients) is similar to discovering individual
physical hosts.

ViPR SRM requires non-root user credentials or an SSH public/private key pair (keys
can be created for root/non-root users) to discover VIO Servers and VIO Clients.

When the VIOS Server is installed, the padmin user is automatically created and this
user provides restricted shell access. The ViPR SRM host data collection mechanism
does not work in the restricted shell environment, so you must create a non-root user
and configure the non-root user through Sudo, PowerBroker, or Centrify's dzdo to
elevate the privileges to run certain commands as root. Provide the non-root user
credentials to ViPR SRM while discovering the VIO Server.

Note

ViPR SRM does not require padmin credentials to discover the VIO server.
There are many tools available to elevate the privileges of a non-root user to run
commands as root, but ViPR SRM 4.x and higher supports only Sudo, Powerbroker,
and dzdo.
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Preparing VIO Server and Client hosts for discovery is similar to how a Physical UNIX
host is prepared, follow SolutionPack for Physical host for more details: Unix host/
LPAR (VIO Server/Client) configuration for discovery and data collection

Verify adapter IDs in NPIV configuration

In the NPIV configuration if a VFC Server Adapter is created on the VIOS and a VFC
Client Adapter on the VIOC, ensure correlation between the Physical HBA ports and
the Virtual FC Client Adapter ports.

Procedure

1. On the HMC, go to the Virtual Adapters tab in the partition Properties of the
VIOS/VIOC on which the VFC Server/Client Adapter is created.

2. Verify that a match exists between the Adapter ID of VFC Server Adapter and
the Adapter ID of VFC Client Adapter.

Installing the SolutionPack for IBM LPAR
Before you begin

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select IBM LPAR in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name if you want to change the default instance name from
ibm-lpar.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays data collection details.

9. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

10. If you want to change the default HMC polling interval, click Do you want to
configure advanced settings.

11. Click Next.

The window displays reports settings.

12. In Administration Web-Service Instance, select an existing instance or create
a custom instance.
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13. Click Install.

14. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

Adding and configuring HMC device in Discovery Center

Procedure

1. From the User Interface, click Administration .

2. Click Discovery Center.

3. Under Device Type, click IBM LPAR.

4. Click Add new device.

5. From the Server drop-down list, select the collector VM where the Data
Collection block for the SolutionPack for IBM LPAR is installed.

6. Select the ibm-lpar instance.

7. Type the HMC hostname or IP Address.

8. Select the Authentication Type as:

Option Description

Password based Authenticates with password.

Public key based Authenticates with SSH public private key.

9. Provide the username:

a. Provide the password of the host for password based authentication.

b. Provide the location of the private key for public key based authentication.

10. On successful completion, click Save and then Ok.

Adding and configuring VIO Server/Client in Discovery
Center

The user credentials of VIO Server and VIO Clients should be configured in Discovery
Center > Host configuration.

Steps to add VIO Server or Client is similar to that of adding physical hosts for
discovery. Refer to Add devices using discovery

SolutionPack Reconfiguration
If you want to change the answers that were provided during SolutionPack installation
the first time through, you could change them by reconfiguring the SolutionPack.

Procedure

1. Click Administration .

2. Under Centralized Management.

a. Click SolutionPacks > Infrastructure > IBM LPAR and select the instance
for LPAR.
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3. Change the configuration as desired.

4. Click Reconfigure.
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SolutionPack for IBM SAN Volume Controller/
Storwize

This chapter includes the following topics:

l Overview.......................................................................................................... 216
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Overview
The IBM System Storage SAN Volume Controller (SVC) is a member of the IBM
Storwize family, which provides storage virtualization with a single point of control for
storage resources.

The SolutionPack for IBM SAN Volume Controller/Storwize enables you to generate
real-time and historical reports and access capacity and performance details to gain
insight into the management of the underlying Storwize storage environment.

Preparing for discovery and data collection
Identify the information that is required to support resource discovery and data
collection before installing the SolutionPack for IBM SAN Volume Controller/
Storwize .

Before you begin

l Confirm that the IBM SVC model and version are supported.

l ViPR SRM core modules must be up-to-date on all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l An SMI-S provider must be running on the IBM SVC server on port 5989.

Procedure

1. Record the IBM SVC/Storwize cluster IP address and hostname (for SSH and
CIMOM communication).

2. Record the username and password for the cluster.

Note: All performance, topology, and capacity metrics are supported for users
who are members of the "Administrator" or "SecurityAdmin" user group.
Performance data (such as CPU usage and port traffic statistics of non-
configuration nodes) are not supported for users who are members of the
"Service" or "CopyOperator" or "Monitor" user groups.

Installing the SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.
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8. Click Next.

The window displays pre-configured alert details.

9. From the Alerting on data collection drop-down menu, select existing settings
that have been specified for other components, or select Add a new alerting
data collection.

If you select Add a new alerting on data collection, type information about the
alerting configuration. In Alerting Backend hostname or IP address, specify
the Primary Backend host.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

12. Leave Enable Topology Backend on data collected checked.

13. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

14. Select Use advanced settings to configure polling settings.

15. Click Next.

The window displays reports settings.

16. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

17. Click Install.

18. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

19. Click Discovery Center > Inventory Management.

20. Click IBM SAN Volume Controller/Storwize.

21. Click Add new device.

22. Select the server and collector instance where you want to store the
configuration details for this device, and then enter the hostname or IP address
of the host, supply the login credentials, and specify the appropriate
configuration settings.

23. Leave Enable performance synchronization checked.

Enable performance synchronization allows ViPR SRM to collect and report
performance statistics across all of the nodes. The performance statistics files
are copied from the non-config nodes to the config node, and the copied files
are purged after they are processed. None of the original performance statistics
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on any node is purged. Disabling performance synchronization will allow
collection and reporting only on the config node.

24. To validate the credentials, click Validate and Add.

25. Click OK.

26. Click Save.

Limitations

l Backend Arrays EMC Unity, EMC XtremIO, EMC Isilon, EMC ScaleIO, IBM DS, HP
XP are not supported.

l Internal Storage is not supported in the Raw Capacity Usage and Configured
Usable reports. Service Level and Chargeback are not supported for mdisks
(virtual disks) based on internal storage.

l Replication is not supported.
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SolutionPack for IBM XIV

This chapter includes the following topics:
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Overview
The SolutionPack for IBM XIV enables you to monitor the status and performance of
the IBM XIV disk storage system, and access performance and configuration data
pertaining to the volumes, disks, pools, and ports of IBM XIV systems.

Preparing the IBM XIV system for discovery and data
collection

Identify the information that is required to support resource discovery and data
collection before installing the SolutionPack for IBM XIV.

ViPR SRM communicates with IBM XIV using the CIM agent.

Procedure

1. Ensure that the CIM agent is installed.

Starting with IBM XIV Storage System V10.1.0, the CIM agent is pre-installed
on the administrative module. The embedded CIM agent is automatically
enabled and preconfigured.

2. Identify the access credentials.

3. Record this information for use when you install the SolutionPack.

Installing the SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. From the Alerting on data collection drop-down menu, select existing settings
that have been specified for other components, or select Add a new alerting
data collection.
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If you select Add a new alerting on data collection, type information about the
alerting configuration. In Alerting Backend hostname or IP address, specify
the Primary Backend host.

11. Click Next.

The window displays data collection details.

12. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

13. Leave Enable Topology Backend on data collected checked.

14. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

15. Select Configure advanced settings to configure polling settings.

16. Click Next.

The window displays reports settings.

17. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

18. Click Install.

19. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

20. Click Discovery Center > Inventory Management.

21. Click IBM XIV.

These steps describe how to add hosts individually. For information about using
discovery groups to use the same credentials to discover multiple hosts, see 
Adding devices to discovery groups.

22. Click Add new device.

23. Select the server and collector instance where you want to store the
configuration details for this device, and then enter the hostname or IP address
of the host, supply the login credentials, and specify the appropriate
configuration settings.

24. To validate the credentials, click Validate and Add.

25. Click OK.

26. Click Save.
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Limitations
Discovery of LDAP users requires active GUI session
Due to limitations in the IBM software, discovery using the LDAP users account will
not succeed unless there is an active IBM XIV GUI user session. The session must be
active either for the corresponding LDAP user or for a storage administrator.

Max Storage Volume Response Time metric not collected
The SolutionPack does not collect the Max Storage Volume Response Time (ms)
metric that is needed for the Explore > Hosts > [host] > Device Summary > [host]
report.

No support for Used for File, LUN alias, and Replica 2 and Replica 3 details
‘Used for File’ metrics are not supported. Therefore, the respective columns in the
following reports are empty.

l Dashboards > Storage > Enterprise Capacity Dashboard > Usable Capacity by
Pool

l Operations > Chargeback > Chargeback by Group

l Explore > Storage Capacity > Storage Pools

‘LUN Alias’ column is empty in the following report:

l Explore > Storage > LUNs

Remote Replication data is not exposed through the SMI provider, therefore, Replica 2
and Replica 3 columns details are empty in the following report:

l Explore > Storage > Replication
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SolutionPack for Microsoft Hyper-V

This chapter includes the following topics:
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l Using a test script to query WMI objects......................................................... 225
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Overview
The SolutionPack for Microsoft Hyper-V generates real-time and historical reports so
you understand Hyper-V performance through global and detailed status of Hyper-V
hosts and underlying virtual machines.

Configuring credentials for SolutionPack for Microsoft
Hyper-V

l Hyper-V Collector Manager must have the right to query WMI objects from
Hyper-V hosts

l PowerShell must allow the execution of unassigned PowerShell scripts

Requirements for data collection

ITo collect data from Microsoft Hyper-V hosts, the environment requires to meet the
following requirements:

l The Collect SolutionPack Block must be installed on a supported server. Refer to
the ViPR SRM Support Matrix for more information.

l The Collect SolutionPack Block must be able to query WMI objects in remote
Microsoft Hyper-V hosts. For required privileges, refer to ViPR SRM and
SolutionPack privileges.

l The Collect SolutionPack Block must allow the execution of unsigned PowerShell
scripts. To provide this capability, run the following command as an administrative
user: PowerShell -C Set-ExecutionPolicy Unrestricted.

Installing the SolutionPack

Before you begin

l Core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays data collection details.
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9. From the Alerts drop-down list, select existing settings that have been
specified for other components, or select Add a new alerting on data
collection.

10. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

11. Leave Enable Topology Backend on data collected checked.

12. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

13. Select Configure advanced settings to configure polling settings.

14. Click Next.

The window displays reports settings.

15. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

16. Click Install.

17. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

18. Click Discovery Center > Inventory Management.

19. Click Microsoft Hyper-V.

20. Click Add new device.

21. Select the server and collector instance where you want to store the
configuration details for this device. Type the hostname or IP address of the
host, supply the login credentials, and specify the configuration settings.

Clicking the Test button results in a warning message that can be ignored.

22. Click OK.

23. Click Save.

Using a test script to query WMI objects

The Test feature that is located in the Discovery Center under the Centralized
Management UI supports only required functionality for the test button such as host
reachability and credentials verification.

SolutionPack for Microsoft Hyper-V provides a script that can be used to check if it is
possible to query all required WMI objects using the provided user. The script is in the
folder <APG_FOLDER>/Collecting/XML-Collector/
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<SolutionPack_instance_name>/conf/. Run the script from the Collect
SolutionPack Block server. Use the following syntax to run the script:

TestWMI.ps1 -Computer <ip-or-hostname> 
          -Username <domain-or-machine\username>
          -Password <password> [-NoPing]

-Computer
Remote Hyper-V host IP address or hostname

-Username
Username that is used to perform remote WMI queries, in the format DOMAIN
\username for domain users or MACHINE\username for local users

-Password
Password of the user which is specified with the -Username parameter

-NoPing
(optional) If the remote Hyper-V host is blocking ping requests, you must use this
parameter to skip connectivity tests

Limitations

l The Storage Connectivity tab does not show data for Hyper-V VMs.

l Topology and Chargeback are not supported for ScaleIO and Hyper-V.

l Pass through disk capacity not collected/displayed for Hyper-V guests.

l NAS shares on Hyper-V guests/VMs are not supported with Hyper-V
SolutionPack.

l VM Chargeback reports are only seen for VMs using N_Port ID
Virtualization(NPIV).

l Disk data is not collected when VMs are using pass-through disks.

SolutionPack for Microsoft Hyper-V

226 EMC ViPR SRM 4.2.1  SolutionPack Guide



CHAPTER 32
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Overview
This SolutionPack includes reports for unified monitoring of Microsoft SQL Database
using SQL queries against targeted servers. The reports give key information on
status, performance and availability of databases, datafile capacities, and performance
metrics such as Index, IO, Wait, and Memory pressure.

SQL commands
This SolutionPack uses these commands:

l SELECT

l CONNECT

l INSERT

l CREATE TABLE

n This command creates temporary tables that are used when gathering the
capacity-related information of databases. The temporary tables are created in
the tempdb table. These tables are later dropped.

l EXEC

n Executes a stored procedure that lists disks and their available free space.

l DROP

n Removes temporary tables created earlier in the tempdb table.

User privilege requirements for SolutionPack for Microsoft
SQL

The Microsoft SQL Server can be discovered with SQL Authentication or Windows
Authentication.

Microsoft SQL authentication
SQL authentication works for users having either SYSADMIN privileges or an
unprivileged account.

Note

An unprivileged account can be created and used to discover the Microsoft SQL
Server. For more information, refer to Configuring the SolutionPack with an
unprivileged account on page 229.

Windows authentication
A Windows user account must be imported into the Microsoft SQL Server with the
following settings:

l Server role of Public

l Securable grants for Connect SQL, View any definitions, and View server state

Note

A non-admin account can be created and used to discover the Microsoft SQL Server.
For more information, refer to Granting permission to a non-admin user .
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Configuring the SolutionPack with an unprivileged account
Create a watch4net account for Microsoft SQL SolutionPack collector with specific
grants.

The collector must connect to each instance of MS-SQL Server and perform SQL
queries. You can use either an administrator equivalent system account or create a
dedicated system account for the collector. If you want a dedicated system account,
please ask the DBA administrator to create a watch4net account with specific grants
for the collector.

To create a watch4net account:

Procedure

1. The default database must be used as the [master] database in this procedure.

USE [master]
GO

CREATE LOGIN [watch4net]
WITH PASSWORD=N'<securepassword> ',
DEFAULT_DATABASE=[master],
DEFAULT_LANGUAGE=[us_english],
CHECK_EXPIRATION=OFF,
CHECK_POLICY=OFF
GO

EXECUTE master.sys.sp_MSforeachdb
'USE [?];
CREATE USER watch4net FOR LOGIN watch4net
GO

GRANT VIEW SERVER STATE TO watch4net
GO

GRANT VIEW ANY DEFINITION TO watch4net
GO
;

Results

Dedicated account is configured.

Granting permission to a non-admin user
If you want a dedicated system account, have your DBA administrator create a
DOMAIN\watch4net account with specific grants for the collector.

Procedure

1. Follow this example to create a DOMAIN\watch4net account. The default
database must be used as the [master] database in this procedure.

USE [master];
GO
CREATE LOGIN [DOMAIN\watch4net]
FROM WINDOWS
WITH DEFAULT_DATABASE=[master];
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GO
CREATE USER [watch4net] FOR LOGIN [DOMAIN\watch4net];
GO
GRANT VIEW SERVER STATE TO [DOMAIN\watch4net]
GO
GRANT VIEW ANY DEFINITION TO [DOMAIN\watch4net]
GO

Results

Your dedicated account is configured.

Installing the SolutionPack for Microsoft SQL

Before you begin

l Ensure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. The installation guide for the product provides more information.

l Ensure that you create a watch4net user earlier to installing the SolutionPack.
Ensure that correct credentials are added to Microsoft SQL Server Inventory
Management during the installation process.

Procedure

1. Click Administration > Centralized Management.

2. Click SOLUTIONPACK CENTER.

3. Select the Microsoft SQL Server in the Browse and Install SolutionPacks
window.

4. Read the summary information and click Install.

5. Type the instance name.

6. Assign a server for each of the components.

7. Click Next.

The window displays pre-configured alerts details.

8. From the Pre-Configured Alerts drop-down list, select existing settings that
have been specified for other components, or select Add a new alerting on
data collection.

9. Click Next.

The window displays the data collection details.

10. Make a selection in the Data Collection drop-down list.

Select existing settings that have been specified for other components or select
Add a new data collection.

11. If you select Add a new Data collection, type information about the data
collection. In the Hostname or IP address to send data field, use localhost
on default port 2020.

This is the Collector host where the Load Balancer Connector is installed.

12. Select the Frontend Web Service option.

Select existing settings that have been specified or choose Add a new
Frontend Web Service.
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13. If you select Configure Collector advanced settings, you have the option to
select different polling periods.

The default polling period is 15 minutes. To set the polling period that is based
on the number of SQL Server instances that are being polled by this collector
manager instance, consult with the database administrator. For example, you
have the option to select 5 minutes, 15 minutes, 30 minutes, or 1 hour.

14. Click Next.

15. Provide information about the web-service gateway if it is different from pre-
populated information.

16. In the Administration Web-Service instance, select an existing instance or
create a custom instance.

17. Click Install.

18. Click OK.

Monitor the installation logs to ensure that the installation completes
successfully.

19. Click Discovery Center > Inventory Management.

20. Click Microsoft SQL Server.

21. Click Add new device.

Note

Threshold based alerts are disabled by default. To manually enable threshold
based alerts, go to Administration > Modules > Alerting > Alert Definitions  >
MS-SQL Alert definition.

22. Select the server and collector instance where you want to store the
configuration details for this device.

23. Set these values:

l Type the Hostname or IP address of the SQL server.

l Specify the Database Port and Database Instance name. For example, type
Default for the SQL Server Instance name or type the named instance.

l Specify the mode of authentication that is used for the SQL Server: SQL
Authentication or Windows Authentication

l If using SQL Server authentication, type the username and password for the
SQL Server.

l If using Windows authentication, provide the Windows domain, username,
and password. Use either the local or domain username.

24. To check connectivity with the SQL Server, click Validate and Add.

25. Click OK.

26. Click Save.

Enabling SSL enabled MS-SQL instance discovery

Procedure

1. On Linux:
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a. Run:

export _JAVA_OPTIONS=-Djsse.enableCBCProtection=false -Linux

b. Restart all services:

./manage-modules.sh service restart all

2. On Windows:

a. Locate the following registry entry:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software
Foundation\Procrun
2.0\APGCollectorManagerMicrosoftsqlserver\Parameters
\Java

b. Open the Options key and append with:

-Djsse.enableCBCProtection=false

c. Locate the following registry entry:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software
Foundation\Procrun 2.0\APGScriptEngineDefault\Parameters
\Java

d. Open the Options key and append with:

-Djsse.enableCBCProtection=false

e. Restart the MS-SQL Collector service:

manage-modules.cmd service restart collector-manager
microsoft-sqlserver

f. Restart the Script engine service:

manage-modules.cmd service restart script-engine Default

Limitations

l The Related Host report is not populated for hosts that are discovered via the
EMC Host Interface agent.

l If Database is residing on VM VMFS/NFS data store, end to end topology is not
supported.

l Case Sensitive collation that is used on the database instance is not supported.
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Overview
The SolutionPack for NetApp Filer enables users to get a deeper understanding of the
performance and storage capacity parameters of NetApp Filer devices through a
unified monitoring of NetApp Filer devices distributed in the network.

The SolutionPack generates reports regarding performance and capacity metrics.

Configuring access credentials

ViPR SRM communicates with NetApp Filer arrays using the NetApp CLI over SSH.

The following SSH connections are required:

l SSH connection to the 7-Mode NetApp devices with the following roles: login-ssh,
cli-stats*, cli-snap*, cli-aggr*, cli-vol*, cli-disk*, cli-nfs*,cli-cifs*, cli-df,cli-
sysconfig, cli-ifconfig, cli-qtree, cli-quota,cli-storage, cli-maxfiles, cli-echo, cli-lun,
cli-fcp, cli-vfiler, cli-exportfs, cli-ifstat

l SSH connection to the C-Mode NetApp devices with the following roles: access
level read-only for the commands volume, df, lun, storage, network, vserver,
cluster, sleep, snapmirror, and access level 'all' for the commands set, system,
statistics

Verify that you are polling the real filer (not a vFiler).

Note

Ensure that the host names are consistent.

Preparing NetApp Filer for discovery and data collection
Identify the information that is required to support resource discovery and data
collection before installing the SolutionPack for NetApp Filer.

ViPR SRM communicates with NetApp Filer arrays using the NetApp CLI over SSH.

Procedure

1. Identify the IP, username, password, SSH Port no (default is 22), and NetApp
Filer Mode (7-Mode or C-Mode).

2. Identify the Cluster management IP for C-Mode Filer discovery.

3. Record this information for when you add the Netapp devices to Discovery
Center.

Configuring NetApp arrays for alert consolidation
Configure the forwarding of health alert traps (SNMP v1) from NetApp arrays to ViPR
SRM.

Note

SNMP traps are sent to port 162.
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Procedure

1. Log in to the NetApp array.

2. To enable SNMP trap forwarding, type the following command:

options snmp.enable
3. To check which hosts have registered for SNMP traps, type the following

command:

snmp traphost
4. To receive SNMP traps, add the ViPR SRM primary backend by entering the

following command:

snmp traphost add <hostname>
5. To verify that the host was added, type the following command:

snmp traphost

Installing the SolutionPack

Before you begin

l EMC ViPR SRM core modules must be up-to-date in all servers because not all
module dependencies are validated during the SolutionPack installation or update
process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.
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12. Leave Enable Topology Backend on data collected checked.

13. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

14. Select Configure advanced settings to configure polling settings.

15. Click Next.

The window displays reports settings.

16. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

17. Click Install.

18. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

19. Click Discovery Center > Inventory Management.

20. Click NetApp.

21. Click Add new device.

22. Select the server and collector instance where you want to store the
configuration details for this device, and then enter the hostname or IP address
of the host, supply the login credentials, and specify the appropriate
configuration settings.

23. To validate the credentials, click Validate and Add.

24. Click OK.

25. Click Save.

Supported use cases

Table 9 Supported use cases

Use case Support (7 mode) Support (C mode)

Discovery Yes Yes

Maps, Path, and Connectivity
details

Yes
7 mode to external storage
array (VNX and VNXe)

7 mode to VPLEX

7 mode to IBM SVC

Yes
C-mode topology

Not supported:

External storage array

Global Capacity reports Yes Yes

Explore reports Yes Yes

Chargeback Yes Yes
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Table 9 Supported use cases  (continued)

Use case Support (7 mode) Support (C mode)

Performance Yes Yes

Alerting Yes Yes

Compliance No No

Detailed reports for File and
Block at SP level

Yes Yes

Qtree and Quota Reports Yes Yes

CIFS shares and NFS shares
report

Yes Yes

Limitations
Limitations in global reports
Used capacity is the same as the total capacity for Ontap 7.x versions of the following
reports:

l Explore > Storage Capacity > Service Level Capacity

l Explore > Storage Capacity > Array by Service Level

In Dashboards > Storage > Enterprise Capacity Dashboard > Usable Capacity by
Type > Used for Block, the OnTap 7.x CLI does not provide LUN used capacity
therefore the total capacity is used for computation.

The following global reports/metrics are not applicable:

l In Explore > Storage > NAS File Systems, Snapshot Total, Snapshot Used, and
Snapshot Utilization are not applicable

l In Explore > Storage Capacity > Storage Pools, Overhead Capacity is not
applicable in the File Systems/Flex Vols report and Pool Enabled and Pool
Overhead are not applicable in the Subscriptions report

l Explore > Storage > RAID/Parity Group

l Explore > Storage Capacity > NAS Pools

In Dashboards > Storage > Enterprise Capacity Dashboard > Used Capacity by
Type and Explore > Storage > More Reports > Enterprise Capacity, the "Used for
HDFS" and "Used for Object" metrics are blank for NetApp.

In Explore > Storage > NAS File Systems, for filers running OnTap 8.2 or higher, the
total capacity of a thin file system is same as its used capacity.

Limitations in the inventory reports

l SVM is not reported if there are no volumes that include the root volume that is
associated with that SVM.

l Shares that are associated with Vfiler are not reported on the Shares tab. This
data is reported on the Vfiler tab.

l Volume capacity is shown for the shares, but the share is created on a Qtree with
different Quota specifications.

l Shares that are created on root ($, etc, /) are not supported.
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l Shares that are created on the same path/volume are displayed on the same row.
As a result, the number of shares that are reported might be less than the actual
number of shares.

l CIFS shares created on Snapshots are not supported.

l Interfaces that are configured without IP are not reported.

l The Capacity of broken disks is not reported.

l Volume level capacities are displayed for all CIFS and NFS shares.

l Maximum length of variable ID in SRM is 255 characters. As a result, information
on capacity will be missing, a truncated volume name will be displayed. To avoid
data inconsistency, length of the volume name required to be in the range of
150-170 characters which will allow remaining portion of variable ID to be used for
mandatory system data.
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Overview
The SolutionPack for Oracle Database monitors the status and performance of an
Oracle database.

This SolutionPack specializes in Oracle monitoring and provides a proactive set of
reports that get right to the heart of any ongoing Oracle capacity and performance
issue. The SolutionPack can be used both by database and storage administrators and
comes with a complete monitoring package for databases that includes reports for
availability, database and table sizes, cache ratios, and other key metrics. This
SolutionPack also has complementary features that allow rich KPIs like the End to End
view of the Oracle Database Topology by mixing Oracle database queries and server
monitoring. To use this feature, EMC recommends installing the SolutionPack for
Physical Hosts or the SolutionPack for VMware vCenter (depending on the Oracle
setup) along with the corresponding SolutionPack for the array where Oracle is
deployed.

Installing the SolutionPack

Before you begin

l The core modules must be up-to-date on all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l The appropriate JDBC driver jar file must be in the …/APG/Databases/JDBC-
Drivers/Default/lib folder. Refer to the support matrix for additional details.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each of the components. For Oracle ASM deployments,
specify the server where the system will install ASM Data Collection. For
additional details about the ASM script and configuring ASM, refer to the
SolutionPack for Oracle Database section of the support matrix.

8. Click Next.

The window displays pre-configured alerts details.

9. From the Pre-Configured Alerts drop-down list, select existing settings that
have been specified for other components, or select Add a new alerting on
data collection.

10. Click Next.

The window displays data collection details.

11. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
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2020, which is the Collector host where the Load Balancer Connector is
installed.

12. Leave Activate the FailOver-Filter checked.

13. From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add a new Web-Service
Gateway.

If you select Add a new Web-Service Gateway, type information about the
web-service gateway.

14. The Topology Service automatically includes the standard settings. You should
only add a new Topology Service if the Topology Mapping service is installed in
a non-default location.

15. If you select Configure collector advance settings, you have the option of
selecting from polling periods of 5 minutes, 15 minutes, 30 minutes, and 1 hour.
The default polling period is set to 15 minutes. To set the polling period based on
the number of Oracle Database instances that are being polled by this particular
instance of the collector manager, consult with the database administrator.

16. Click Next.

The window displays reports settings.

17. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

18. Click Next.

The windows displays ASM Data Collection settings.

19. Specify the default collection level for ASM Data Collection. In this case, the
default option is Standard.

20. Click Install.

21. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

22. Click Discovery Center > Inventory Management.

23. Click Add new device.

Note

Threshold based alerts are disabled by default. To manually enable threshold
based alerts, go to Administration > Modules > Alerting > Alert Definitions >

Oracle Alert Definitions.

24. Click Oracle Database.

25. Select the server and collector instance where you want to store the
configuration details for this device, and then type the hostname or IP address
of the host, supply the login credentials, and specify the configuration settings.

EMC recommends adding a watch4net user beforehand so that the correct
credentials are added to Oracle Database Inventory Management. For details
about the required grants, refer to Configuring the SolutionPack with an
unprivileged account.

For each Oracle Database instance being polled, it is useful to have the
following information on hand before it is added to the Collection devices list:
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l Oracle service name

l Oracle instance name (in case of a RAC setup)

l Username (watch4net user)

l Password

l Port

l Server details (Windows, Linux, or Solaris)

l Server details (Physical or VM)

l Oracle setup (ASM or non ASM)

l Oracle setup (RAC or non RAC)

l Oracle version

l RAC version (if installed)

26. To validate the credentials, click Validate and Add.

27. Click OK.

28. Click Save.

Topology for the SolutionPack for Oracle Database
The SolutionPack for Oracle Database includes features that allow rich KPIs (like the
end-to-end view of the Oracle Database topology) by mixing Oracle database queries
and server monitoring.

The SolutionPack is used to poll the vast majority of metrics through SQL queries
against individual databases.

To support the end-to-end use-case from Oracle ASM to the backend array LUN, it is
necessary to connect on the OS layer (via ssh or wmi).

Configuring the SolutionPack with an unprivileged account

The collector must connect to each instance of Oracle databases and perform SQL
queries. You can use either an administrator equivalent system account or create a
dedicated system account for the collector. If you want to create a dedicated system
account, ask the DBA administrator to run the following query against every
instances/RAC cluster. This creates a watch4net account with specific grants for
the collector.

Procedure

1. Create the watch4net user:

create user watch4net identified by <securepassword> default 
tablespace users temporary tablespace temp;

2. Grant the necessary privileges to the watch4net user by running the following
grants:

grant create session to watch4net;
grant select on dba_data_files to watch4net;
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grant select on dba_free_space to watch4net;
grant select on dba_libraries to watch4net;
grant select on dba_objects to watch4net;
grant select on dba_segments to watch4net;
grant select on dba_tablespaces to watch4net;
grant select on gv_$sysmetric to watch4net;
grant select on v_$asm_disk to watch4net;
grant select on v_$asm_diskgroup to watch4net;
grant select on v_$asm_diskgroup_stat to watch4net;
grant select on v_$asm_disk_stat to watch4net;
grant select on v_$database to watch4net;
grant select on v_$dispatcher to watch4net;
grant select on v_$filestat to watch4net;
grant select on v_$instance to watch4net;
grant select on V_$instance_recovery to watch4net;
grant select on v_$latch to watch4net;
grant select on v_$librarycache to watch4net;
grant select on V_$LOCK to watch4net;
grant select on v_$locked_object to watch4net;
grant select on v_$lock_type to watch4net;
grant select on v_$log to watch4net;
grant select on v_$logfile to watch4net;
grant select on v_$parameter to watch4net;
grant select on V_$PGASTAT to watch4net;
grant select on v_$rollstat to watch4net;
grant select on v_$rowcache to watch4net;
grant select on v_$session to watch4net;
grant select on v_$sesstat to watch4net;
grant select on v_$sess_io to watch4net;
grant select on v_$sgainfo to watch4net;
grant select on v_$statname to watch4net;
grant select on v_$sysmetric to watch4net;
grant select on V_$SYSSTAT to watch4net;
grant select on V_$SYSTEM_event to watch4net;
grant select on v_$system_wait_class to watch4net;
grant select on V_$version to watch4net;

Results

Your dedicated account is configured.

Discovery Center requirements
Under Centralized Management > Discovery Center > Inventory Management,
ensure that there is an entry for the same Oracle server under both Oracle Database
and Host Configuration.

Once the Oracle Instance is correctly added in the Inventory Management
configuration, validate the connectivity by clicking Test. A successful test ensures
that the correct host along with the oracle configuration has been added. The test
also checks for the correct version of the jdbc driver and that it is in the right folder.
The test results can be expanded to show all of the grants that are provided to the
user 'watch4net'. If there are any collection errors, these grants can be validated with
the ones in this document.

The server must be under Host Configuration so the ASM Script (oracle-asm-
disk.pl for Linux and ASMDiskDetection.ps1 for Windows) can be pushed to
the server to retrieve the internal Disk/Array WWN information.
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Configuring sudo rights for ASM scripts
On a Linux server, if a non-root user is used in the Discovery Center host
configuration, you must create an entry in the /etc/sudoers file so that the
oracle-asm-disk.pl Oracle ASM script can retrieve all the required information.

Procedure

1. Run the following script:

ssh -v user@oracle_server 'cd /home/user/
emcsrm ; /usr/bin/perl ./oracle-asm-disk.pl debug=1
The end of the script output contains the recommended settings for configuring
the /etc/sudoers file.

2. Optionally, you can edit the /etc/sudoers file directly with the following
lines:

'Defaults:user !requiretty'
'Defaults:user env_keep += "ORACLE_SID"'
'user ALL=(root) NOPASSWD: /usr/local/bin/inq -wwn -dev  
*, /bin/raw -qa, /lib/udev/scsi_id --page\\=0x83 *'
'user ALL=(oracle) NOPASSWD: /u01/app/oracle/product/12.1.0/
grid/bin/asmcmd lsdsk'

3. Replace /u01/app/oracle/product/12.1.0/grid/bin with the
ORACLE_HOME to reflect the Oracle install.

Note

If the Linux server does not support the scsi_id command, install the inq
application. On Windows, the ASM script will only work for a user with Admin
rights.

Limitations

l The Related Host report is not populated for hosts that are discovered via the
EMC Host Interface agent.

l On a Windows server, the ASMDiskDetection.ps1 script must be run using an
account that belongs to the 'Administrators' group. With non-admin discovery on
Windows, reports such as ASM Datafile Distribution and ASM Disks (under
Database Summary) will not work.

l Discovery Center Test button fails with the following error: Cannot locate
driver 'oracle.jdbc.driver.OracleDriver' !
1. After installing the SolutionPack, put the Oracle driver (ojdbc jar) in the

following directory: /opt/APG/Databases/JDBC-Drivers/Default/lib
2. Restart the script Engine.

l If Database is residing on VM VMFS/NFS data store, end to end topology is not
supported.

SolutionPack for Oracle Database

244 EMC ViPR SRM 4.2.1  SolutionPack Guide



l If profile parameter like IDLE_TIME, SESSIONS_PER_USER and so on for the
Oracle Database SolutionPack user is set, recommend that the user should be
used by SRM only. Ideally IDLE_TIME should be set to 'UNLIMITED'.

Troubleshooting

Test button failures between the collector and the Oracle database can occur in the
following conditions:

l Host not reachable

l Port not accessible

l Policy setting

Procedure

1. Ping the host and verify that it is reachable.

2. Telnet to the host and verify that it is accessible.

3. Check to see if any policy set is preventing connecting through the ports.

After you finish

If the output is bash-3.2# ./asmcmd Connected to an idle instance.
ASMCMD>, validate and update the following environment variables: ORACLE_HOME
and ORACLE_SID.

If the test button fails in Discovery Center and the output is related to grants, connect
to the sqlplus sys user and run the following command: select * from
dba_tab_privs where grantee='WATCH4NET'. Validate that the grants are
present.
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Overview
The SolutionPack for Oracle MySQL Database provides management capabilities that
are typically found in database-centric tools along with management support from
other technologies. You can measure client activity by reporting on data from the
database tier alongside the business logic and presentation tiers.

Preparing MySQL database for discovery and data
collection

Before installation, prepare the MySQL Databases to be discovered.

The following procedure describes how to create an unprivileged account to be use by
the SolutionPack.

Procedure

1. Identify the Collector IP or FQDN.

2. Connect to one of the MySQL databases and get and generate a non-plain text
password using the command:

SELECT PASSWORD('mypass');

3. Take the result string (for example:
*6C8989366EAF75BB670AD8EA7A7FC1176A95CEF4) and grant the privileges
on each of the databases as shown in the example:

CREATE USER 'watch4net'@'%'IDENTIFIED BY PASSWORD 
*6C8989366EAF75BB670AD8EA7A7FC1176A95CEF4;
GRANT ALL ON *.* TO 'watch4net'@'%';

Installing the SolutionPack

Before you begin

l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates that are listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support
Request (SR) form, which you can find on the EMC Online Support website at 
http://support.emc.com.

l Ensure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide
provides for more information.

Procedure

1. Log in to Centralized Management.

2. Select SOLUTIONPACK CENTER.

3. Select the Oracle MySQL Database in the Browse and Install SolutionPacks
screen.
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4. Read the summary information and click Install.

5. Edit the default instance name, oracle-mysql-database, and click Next.

6. From the Data collection drop-down list, select existing settings that have
been specified for other components, or select Add a new data collection.

7. If you select Configure Collector advanced settings, you have the option to
select different polling periods.

Click Next.

8. From the Web-Service Gateway drop-down, select existing settings that have
been specified for other components, or select Add a new Web-Service
Gateway.

9. Select Administration Web-Service Instance as the default and click Install.

10. When a check mark appears next to the Collector and the Report, click OK.

Monitor the installation logs to ensure that the installation completes
successfully.

11. Click Discovery Center > Inventory Management.

12. Click Oracle MySQL Database.

13. Click Add new device.

14. Select the server and collector instance where you want to store the
configuration details for this device.

15. Set the following values:

l Type the Hostname or IP address of the MySQL server.

l Specify the Database Port.

l Provide the username and password.

16. To validate the credentials, click Validate and Add.

17. Click OK.

18. Click Save.

Limitation
l Oracle MySQL Database SolutionPack does not provide or support alerts.
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CHAPTER 36

SolutionPack for Physical Hosts

This chapter includes the following topics:
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Overview
The SolutionPack for Physical Hosts discovers physical hosts, individual LPARS (AIX),
and allows you to monitor and generate real-time and historical reports on the
performance of physical hosts. The SolutionPack can report information about host
performance, capacity and utilization, connectivity, path details, and inventory.

High-level prerequisites for host discovery:

l UNIX:

n SSH and its subsystem SFTP enabled

n Perl v5.6.1 or later

n sudo, powerbroker, or centrify dzdo configured according to the environment

n Latest vendor specific SNIA libraries for all the HBA's installed on the hosts

l Windows:

n Powershell v2.0 or later

n WSMAN listeners over http or https

You can discover physical hosts with the following mechanisms:

l Agentless (for both Windows and Unix): To discover hosts via agentless discovery,
configure the hosts to support discovery and data collection as described in 
Preparing your hosts for discovery and data collection.

l Host Agent for Unix/Linux: If you do not want to configure the hosts for agentless
discovery, you can use the Host Agent for Unix/Linux. This mode requires the
following steps:

n Download the release specific srmhostagent.sh file from https://
support.emc.com and run it as the 'root' user on the target host that you want
to discover. For additional details, see Discovery via Host Agent for Unix/Linux.

n Create a non-privileged/non-root user with read-only access to the /tmp
directory on the target host to be discovered. Use this user to discover host in
ViPR SRM. To install the SolutionPack and add devices to ViPR SRM, see 
Installing the SolutionPack and configuring devices for discovery.

l EHI Host Agent for Windows (refer to the SolutionPack for EMC Host Interface
chapter)

Regardless of which discovery mechanism you choose, the authentication mechanism
from ViPR SRM to the host remains the same. The following table lists the
authentication methods that are supported by the SolutionPack for Physical Hosts
when you are adding a device to ViPR SRM for discovery:

OS Type Protocol Password
based

Key based Certificate based

All Unix/Linux SSH Yes Yes No

Windows http/https Yes No Yes

Note

For an overview of physical host discovery mechanisms that includes passive
discovery, see Physical host discovery.

SolutionPack for Physical Hosts

252 EMC ViPR SRM 4.2.1  SolutionPack Guide

HTTPS://SUPPORT.EMC.COM/
HTTPS://SUPPORT.EMC.COM/


Preparing the hosts for discovery and data collection
Configure the hosts to support resource discovery and data collection.

Refer to the following sections for additional details about configuring the hosts:

l Windows host configuration for discovery and data collection on page 253

l Unix host/LPAR (VIO Server/Client) configuration for discovery and data
collection on page 262

l Configuring ESX hosts to collect PowerPath metrics

Guidelines for SNIA libraries and HBA drivers
To discover SNIA-qualified HBA-related information for all the host platforms you
should ensure the right versions of SNIA library, drivers and firmware are in place.

l Ensure that you have EMC-supported host bus adapter (HBA) drivers and
firmware. EMC ViPR SRM Support Matrix provides information for the supported
SNIA compliant version of the HBA driver.

l HBA Model and the compatible driver versions that are qualified by EMC can also
be verified on https://support.emc.com > Product and Support Tools > Elab
Interoperability Navigator. The vendor websites also list the EMC compatible
drivers.

l The vendor-specific SNIA libraries must be installed on the target host.

l The HBA model number and part number should be verified before updating the
hosts with SNIA libraries for HBA.

l You can install the SNIA library as part of HBA driver installation package or install
the latest version of HBAnywhere or OneCommand Manager (for Emulex
installations) or SAN Surfer (for Qlogic installation).
To discover an HP-UX host with a multi-port Fibre Channel card, the package
CommonIO bundle 0812(December 2008) or later should be present on the host to
obtain the updated FC-SNIA file set. INQ is dependent on binaries from
CommonIO bundle.

Note

All Unix/Linux flavored hosts to have vendor specific SNIA libraries that are
installed to get all HBA related information except Cisco UCS hosts with VIC HBA
cards and Linux operating system. On Linux flavored hosts, partial information
would be populated when SNIA is not installed.

Windows host configuration for discovery and data collection

Required software

l Install Powershell 2.0 or later on Windows hosts. Powershell can be downloaded
from http://support.microsoft.com/kb/968929/en-us. User should have
permissions to run powershell scripts. To provide permissions to run scripts, run
the following command on the powershell terminal: Set-ExecutionPolicy
RemoteSigned

Required user permissions
The following user credentials are required for successful host discovery:
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l Local administrator

l Domain user who is part of administrator's group

l Non-admin user

A non-admin user is identified by ViPR SRM as a service account user or domain user
who is neither a part of the Administrator group or domain Administrators group.
For additional details, see Types of discovery allowed by different privilege levels.

Host configuration
To prepare Windows hosts for ViPR SRM discovery of objects using WinRM services,
hosts must be pre-configured with the WSMAN settings.

Configure one of the following listeners:

l WinRM HTTP listener:

n Negotiate authentication mode set to true

n Firewall exception added for port 5985

l WinRM HTTPS listener:

n Negotiate authentication mode set to true

n Certificate that is generated and placed in the personal store. See Generating
a .pfx certificate.

n Firewall exception added for port 5986.

These changes can be completed via two methods:

l Host Configuration utility (run on each host).
Using the Host Configuration Utility

l Group policy configuration (run on the domain servers).
Generating a .pfx certificate

Configuring Centrify on Windows host
Refer to the Centrify Suite Evaluation Guide for Windows in the Centrify documentation
or contact the server administrator.

Types of discovery allowed by different privilege levels

The term "non-admin user" refers to a service account user or domain user who is not
part of the Administrators group on a Windows host.

The following table applies to Windows 2008 and 2012:

Table 10 Allowed discovery types

Data in
reports

Non-
Admin
user

Local Admin user

Discovery of
host names, IP

Supported Supported

MPIO/
Powerpath

Not
supported

Supported

Device Details/
Attributes

Supported Supported

HBA Details Supported Supported
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Table 10 Allowed discovery types (continued)

Data in
reports

Non-
Admin
user

Local Admin user

End to end
reports - Maps

Supported Supported

Path Details &
Connectivity

Supported Supported

File Systems to
Disks

Not
supported

Supported

System
Performance

Supported Supported

Disks
Performance

Supported Supported

FileSystem
Usage

Supported Supported

VolumeGroups Supported Supported

Internal & SAN
Disks

Not
supported

Supported

Chargeback by
Physical host

Supported Supported

Network
Interface

Not
supported

Supported

Chargeback reports for non-admin users are supported on VMAX, VNX, VNXe and
XtremIO array devices. Refer to the release notes for any limitations on third-party
array LUNs masked to Windows hosts.

Customizing a WinRM URL prefix

Before you begin

EMC supports use of a custom WinRM URL prefix. You can change the URL prefix
from the default "wsman" to any other by using following command on the target
host.

Procedure

1. Type the following command:

For Use

Non-SSL communication winrm set winrm/config/listener?
Address=*+Transport=HTTP @
{URLPrefix="EMC"}

SSL-based communication winrm set winrm/config/listener?
Address=*+Transport=HTTPS
@{URLPrefix="EMC"}
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Prerequisites for discovering a Windows host using non-admin user credentials

To prepare Windows hosts for discovery, you can configure privileges in these ways:

l Provide the option -user nonadmin as an input to the Host Configuration utility

l Manually

The following checklist summarizes the configuration changes required on Windows
hosts:

1. WinRM configuration settings:

a. Adding a non-admin user to a group on page 256

b. Retrieving the SID of a non-admin user on page 256

c. Adding a non-admin SID to root SDDL on page 257

If you decide to use Host Configuration utility, the script performs these operations on
the host.

l For Windows 2008 and Windows 2012, the Host Configuration utility sets both
WinRM and WMI configurations.

These procedures are only available in ViPR SRM 3.5.1.

Adding a non-admin user to a group

Before you begin

On a Windows 2008/2012 host a non-admin user should be part of the following
groups:

l Performance Monitor Users

l Performance Log Users

l Add non-admin users to the group WinRMRemoteWMIUsers__ . If that group does
not exist, add the user to Distributed COM Users group.

Procedure

1. Go to Start.

2. Right-click Computer name and click Manage.

3. On the Computer management window, click Local Users and Groups.

4. Right-click the non-admin user and select Properties.

5. Select the MemberOf tab.

6. Click the Add button and key in the group name.

7. Click Ok, then click Apply.

8. Repeat these steps to add Performance Monitor Users, Performance Log Users
and TelnetClients.

9. click Ok

Retrieving the SID of a non-admin user

Procedure

1. Run the command wmic useraccount get name,sid at a command
prompt.
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2. From the output of the command, capture the SID of the non-admin user.

Adding a non-admin SID to root SDDL

Procedure

1. Open a command prompt.

2. Type the following command to add the SID.

winrm set winrm/config/service
@{RootSDDL="O:NSG:BAD:P(A;;GA;;;BA)(A;;GA;;;<non-admin-
sid>)S:P(AU;FA;GA;;;WD)(AU;SA;GWGX;;;WD)"}
Replace <non-admin-sid> in this command with the SID you obtained.

Using the host configuration utility

The host configuration utility allows you to configure and/or verify the WSMAN
settings that ViPR SRM requires for Windows host discovery. It is available at <APG
Home Directory/Collecting/Stream Collector/Generic-RSC/scripts/
windows>
The script verifies and performs the following actions:

l Ensures that the WINRM service is running

l Creates a listener port for accepting WS-MAN requests

l Adds firewall exceptions to open port 5985 as non-SSL and 5986 as SSL

l Sets Basic or Negotiate authentication mode, based on an input argument to the
script (-authType <Authentication_type>), to true. (EMC recommends
Negotiate.)

l Sets MaxTimeout value to 300000 ms.

l Checks whether fcinfo package is present on the host, if Windows 2003

l Verifies the presence of INQ on the host and checks its version, if Windows 2003

Usage
./hostconfig-srm.ps1 <-verify | -set | -set -force> [-authType
<authentication_type>] [-ssl [-thumbprint <thumbprint_value>]
[-CN <certificate_hostname>]] [-user <username>][-help]

Table 11 Host Configuration utility command options

Options Description

-help Displays the help menu of the script.

-verify Verifies current settings on the Windows host.

-set Configures settings on the Windows host.

-set -force Changes configuration settings without prompting
the user. The -force option must be used with the
-set option.

-authType authentication-type Provide this option to set the authentication type
for WS-MAN to Negotiate or Basic.

-ssl Configures and verifies the SSL certificate
specific settings on the host for WS-MAN
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Table 11 Host Configuration utility command options (continued)

Options Description

discovery with SSL. For secure communication,
the data transport should be made secure where
SOAP packets would need to be encrypted with
certificates.

-thumbprint thumbprint_value Configures the SSL certificate with the specified
thumbprint_value on the host. This option must be
used only with the -ssl option.

-certhostname certificate_hostname Configures the SSL certificate with the specified
certificate_hostname value on the host. This
option must be used only with the -ssl option.

-user username Configures the host to enable discovery using the
non-admin username provided.

Example 3  Sample usage of hostconfig-srm.ps1 script

The following screens show how to perform actions with the Host Configuration
Utility.

l Verify whether host is ready for discovery with HTTP using Negotiate authtype by
running the following command on the target windows host to be discovered: .
\hostconfig-srm.ps1 -verify -authType Negotiate

l Set Negotiate authtype for a successful discovery with HTTP on Windows 2008: .
\hostconfig-srm.ps1 -set -authType Negotiate

Configuring group policy
Use a group policy if you do not want to set the configuration on each and every host
(either manually or using a script). The group policy lets you apply a set of
configurations across a set of hosts. You have to configure the group policy so that it
can be applied across hosts as required.

Procedure

1. Right-click Computer and select Manage.

2. Go to Features > Group Policy Management > Forest Domain name >
Domains > Domain Name > Default Domain Policy.

3. Right-click Default Domain Policy and select Edit.

The group policy editor appears.

4. Select Default Domain Policy > Computer Configuration > Policies >
Administrative Templates > Windows Components > Windows Remote
Management.

5. Modify the following parameters as required:

l Enable Allow automatic configuration of listeners.

l Enable Allow Negotiate Authentication (for domain user).

l Add Windows Firewall exception for Port 5985 - HTTP
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l Add Windows Firewall exception for Port 5986 - HTTPS

Note

HTTPS listener configuration is not possible from Group Policy.

Configuring firewall port exception using group policy
Using group policy, you have to configure firewall port exception if you are not using
default ports.

Procedure

1. Click Computer.

2. Go to Computer Configurations > Policies > Windows Settings > Windows
Firewall with Advanced Security > Inbound Rules

3. Create a new inbound rule

This enables the WinRM communication.

Updating group policy
If you update the group policy on a domain controller, the changes are reflected on the
computers that are part of the domain in approximately 90-120 minutes. Use this
procedure to force update the group policy on the member computers.

Procedure

1. You can use any of the options for force update of group policy:

Option Comment

Run the command gpupdate/force on
all the member computers.

This command results in a fetch
operation for the group policy

This command has to be run on all
the hosts and hence maybe
cumbersome.

Change the Group Policy Refresh Interval
in the Group Policy Management editor
under Computer Configuration >
Administrative Templates > System >
Group Policy

Minimum possible time is 7
minutes.

Reducing refresh interval is not
recommended as it increases the
load on the network.

Generating a certificate
WinRM HTTPS requires a local computer server authentication certificate or self-
signed certificate with a CN name installed on the host. The certificates should not
have expired or been revoked.

Perform the following to create certificates:

Procedure

1. Generate a .pfx certificate

2. Exporting the .pfx certificate

3. Importing the .pfx certificate
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4. Generate a .cer file

5. Import the .cer file

Generating a .pfx certificate

You can generate the required certificate using any certificate generator. This
procedure demonstrates generating a certificate using makecert.

Procedure

1. From the command prompt, run C:\>makecert.exe -ss MY -sr
LocalMachine -n "CN=<certificatename>" -sky exchange -pe -a
sha1 -eku 1.3.6.1.5.5.7.3.1
The above makecert command can only be used for operating system versions
prior to Windows Server 2012 and not including Windows Server 2012.

a. To generate a certificate for Windwos Server 2012, run the command: New-
SelfSignedCertificate -CertStoreLocation cert:
\LocalMachine\My -DnsName "<host-name>"
Here DnsName is considered as the Certificate Name(CN) so the hostname
is compulsory.

b. To generate a certificate for Windows Server 2016, run the command: New-
SelfSignedCertificate -CertStoreLocation cert:
\LocalMachine\My -Subject "CN=<host-name>" -KeySpec
KeyExchange -KeyExportPolicy Exportable -TextExtension
@("2.5.29.37={text}1.3.6.1.5.5.7.3.1") -HashAlgorithm
SHA256
Hostname is compulsory for certificate name(CN=hostname) for -Subject
parameter.

This creates a certificate under the personal store. Use the following steps to
verify the certificate created using makecert and New-
SelfSignedCertificate.

2. On a Windows host, click Start > Run.

3. Type mmc and click OK.

The Console window appears.

4. Click File > Add/Remove Snap-in.

5. Select Certificates under Available snap-ins and click Add.

6. Select Computer account.

7. Click Finish.

8. Click OK in the Add or Remove snap ins window.

9. On the left pane, double click Certificates (Local Computer) > Personal >
Certificates.

10. On the right pane double click the certificate listed.

11. Navigate to Details tab. Select Subject to get the CN Name and Thumbprint
to get the Thumbprint of the certificate.

Note the CN Name and Thumbprint value, which will be used later while
creating a WSMAN listener for HTTPS.
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Exporting the .pfx certificate

To use the same certificate on multiple hosts, the generated certificate has to be
imported on other hosts.

Procedure

1. On a Windows host, click Start > Run.

2. Type mmc and click OK.

3. In the Console window, click Certificates (local Computer) > Personal >
Certificates.

4. Double-click Certificates.

5. Under Details, click Copy to File.

6. In the Certificate Export Wizard select Yes, export the private key. and click
Next.

7. Select Include all certificates in the certification path if possible and click
Next.

8. Type a password for the private key.

This password is used when you import this certificate on other hosts.

9. Type a filename and save the .pfx file.

Importing the .pfx certificate

You have to import the .pfx on other hosts if you want to use the same certificate on
multiple hosts.

Before you begin

The .pfx certificate must be copied on the host where it is to be imported.

Procedure

1. On a Windows host, click Start > Run.

2. Type mmc and click OK.

3. In the Console window, click Certificates (Local Computer) > Personal >
Certificates

4. Right-click and select All Tasks > Import.

5. In the browse window, select the .pfx certificate and click OK.

Generating a .cer file

The .cer file is created from a .pfx certificate with only a public key, which is used
along with the private key for a successful handshake between the client and server.

Procedure

1. Go to Start > Run > mmc > Certificates (Local Computer) > Personal >
Certificates

2. Double-click Certificates.

3. Under Details, click Copy to File.

4. Select No, do not export the private keys.

5. Selecting the Encoding type as DER or Base-64, and click Next.

6. Type a file name and click Save.
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Importing a .cer file

You have to import the .cer file on the collector host to enable a successful handshake
between the server and the client.

Procedure

1. Copy the .cer file on the collector host.

2. Log in to the collector.

3. Run the command /opt/APG/Java/Sun-JRE/6.0u45/bin/keytool -
import -file <Public_Certificate_File> -keystore /opt/APG/Java/
Sun-JRE/6.0u45/lib/security/cacerts -alias <Name>

The command prompts for keystore’s password. The default password is
changeit.

A sample output returned by the command:

Owner: CN=<CN Name>
Issuer: CN=Root Agency
Serial number: 522200243f029a894c741bcb83d58a5d
Valid from: Tue Dec 10 11:59:03 EST 2013 until: Sat Dec 31
18:59:59 EST 2039
Certificate fingerprints:
MD5: 99:2A:6E:DC:CD:D7:7E:7D:07:C3:E2:8A:8F:E1:BB:DD
SHA1:
17:29:F4:45:99:AE:DC:C5:08:C6:73:D4:CF:A6:BE:7E:79:48:50:76
Signature algorithm name: SHA1withRSA
Version: 3
Extensions:
#1: ObjectId: 2.5.29.1 Criticality=false
#2: ObjectId: 2.5.29.37 Criticality=false
ExtendedKeyUsages [
serverAuth
]
Trust this certificate? [no]: yes

Unix host/LPAR (VIO Server/Client) configuration for discovery and data
collection

ViPR SRM supports discovery of several Unix variants. Each Unix environment
requires configuration for ViPR SRM to collect data consistently.

Software to preinstall on Unix hosts for discovery
The following software must be available/installed on Unix hosts for successful ViPR
SRM discovery:

l INQ binary (an EMC command line executable). You can acquire INQ in the
following ways:

n Enable the Push INQ check-box on the generic-rsc block to allow ViPR SRM to
push inq directly to a host. This is enabled by default.

n Pre-install INQ at a user-specified location on the host at a location provided to
ViPR SRM during SolutionPack installation.
INQ 8.1.0.4 needs to be made available on the host. Platform specific INQ can
be downloaded from: ftp://ftp.emc.com/pub/symm3000/inquiry/
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Note

Note: INQ 8.1.0.4 is supported only on 64-bit OS platforms. INQ 7.6.2 must be
manually copied onto 32-bit target hosts.

The downloaded platform-specific binary should be renamed to inq and placed
in any user-defined location. The location where the INQ binary is placed must
be provided to ViPR SRM during installation of the SolutionPack for Physical
Hosts under Advanced settings: Location_inq.

Note: The INQ binary should have executable permissions on the host.

l System Activity Report (SAR)
SAR command is used by ViPR SRM to collect performance metrics from hosts/
LPARS. 'sar' is a part of systat package, identify the compatible version of systat
package corresponding to the operating system and install it on hosts/LPARS
required for discovery, if not already installed on the host/LPARS.

Note

The SolutionPack for Physical Hosts does not package the SAR utility.

Configuring sudo for host/LPAR (VIO Server/Client) discovery
Due to security constraints, ViPR SRM must be able to discover Linux and UNIX hosts
in a data center even with non-root credentials. SUDO is a tool on UNIX hosts that can
temporarily elevate user to execute command as root. Administrators can add specific
commands in the sudoers file to enable ViPR SRM to execute those commands and
collect host information.

Before you begin

Supported sudo versions

Linux Fedora distribution: sudo-1.8.6 and above

Other operating systems: any version of sudo

Procedure

1. Include the path of sudo command in the environment variable $PATH for the
sudo user.

The variable $PATH can be set either in /etc/environment or /etc/
default/login or any other OS specific file.

2. Include the paths of OS commands in the environment variable $PATH for sudo
user.

By default, most of the OS commands are located at the following
location: /usr/local/sbin:/usr/local/bin:/sbin:/bin:/usr/
sbin:/usr/bin

3. Verify that the $PATH is correct.

a. Log in as sudo user

b. Type which sudo.
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4. Ensure that the sudoers file is available.

By default, the sudoers file is available in /etc or /opt/sfw/etc/
or /usr/local/etc/sudoers

5. Add the following line to the defaults section of the sudoers file:

Defaults !requiretty #for all users
or

Defaults : SRMADMIN !requiretty #for a specific user

6. For AIX hosts, if inq gives partial information, add the following line:

Defaults env_keep += "ODMDIR"
7. Ensure that the sudo user has root privilege to run the following commands on a

given host.

Ensure the absolute path to the packages are provided in sudoers file.

It is recommended to use visudo to edit sudoers file.

Some packages are not installed by default.

AIX

sar, inq, powermt, vxdisk, swap, kdb (kdb is only for VIO Clients)

Linux

sar, inq, powermt, vxdisk, dmidecode, lvs, pvs, vgs, multipath

HPUX

sar, inq, powermt, vxdisk, /opt/sfm/bin/CIMUtil (CIMUtil is required only
in ViPR SRM 3.5.1 or higher)

Solaris

sar, inq, powermt, vxdisk, mpstat
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Figure 1 Sample sudoers file for Linux OS

Configuring PowerBroker for host/LPAR(VIO Server/Client) discovery
PowerBroker for UNIX & Linux allows system administrators to delegate UNIX and
Linux privileges and authorization without disclosing passwords for root or other
accounts. Administrators can add specific commands in the configuration/policy files
to enable ViPR SRM to execute those commands and collect host information.

Procedure

1. Include the path of the pbrun command in the environment variable $PATH for
the powerbroker submit/run host.

2. Include the paths of the OS commands in the environment variable $PATH for
the pbrun user. By default, most of the command files have the following
location:

/usr/local/:sbin:/usr/local/bin:/sbin:/bin:/usr/
sbin:/usr/bin

3. Verify that the $PATH is correct.

a. Log in to the submit/run host.

4. Type "which pbrun".

SolutionPack for Physical Hosts

Unix host/LPAR (VIO Server/Client) configuration for discovery and data collection     265



5. The configuration/policy files exist on the master host and they must include
the pbrun user name and the associated commands for host discovery. The
following screenshot displays the policy files for a configuration in which the
master/submit/run host is on the same host:

In this screenshot, the RootUsers variable includes "cmguser", which is the
submit user (the ViPR SRM user used for discovering the host details) and the
RootProgs variable includes the various commands required by ViPR SRM to
discover the host. Note that the commands mentioned in the section about
configuring sudo apply here as well.

Note

The configurations above are sample configurations for reference. Contact your
host admininistrator to make changes according to your environment.

Configuring centrify dzdo for host/LPAR(VIO Server/Client) discovery
Refer to the Centrify Suite Evaluation Guide for Linux and UNIX in the Centrify
documentation or contact your server administrator.

Generating a public and private key pair

For the SSH key method of discovering UNIX hosts/LPAR (VIO Server/Clients), you
must generate a valid public and private key pair. You can choose any key generation
tool to generate a valid public and private key pair.
Before you begin:

Before you begin host discovery, you must have a public key present on all the UNIX
hosts/LPARS that are to be discovered using the private key. You can create SSH
keys in any Unix environment and import them onto the ViPR SRM collector. EMC
recommends that you create public-private SSH keys on ViPR SRM collectors (Linux
VMs) where host discovery will be initiated.
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These steps describe the procedure to generate a public and private key pair for UNIX
hosts/LPARS using the ssh-keygen tool.

Note

The public key is to be added to the authorized_keys file on the target hosts intended
for discovery and the private key is to be imported to the collector VMs where
discovery is triggered.

Procedure

1. A Public-Private key can be generated using the following command:

ssh-keygen -t rsa -f <location_of_the_private_key/name_of_
private_key_file> -N ""
For example: ssh-keygen -t rsa -f /root/.ssh/id_rsa -N ””

2. Ensure that the public and private key pair that is generated has the following
permissions:

l chmod 600 /root/.ssh/id_rsa
l chmod 644 /root/.ssh/id_rsa.pub
The private key file is id_rsa
The public key file is id_rsa.pub

3. To make the key pair functional, append the public key to <user's home
directory>/.ssh/authorized_keys in the target UNIX host using the
command mkauthkeys --add "string" where "string" is the content of
id_rsa.pub file.

Next, import the private key to the Collector used for discovery.

Note

The public key is to be added to the authorized_keys or authorized_keys2
(depending on the HMC version) file on the target hosts intended for discovery
and the private key is to be imported to the collector VMs where discovery is
triggered.

Importing a private key into the Collector

Procedure

1. The private key should be placed inside APG's HOME directory (where APG is
installed).

For example: UNIX: /opt/APG/.

2. Type chown apg:apg <private_key_file>.

This command changes the owner.

The HMC is now ready for successful data collection.
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Configuring SSH authentication
Do the below changes if SSH authentication fails on any Unix Host/LPAR. Modify
the /etc/ssh/sshd_config file and restart the sshd service to allow successful
SSH authentication.

Procedure

1. Change the following value to yes:

#PasswordAuthentication no <--- original
#PasswordAuthentication yes <--- modified

Discovery via Host Agent for Unix/Linux
The Host Agent for Unix/Linux allows you to discover hosts via a non-privileged user
with read-only access to the /tmp directory. You can provide a non-admin/service
account user with read-only permission to ViPR SRM to authenticate the host and
collect metrics generated by the host agent.

Before you begin

Note

Create a non-privileged user account with read only rights on the target host to be
discovered.

The host agent is provided as a self-extracting shell script (srmhostagent.sh) that
upon execution extracts the LUNMappingDdetection.pl script, supporting perl
modules, and inq-archive.tar on the target host in the /opt/emcsrm directory.

The following items should be available and running as root user on the target host:

l srmhostagent.sh – A self-extracting script file with the following components:

n LunMappingDetection.pl
n LunMappingDetection_conf.txt
n RSC.pm
n RSCPP.pm
n PerfMon.pl
n inq-archive.tar
n startup_config.pl

l A cron job entry that you will configure while extracting srmhostagent.sh for
the scheduled run of LMD.pl (procedure explained below ).

l The Reports component of the SolutionPack for Physical Hosts must be installed
on the Frontend server.

Procedure

1. Download srmhostagent.sh to a temporary directory on the target host.

2. As the root user, run srmhostagent.sh. The script creates a folder named
emcsrm in the /opt directory and extracts the perl scripts and modules used
for discovery to the /opt/emcsrm directory.

For example,./srmhostagent.sh customize=yes cronadd=yes
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customize=yes allows you to configure advanced settings. You can
reconfigure all of those questions that are asked during the installation of the
SolutionPack for Physical Hosts with customize=yes.

cronadd=yes adds a cronjob that triggers the host discovery script based on
the polling interval (the default is 15 minutes).

# ./srmhostagent.sh customize=yes cronadd=yes
Verifying archive integrity...  100%   All good.
Uncompressing Extracting LunMappingDetection.pl and 
supporting perl modules  100%
Collect performance metrics Point in time data [y/n] Default 
[y]:
Collect performance metrics for PowerPath LUNs [y/n] Default 
[y]:
Collect performance metrics for PowerPath Bus [y/n] Default 
[y]:
Collect performance metrics Average over time [y/n] Default 
[n]: y
Collect performance metrics for Networks ports [y/n] Default 
[n]: n
Collect performance metrics for PowerPath range-bound [y/n] 
Default [n]: y
Creating "/opt/emcsrm" and extracting all files within, 
proceed..? [Y/n] Default [y]:
Successfully updated cron entry

./srmhostagent.sh -h displays help on how to use srmhostagent.sh.

Note

Avoid using any of the other options while running the ./srmhostagent.sh
command except --quiet option.

When run without any parameters, you can run the script any number of times
without consequence and it will re-extract the files under /opt/emcsrm. When
run with parameters such as “customize=yes” and “cronadd=yes”, there is a
possibility that the configuration settings provided with a customized
installation will be overwritten with subsequent executions of the
srmhostagent.sh script. EMC recommends that you always use the
“customize=yes” and “cronadd=yes” options together to prevent the possibility
of overwriting the customizations. If the script is run without the
“customize=yes” option, all configuration settings are set to their default
values.

3. To upgrade srmhostagent.sh, download and execute the latest version as
shown above. All the files in /opt/emcsrm location will be overwritten with the
latest version.

4. To cleanup/purge smrhostagent.sh related files, use cleanup=yes option.

Results

The LunMappingDetection script creates an output file in /tmp/
hostdata_LunMappingDetection_<hostname> that is read by the non-admin
user credentials supplied to ViPR SRM for discovery of the target host.
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Note

ViPR SRM release specific srmhostagent.sh is uploaded to https://
support.emc.com whenever there are any new changes. Download and execute the
latest version to upgrade the Host Agent for Unix/Linux binary: srmhostagent.sh.

Configuring ESX hosts to collect PowerPath metrics
This procedure describes how to configure ESX hosts to collect PowerPath metrics.

Before you begin

l Ensure that PowerPath/VE remote CLI (rpowermt) is installed on the host and
enable performance collection by running the rpowermt set perfmon={on
[interval=<#seconds>] | off} host=HOST_FQDN command.
The EMC ViPR SRM Support Matrix provides more information on supported
PowerPath versions.

l Register ESX and enable performance for reporting.
Refer to the Powerpath /Ve or RTOOLS documentation about how to register an
ESX server and enable performance.

l Configure the host where RTOOLS resides in generic-RSC based on the operating
system type (ESX-LINUX or ESX-Windows).

You can discover ESX and VMs running on the ESX server using the SolutionPack for
VMware vCenter. However, the vCenter API does not provide all PowerPath metrics.
Therefore, if you want PowerPath metrics, you need to provide the IP addresses of
the RTOOLS host (physical host or VM) in addition to discovering the VMs using the
SolutionPack for VMware vCenter. Depending on whether the RTOOL host is running
on Windows or Linux OS, you have to configure the generic-rsc collector with OS type
as ESX Windows or ESX Linux, respectively, to collect PowerPath metrics.

Procedure

1. Create a lockbox.

2. Update host username and password in the lockbox.

The PowerPath/VE for VMware vSphere Installation and Administration Guide
provides detailed description of performing the above steps.

PowerPath reports can also be accessed from Explore View > Host > Storage
Connectivity.

PowerPath reports are available for the SolutionPack for IBM LPAR.

3. In Host configuration under Device Management, add one of the following
options for the RTOOLS host:

l ESX Linux if the RTOOL application is running on a physical host or VM
running Linux.

l ESX Windows if the RTOOL application is running on a physical host or VM
running Windows.

Configuring hosts to collect PowerPath metrics
Provides information about configuring host to collect PowerPath metrics.

To collect PowerPath metrics, do the following:
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Procedure

1. Install PowerPath CLI (powermt) on the host.

Note

The PowerPath CLI is installed by default during the PowerPath installation.

2. Enable performance collection by running the powermt set perfmon={on
[interval=<#seconds>] | off} command.

Note

The EMC ViPR SRM Support Matrix provides more information on supported
PowerPath versions.

Installing the SolutionPack

Before you begin

l Core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l For non-admin users, the SolutionPack for Physical Hosts will report an
authentication error during discovery if the user is not part of the remote admin
users group. To avoid this issue, add non-admin users to the
WinrMRemoteWMIUsers__ group. If that group does not exist, add non-admin
users to the DCOM group on the Windows host.

The steps below assume a typical four server deployment: Primary Backend,
Additional Backend, Collector, and Front End.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name if you wish to change the default instance name of
generic-host.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays a note about pre-configured alerts.

10. Click Next.

The window displays reports settings.
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11. In Administration Web-Service Instance, select an existing instance or create
a custom instance.

12. Click Next.

The window displays script settings.

13. Select the performance metrics that you want to collect. Click Use advanced
settings to configure the absolute paths of the binaries.

14. Click Install.

15. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

Adding and configuring devices in Discovery Center
Procedure

1. Click Discovery Center > Inventory Management.

2. Click Host configuration.

These steps describe how to add hosts individually. For information about using
discovery groups to use the same credentials to discover multiple hosts, see 
Adding devices to discovery groups.

3. Click Add New Device.

4. Select the Server and Instance where you want to store the configuration
details for this device.

l Server: If multiple collectors are deployed then choose the collector from
the drop down where "generic-host: script block" is installed.

l Instance: Generic-RSC is the default instance name unless an additional
"generic-rsc" block is installed.

5. Enter the hostname.

6. Select the discovery mode from the Specify the discovery mode drop-down
menu.

If you select Host Containers, enter one or more HBA port WWNs in the Host
Port WWN field. Multiple WWNs must be separated by a semicolon (;). This
field is not case sensitive.

7. If you select Agentless or HostAgent Unix/Linux discovery, select the OS type
from the Specify the OS type drop-down menu.

Note

For HostAgent Unix/Linux, Unix is the only option and it applies to all of the
Unix/Linux flavors.

8. For AIX, ESX-Linux, HPUX, Linux, or Solaris hosts, from the Authentication
Type drop-down menu, select:

l Password based if you are using password based authentication.

l Public key based if you are using key-based authentication.

9. For ESX-Windows or Windows hosts, from the Connection Type drop-down
menu, select:

l HTTPS if you intend to use SSL certificates for authentication.
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l HTTP if you intend not to use SSL certificates for authentication.

10. For Windows, if you have a custom WinRM URLPrefix, enter the same. Leave it
blank if wsman is the default URLPrefix.

11. Provide the username (root / non-root / administrator / non-admin / service
account user).

12. If you are using password based authentication (Unix) or HTTP based
Connection type (Windows), provide the password for the host.

13. If you are using key-based authentication, provide the absolute location of the
private key:

/opt/APG/<Name of private key>

14. Type the network port.

Protocol Default Port

SSH 22

HTTP 5985

HTTPS 5986

15. Keep the default settings for the Collection level and Force collection.

16. Click Validate and Add to validate the credentials.

17. Click OK.

18. Click Save.

SolutionPack reconfiguration

If you want to change the answers that were provided during the SolutionPack
installation, you can change them by reconfiguring the SolutionPack.

Procedure

1. Click Administration .

2. Under Centralized Management, navigate to SolutionPacks > Infrastructure >
Physical Hosts, and click the Reconfigure button for the component that you
want to modify.

The SolutionPack Reconfiguration dialog box appears.

3. Change the configuration as desired.

4. Click Reconfigure.

Configuring ViPR SRM to search for additional paths for
INQ

To configure ViPR SRM to look in additional paths for INQ, use the following
procedure:

Procedure

1. Log into the ViPR SRM UI with an account that has administrator privileges.

2. Click the Administration icon on the top menu.
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3. In the left pane, navigate to Administration > Centralized Management >
SolutionPacks.

4. Select Infrastructure > Physical Hosts.

5. Click the pencil icon to edit the scripts component of the SolutionPack for
Physical Hosts. The SolutionPack Reconfiguration page displays.

Figure 2 Edit scripts of the SolutionPack for Physical Hosts

6. Select the Use advanced settings checkbox to display the Location of the inq
binary field.

7. Type the path where INQ is located on the target host into the Location of the
INQ binary field. For example, /usr/site/bin.

Figure 3 SolutionPack Reconfiguration absolute location of INQ binary

8. Click Reconfigure and apply the change.

Recommendations
l Do not discover the same host using agentless discovery and EHI agent-based

discovery. Simultaneous discovery results in duplicate data collection. If you
switch from agentless discovery to EHI agent-based discovery (or vice versa), the
metrics collected from the previous discovery mechanism become inactive.
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Limitations

l For Dashboards > Hosts:

n Distribution by OS: The total count will not match the All Hosts (Excluding
ESX) if "devdesc" (Operating system details) is not collected for VMs.

n Distribution by Multipath: Windows hosts that have native DMP or PowerPath
installed, but are not using it to manage disks, will not be visible in this report.

l This SolutionPack does not identify LUNs from the Hitachi AMS200 array, due to
the unavailability of WWN using in-band SCSI mechanisms accessible to the hosts,
hence the LUNs associated with the array cannot be matched with the disks from
the hosts.

l On Windows hosts, if the multipathing software on the host does not support any
array, the LUN from that array may show up as multiple host physical drives.

l Physical hosts connected to IBM DS 8000 do not show "Connected array" and
"LUN" in the SAN disks report.

l SAN Disks and Internal Disks reports will not be populated for Windows host
discovered using non-admin user.

l For SRM 3.7.1 and higher, if you are using the aes256-ctr encryption algorithm for
enhanced security, follow the instructions in KB article 000463134.

l If the same performance data is represented in multiple ways on the same report
(such as on a standard table and a simple chart), if data collection stops for 24
hours, it is possible for one of the displays to contain data while the other is blank.
This is caused by different time management settings between the two displays.

l End to End use cases like "Topology" and "Storage connectivity > Connectivity"
are not supported on Unix platforms (other than Linux) configured on CISCO UCS
Servers mounted with CISCO VNIC HBAS. This is due to inherent dependencies on
inq and in-turn SNIA libs.
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CHAPTER 37

SolutionPack for Storage Compliance

This chapter includes the following topics:

l Overview..........................................................................................................278
l Where to find the latest SolutionPack software............................................... 278
l Installing the SolutionPack............................................................................... 278
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Overview

The SolutionPack for Storage Compliance allows user to manage Storage Compliance
Policies, ESM Matching, Compliance Rule Definitions, and perform Configuration
Planning. It also generates breach, track configuration changes, policy report, and
Compliance Configuration Planning report. This enables the identification of any
deviation from configuration best practices, including items that do not comply with
the EMC ViPR SRM Release Notes. The compliance reports can be found under
Operations > Compliance. Click the Storage Compliance link in the Administration
screen to launch the Policy & Rule Management, ESM matching, and
Configuration Planning screen

Where to find the latest SolutionPack software

Install the latest core software update for the product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the
software longer than 30 days, you must install a SolutionPack license before the trial
period ends.

This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request for a license. For the license, submit a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.

Installing the SolutionPack

Before you begin

l EMC M&R uses SSH and a user account.

l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

l If you are installing on a Windows host, stop the process jucheck.exe. This is a
Java JRE update validator and uses the same port as the SolutionPack.

l Do not install multiple instances of the Storage Compliance Backend because the
same port would be used for each installation. This will lead to service startup
failure.

l Alerting backend service should be available during installation; otherwise alerting
definition will not be created. The SolutionPack for Storage Compliance creates
alerting definition for notifying mentioned users with email alerts for breaches/
violations.

l Though the Compliance service comes up immediately, do not run ESM rules as
the SolutionPack installation also populates the database with ESM data, for ESM
rule validation, which takes some time to get the database populated
(approximately 3-5 minutes).

Procedure

1. Click Administration .

2. Click Centralized Management.
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3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays compliance notification details.

9. Select an item in Breach Notification Details. If you select Add a new Breach
Notification Details, select an instance to receive breach notifications.

10. Click Next.

11. From the Frontend Web service drop-down list, select existing settings that
have been specified for other components or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

The Tomcat port should be 58443.

The Tomcat communication protocol should be HTTPS.

12. Select a Topology Service. To add a new gateway configuration, select Add a
new Topology Service.

13. Select a configuration for Breach Notification Details.

Reuse the answers if another SolutionPack is using Alerting backend. Otherwise
create a new configuration by selecting Add a new Breach Notification
Details. In the Alerting Backend hostname or IP address, type the Primary
Backend host. Type 2010 as the port.

14. Select a configuration for Alert Consolidation Details.

Reuse the answers if another SolutionPack is using Alert Consolidation
Details. Otherwise create a new configuration by selecting Add a new Alert
Consolidation Details. In the Alert Consolidation hostname field, type the
Primary Backend host. Type 2040 as the port.

If SOM RCA installation needs to be done, the alert consolidation configuration
is required. For more details, refer to the "How to" article for SOM.

15. Click Next.

16. On the Compliance Rules page, click Next.

17. From Administration Web-Service Instance, select Default.

18. In Configuration for Compliance Backend Web-Service, for 4 VM
installations, type the Primary Backend host for Web-Service gateway
hostname or IP address of Web-Service Gateway.

a. The Web-Service port number should be 48443.

b. The Authentication schema should be Certificate.

c. The Compliance Backend Instance should be generic-compliance.
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19. Click Next.

20. Click Install.

21. After Install of all the compliance components, click Ok.

After installation is complete, you need to restart the Tomcat for Compliance
Frontend to point to the configured Backend. If the Web Service password is
changed, then the Compliance Backend block needs to be reconfigured.
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CHAPTER 38

SolutionPack for VMware vCenter

This chapter includes the following topics:
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l Configuring the SolutionPack to collect PowerPath data.................................282
l Installing this SolutionPack.............................................................................. 282
l Post-install requirements................................................................................. 285
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Overview
The SolutionPack for VMware vCenter generates real-time and historical reports that
help you understand VMware performance for VMware Hosts, Virtual Machines,
virtual networks and DataStores.

Configuring the SolutionPack to collect PowerPath data
This procedure is required to collect PowerPath data from ESX servers.

For monitoring PowerPath performance and path status, an RTools host is required.
RTools is the remote CLI software for managing the PowerPath software on ESXi (or
other) hosts. The Collector uses the Generic-RSC Collector to issue RTools command
scripts to the RTools host to collect PowerPath data directly from the ESXi servers.

Procedure

1. Add the hostname and credential of every ESXi host to the RTools default
lockbox. Commands fail if the lockbox is not populated.

The first use of the command creates the lockbox if necessary.

2. Generic-RSC Collector discovers the RTools host. Discover it through the
SolutionPack for Physical Hosts using the ESX Linux or the ESX Windows host
type. Choose the Linux or Windows type appropriate for the RTools host so
that the collector can issue the correct format scripts.

3. Create the default lockbox on RTools Host and add ESXi hostname credentials:

rpowermt setup add_host host= username= password=
4. Turn on performance monitoring on ESXi host from Rtools (if needed):

rpowermt set perfmon=on interval= host=
5. For PASSWORD based discovery Suse Linux hosts from 3.0 RSC, it requires

edits to the sshd_config file. Note that this file is located under /etc/ssh
directory on discovery hosts. Enable "PasswordAuthentication" and restart
sshd service on the host.

lglah196:~/.ssh # grep Password /etc/ssh/sshd_config
#PasswordAuthentication no #PermitEmptyPasswords no
lglah196:~ # /etc/init.d/sshd restart Shutting down SSH
daemon done Starting SSH daemon done
lglah196:~ #

Installing this SolutionPack

Before you begin

l Core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.

Procedure

1. Click Administration .

2. Click Centralized Management.
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3. Click SolutionPack Center.

4. Select the SolutionPack in the Browse and Install SolutionPacks window.

5. Click Install.

6. Type the instance name.

7. Assign a server for each component.

In a typical four server deployment, the recommended servers are selected
automatically.

8. Click Next.

The window displays a note about Alert Consolidation.

9. Click Next.

The window displays pre-configured alert details.

10. To receive alerts, select Enable the Host PowerPath Alerts.

11. Click Next.

The window displays data collection details.

12. From the Data collection drop-down menu, select existing settings that have
been specified for other components, or select Add a new data collection.

If you select Add a new data collection, type information about the data
collection. In Hostname or IP address to send data to, use localhost on port
2020, which is the Collector host where the Load Balancer Connector is
installed.

13. From the Frontend Web service drop-down menu, select existing settings that
have been specified for other components, or select Add a new Frontend Web
service.

If you select Add a new Frontend Web service, type information about the
Frontend Web service.

14. Leave Enable Topology Backend on data collected checked.

15. From the Topology Service drop-down menu, select existing settings that have
been specified for other components, or select Add a new Topology Service.

If you select Add a new Topology service, provide information about the
topology service and the web service. In Topology Service hostname or IP
address, specify the Primary Backend.

From the Web-Service Gateway drop-down menu, select existing settings that
have been specified for other components, or select Add new gateway. If you
select Add new gateway, provide information about the web-service gateway
where the topology service resides.

16. Optionally, select Do you want to configure advanced settings to configure
the metric collection level, polling intervals, collection thread settings, and the
re-synch interval.

a. In Metric Collect Level, select the level of metrics you want the
SolutionPack to collect per VMware collector block. The Metric Collect
Level is an internal setting that tells the SolutionPack for VMware vCenter
how much data to collect. This setting is not related to vCenter statistics
levels.

Collect-Level 1 collects the minimum required metrics that are related to
capacity, topology, memory, and CPU.
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Collect-Level 2 collects all metrics that are supported by Collect-Level 1 and
additionally all metrics that are related to disks and memory.

Collect-Level 3 collects all supported metrics, which include metrics that are
collected under Collect-Level 1 and Collect-Level 2.

b. In Polling interval for VMware vCenter collection, select a polling interval.

c. In Polling interval for VM files only, select a polling interval.

d. In Number of collecting threads, type the number of collection threads.

e. In Number of collecting threads for VM files, type the number of
collection threads.

f. In Re-Sync interval, select an interval.

17. Click Next.

18. From Event database, select a database.

If you select Add a new Event Database, add the Primary Backend host in the
Database hostname or IP address field.

19. Click Next.

The window displays reports settings.

20. Click Next.

21. To collect performance metrics for all the logical Bus that is managed by
PowerPath agent, select Collect performance metrics for PowerPath Bus.

22. To collect performance metrics for all the logical devices that are managed by
PowerPath agent, select Collect performance metrics for PowerPath LUNs.

23. To collect range-bound performance metrics, select Collect PowerPath range-
bound performance metrics. Selecting this option increases metric count
significantly. Be sure to correctly size your application before enabling this
option.

24. To set the absolute path location of the sudo and pbrun binaries, select Do you
want to configure advanced settings.

25. Click Install.

26. Click Ok. Monitor the installation logs to ensure that the installation completes
successfully.

27. Click Discovery Center > Inventory Management.

28. Click VMware vCenter (vmware-vcenter-collect <version>) for data
collection and/or VMware vCenter (vmware-vcenter-events <version>) for
vCenter events collection.

These steps describe how to add VMware vCenter hosts individually. For
information about using discovery groups to use the same credentials to
discover multiple VMware vCenter hosts, see Adding devices to discovery
groups.

29. Click Add New Device.

30. From Server, select the server where the device is dispatched.

31. From Instance, select the instance of the vmware-vcenter-collect where the
device is dispatched.

32. In Hostname or IP address, type the vCenter service host. Type the
Username and Password used to poll vCenter.
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33. Click Ok.

34. Click Save.

Post-install requirements
Perform these operations after the installation is complete.

To enable PowerPath LUN or Path performance data collection on Linux, browse to
the /opt/APG/Collecting/Stream-Collector/<Instance Name>/conf/
scripts/ directory.

Procedure

1. In the LunMappingDetection.pl script, set
want_powerpath_lun_performance=1.

By default, this flag is set to zero.

2. To enable the PowerPath LUN or Path performance data collection on
Windows:

a. Browse to the C:\Program Files\APG\Collecting\Stream-
Collector\<Instance Name>\conf\scripts\windows directory.

b. In the LunMappingDetection.ps1 script, set
powerPathPerformanceCollection=enabled.

By default, this flag is set to disabled.

3. To enable events reporting, open the Web-Application configuration file
(APG.xml) and uncomment the vmware-vcenter section and the
ResourceLink tag.

4. Restart the Tomcat service.

Limitations

l The Host Attributes report is missing the IP Address for VMware vCenter.

l Incomplete information for HBA driver, firmware, and HBA model in the discovered
value column in Match ESM screen.

l If a VM is discovered via both the SolutionPack for VMware vCenter and the
SolutionPack for Physical Hosts, the VM appears only in the SolutionPack for
VMware vCenter reports and is tagged according to its real device type which is
VM. It is not recommended to discover VMs using the SolutionPack for Physical
Hosts.

l Discovering ESXi hosts via the SolutionPack for Physical Hosts does not provide
any incremental value and is not a supported configuration. All available data is
collected via the SolutionPack for VMware vCenter.

l NAS shares on ESXi guests/virtual server are not supported with VMware vCenter
SolutionPack.
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CHAPTER 39

Discovery Center

This chapter includes the following topics:

l Discovery Center............................................................................................. 288
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Discovery Center
Discovery Center provides a central location to view and manage all devices which are
monitored by the SolutionPacks. In Discovery Center, you can add new devices to be
monitored, change device connection credentials and parameters, and test
connectivity to devices.

There are several ways to add new devices:

l Add a single device manually

l Add devices in bulk by importing a CSV file

l Add devices using discovery

Discovery Center contains two sections:

l The Inventory Management section is where you perform all add device and
manage device activities.

l The Discovery Center Backends section contains collector information that is
required by the automatic discovery operations.

Manage devices
The Inventory Management node is organized by device type. You perform all device
management activities on the device type pages.

The list of device types on the Inventory Management page is based on the
SolutionPacks that are installed.

Click a device type row to manage devices of that type. Management activities
include:

l Review the list of devices that are actively being monitored.

l View and change connection credentials and other device-specific parameters

l Test connectivity to each device

l Add or delete devices

Viewing all known devices and testing connectivity
You can view a list of the devices that are known to the system. You can verify the
connection parameters and availability for a device.

Procedure

1. Navigate to Centralized Management > Inventory Management.

The table lists all of the device types that are being monitored and the number
of devices in each type.

2. Click the device type of the device you want to test.

The Collected Devices tab lists all of the devices currently being monitored.

3. Select a device to test connectivity to it.

4. Click Test to verify that the device can be reached.
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Changing device configuration
You can change the connection parameters and other configurations for a device.

Procedure

1. Browse to Centralized Management > Inventory Management.

2. Click the device type of the device you want to test.

3. On the Collected Devices tab, click the row of the device to test.

The configuration dialog box for that device appears.

4. Change the parameters as needed.

See the product SolutionPack documentation for information.

5. Browse to Centralized Management > Inventory Management.

6. Click Test to verify connectivity.

7. Click OK to save the changes and exit the dialog box.

The device row now appears blue and in italics, indicating that the changes
must be distributed to the collector servers.

8. Click Save, and then OK to confirm the save.

9. Click OK.

Adding a new device manually
Using Discovery Center you can manually add a new device to be monitored.

Procedure

1. Browse to Centralized Management > Inventory Management >
device_type.

2. On the Collected Devices tab, click Add new device.

3. In the device configuration dialog box, type the parameters for the new device.

The configuration dialog box is device-specific. See the product SolutionPack
documentation for information about each field.

4. Click Validate and add.

The validation tests connectivity to the device using the provided information. If
an error indicator appears, correct the information and click Test to try again.

5. Click OK to confirm the add.

The new device appears in the Collected Devices table in blue and italicized,
indicating that it is not yet saved in the system.

6. Click Save.

7. Click Ok to confirm the save.

8. Click Ok.

The Status column represents the discovery results. You can click the status
icon to view the discovery results.

If the connectivity status is a green check, the new device is now being
monitored.
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Adding devices using CSV files
You can import a properly formatted CSV file to add devices.

Each device type provides a template that describes the required format of the CSV
file for the device type. You can also export existing devices into a CSV file.

Importing a CSV file
You can import a CSV file containing information about new devices to be monitored.

Before you begin

To import new devices, you must already have a SolutionPack installed that supports
the device type to be imported.

To get a template of the CSV file for a specific device type, use the Export Template
button.

Procedure

1. Browse to Centralized Management > Inventory Management.

2. Click the device type that you would like to add.

3. Click Import.

The Import new devices popup appears.

4. For Merge the devices to the existing ones?

Option Description

Do not check the
option

Overwrite the current list of devices with the devices
from the CSV file

Check the option Keeps the current list of devices and add (merge)
devices that are contained in the CSV file to the current
list

5. Click Choose File.

6. Browse to the CSV file.

7. Click Ok.

8. Click Continue.

The new devices appear in the Collected Devices table in blue and italicized.

9. Click Save.

The Save Devices popup is displayed.

10. To overwrite or merge the devices, click Ok.

11. Click Ok.

Exporting devices
You can export the list of devices currently being monitored.

Procedure

1. Browse to Centralized Management > Inventory Management.
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2. Click the device type of the devices that you want to export.

3. Click Export.

Follow the browser's prompts to save the file.

Exporting a CSV file template
A template shows the expected format of the CSV file for the bulk import of devices.
The template includes headers.

Before you begin

To export a CSV template file, there must already be one device of that device type
available.

Procedure

1. Browse to Centralized Management > Inventory Management >
device_type.

2. Click Export Template.

3. Follow the browser's prompts to save the file.

Add devices using discovery
The discovery feature uses saved information in discovery groups to find new devices.
A discovery group is specific to a device type.

The following procedures are required to implement discovery for a device type:

1. Register a collector server that supports discovery for the device type.

Note

The discovery method is supported by many, but not all, device types.

2. Create one or multiple discovery groups for the device type.

3. Trigger discovery for a discovery group.

4. Distribute the discovery results to the collector.

Registering a new collector server
To use the automatic discovery features, you must first register the collector server
that supports the device type you want to discover.

Procedure

1. Go to Centralized Management > Discovery Center > Discovery Center
Backends.

The table lists the system's Backend servers.

2. Click the row for a Backend server.

The collector servers that are registered to perform discovery are listed. The
table also shows the discoverable device types that are supported by each
collector server.

Note

If the table is empty, no collectors are registered.
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3. To see a list of unregistered collector servers, click Register.

4. Select one or more servers from the list, and click Register.

If you are collecting VMware vCenter events, select the primary backend that
you want to use for discovering the events.

When registration finishes, all of the currently registered collectors are shown,
with their supported discoverable device types.

Create a discovery group
A discovery group stores the connection information, credentials, and other
configuration information that is required to discover a group of devices. For example,
you might set up discovery groups to store IP address ranges or subnets and
appropriate connection credentials.

Before you begin

Before you can create discovery groups and use the discover feature, the collection
server that is associated with the device type must be registered.

l If the Discovery Groups and Discovery Results tabs are grayed out, the
collection server is not registered.

l If the Discovery Groups and Discovery Results tabs are not shown, discovery is
not supported for the device type.

Procedure

1. Go to Centralized Management > Discovery Center > Inventory
Management > device_type.

2. Click theDiscovery Group tab.

3. Click Add New Discovery Group.

4. Type a name for the discovery group and click OK.

5. Click the discovery group name.

Tables for different types of discovery information appear.

6. Add entries into the tables to provide the discovery information for the group.

Note

The discovery group fields are different for each device type. For information
about the fields, see the SolutionPack installation documentation.

Use the following buttons to add information into the tables:

Button Description

Add new entry… Add discovery information manually.

Import… Import a file containing discovery information.

Export Export discovery information to back it up or reuse it for
other discovery groups.

Export template Export a template to your Downloads folder. You can
complete the template with discovery information, and
then import the file with the Import button.
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7. Click Save.

You can now choose the group in a discover operation.

Discover devices
Discovery finds devices based on the seed information in a discovery group.

Before you begin

Use the Discovery Group tab to create a discovery group or research the settings in
discovery groups.

Procedure

1. Go to Centralized Management > Discovery Center > Inventory
Management > device_type.

2. On the Collected Devices tab, click Discovery.

If the Discover button is not available, ensure the appropriate collector is
registered and that at least one discovery group is defined.

3. Select a Discovery Group name.

4. Select a Discovery Mode.

l Use Full Discovery the first time you discover a group.

l Use Incremental Discovery to discover a newly added device.

5. For Automatically distribute results?:

l Select this option to distribute the results of discovery to the collector.

l Do not select this option if you want to review and approve the discovery
results before incorporating them into the system.

6. Click OK.

If you requested automatic distribution, the results of the discovery are visible
on the Collected Devices tab, and also on the Discovery Results tab.

7. If you did not request automatic distribution, go to the Discovery Results tab
to review the results and distribute them.

Distribute (import) discovery results
If you did not request the discovery process to distribute results, you can examine and
distribute the results on the Discovery Results tab.

Procedure

1. Go to Centralized Management > Discovery Center > Inventory
Management > device_type.

2. Click the Discovery Results tab.

The table shows an overview of discovery requests, by discovery group.

3. To see details about the discovered devices, click a discovery group name.

4. To import the discovered devices into the system (so that monitoring activities
can start on them), click Import to Collected Devices.

5. Complete the pop-up dialog box as follows:
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Option Description

To delete all existing devices of this device type,
and add the results of this discover group discovery

Click OK.

To retain existing devices, add the newly discovered
devices, and update any existing devices if
configuration changes were discovered

Click the Merge
checkbox and then click
OK.

6. To view the new set of devices being monitored, click the Collected Devices
tab.

Review the devices and credentials to avoid lockout of devices due to multiple
attempts of incorrect credentials. We recommend creating groups in such a
way that devices have a minimal set of credentials to be tried against. We
recommend using common public-private key pairs for multiple devices.

Physical host discovery
ViPR SRM supports several mechanisms for physical host discovery.

The following table summarizes the operating systems and SolutionPacks that apply
to each type of discovery:

Table 12 Physical host discovery methods

Discovery Mechanism OS SolutionPack

Agentless Windows/UNIX SolutionPack for Physical
Hosts

Agent based Windows SolutionPack for EMC Host
Interface
SolutionPack for Physical
Hosts (Reports)

Agent based UNIX SolutionPack for Physical
Hosts (Reports)

Passive (via zoning
information from Brocade and
Cisco switches or Device
Manager for HDS)

All SolutionPack for Brocade/
Cisco/HDS

Passive (via host containers) All Not applicable (only requires
the Generic-RSC collector)

Passive host discovery
Passive host discovery is a capability where hosts are intelligently guessed from SAN
zoning records. SAN zoning discovery yields hostnames, IP addresses, and HBA port
WWN values from zoning records. EMC recommends discovering hosts primarily with
passive discovery in order to recognize SAN attached hosts. Once the hosts are
resolved, storage administrators can obtain additional credentials from server
administrators to completely discover hosts.
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Note

Passive discovery through Brocade and Cisco SolutionPacks is disabled by default.

Enabling passive host discovery

You can enable passive host discovery while installing the SolutionPack, or by
reconfiguring the SolutionPack.

For the SolutionPack for Brocade FC Switch, reconfigure the SMI Data Collection
block.

For the SolutionPack for Cisco MDS/Nexus, edit the Generic-SNMP independent
SolutionPackBlock instance.

Discovering hosts via host containers
Use the host containers mode of discovery if you are interested in end-to-end
topology and chargeback, but you do not want to actively poll the host.

Before you begin

To view the end-to-end topology, the fabric and the array from which the host has
been allocated storage must be fully discovered via ViPR SRM. To view chargeback
reports, the array from which the host has been allocated storage must be discovered
in ViPR SRM.

Procedure

1. Click Discovery Center > Inventory Management.

2. Click Host configuration

3. Click Add New Device.

4. Enter the IP address (optional).

5. Enter the hostname.

6. Select Host Containers from the Specify the discovery mode drop-down
menu.

Enter one or more HBA port WWNs in the Host Port WWN field. Multiple
WWNs must be separated by a semicolon (;). This field is not case sensitive.
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Confirming report creation
After you install a SolutionPack, you can view its reports.

To view the reports:

Procedure

1. Go to User Interface > Report Library.

2. Click the SolutionPack to view its reports.

Results

It may take up to an hour to display all relevant information in these reports.

What to do if data does not appear in any reports

Procedure

1. After the completion of at least three collection cycles, verify if data is
populating into the reports. If there is still no data in the reports, continue to the
next step.

2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.

3. To view the log files for errors, go to Centralized Management and click
Logical Overview > Collecting > Collector-Manager::<instance name> > Log
Files.

Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and
populates the reports with new data. You can manually run the scheduled task to
import the data more quickly.

Before you begin

Allow at least three polling cycles to pass before manually running the scheduled task.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Expand Scheduled Tasks.

4. Click Database.

5. Select the import-properties-Default task.

6. Click Run Now.

7. Confirm success in running the task in the Last Result and Last Result Time
columns.
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What to do if data does not appear in some reports

Procedure

1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.

2. Search for the metric in the database.

3. To view the log files for errors, go to Centralized Management and click
Logical Overview > Collecting > Collector-Manager:<instance name> > Log
Files.

4. To view the log files for errors, go to Centralized Management and click
Events > Event-Processing_Manager::Instance name > Logs.

To troubleshoot the errors, enable the Event-Spy for the Event Processing
Manager.

Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.

Procedure

1. Click Administration .

2. Under Modules, click Management of Database Metrics.

3. On the Metric Selection page, create the filter, type the number of results, and
select the properties to display for the metric.

For example, to list up to 100 results of the Capacity metric with the properties
of device and IP, type name=='Capacity' in the Filter field, 100 in the
Maximum results field, and select device and IP for the Properties to show.

4. Click Query.

A list of the metric results appears. If nothing displays, the metric is not being
collected.

External storage capacity is double counted in capacity
reports

Enterprise capacities for a storage array include any external array capacity or
Federated Tier Storage (FTS) Capacity.

To avoid double counting of external storage capacity in the enterprise capacity
reports, do not discover the external storage array.

Authorization fails for passwords having special characters

Passwords for ViPR SRM users with the following characters are not supported: "?(~
' | { }$%^&*()_+)
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Troubleshooting discovery issues, slow reports, and missing
data

Learn how to troubleshoot discovery issues, slow reports, and missing data in reports
or topology maps.

Procedure

1. Under Discovery Center > Inventory Management, locate entries for the
SolutionPack, find the element with the issue, and validate its discovery status
using the Test button utility.

2. Under Centralized Management > Physical Overview, locate the SolutionPack
collector appliance, select it, select the Collector-Manager instance, and ensure
that there are no errors in Collector-Manager log files.

3. Under Centralized Management > Physical Overview, locate the SolutionPack
collector appliance, select it, select Topology-Mapping-Service instance, and
under Log Files, ensure that there are no errors in the topology-mapping-
sevice.log file. Any issues here could be related to a topology map issue.

4. Under Centralized Management > Physical Overview, locate the SolutionPack
collector appliance, select it, select the Load-Balancer instance, and ensure that
there are no errors in the load-balancer logs. Any issues in pushing data to the
backend can cause missing data in reports.

5. Under Centralized Management, select the Primary Backend host, select the
Load-Balancer instance, and ensure that there are no errors in the load-
balancer logs. Any issues in pushing data to the backend can cause missing data
in reports.

6. Under Centralized Management, select the Primary Backend host, select the
Topology-Service instance, and ensure that there are no errors in the
topology-service.log file. Any issues in pushing data to the backend can
cause topology map issues.

7. Under Scheduled Tasks, ensure that all tasks are completing in reasonable time
and that there are not any status problems. Any issues here can cause slow
reports or missing data.

If you are experiencing issues with discoveries, slow reports, or missing data in
reports, ViPR SRM includes an EMC M&R Health SolutionPack that can be very
helpful. Ensure that each of the ViPR SRM appliance hosts have the EMC M&R
Health SolutionPack installed and data has been collected for 2 to 3 collection
cycles. The System Health reports are available at All > Report Library > EMC
M&R Health. The reports at All > Report Library > EMC M&R Health > Misc.
Reports > JVMs Sizing Recommendation are useful to assign the correct
amount of memory for SolutionPacks. Additionally, refer to Managing ViPR SRM
System Health for details about interpreting system health reports.

Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.

Procedure

1. Click Administration .
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2. Click Centralized Management > Logical Overview.

3. Expand Collecting.

4. Click the Collector-Manager for the collector instance.

Collector-Manager::<Collector-Manager instance> - <host_ID>

5. Expand Log Files and click the View File icon to review the error messages.

Troubleshooting agentless host discovery for Windows
This section describes troubleshooting methods that you can use when configuring
agentless host discovery for Windows.

Troubleshooting authentication failures
Use the following procedure to troubleshoot authentication failures:

Procedure

1. From the ViPR SRM user interface, browse to Administration > Discovery
Center > Host Configuration.

2. If the host is already added for discovery, click the instance and verify that the
credentials were entered correctly.

3. If the credentials are correct, click the Test button to troubleshoot any
authentication or authorization problems.

Performing a configuration check
To perform a configuration check, ensure that the following conditions are met:

Procedure

l Ensure that the host configuration utility runs successfully to troubleshoot any
environment problems on the host.

l Ensure that the host OS is supported in ViPR SRM.

Using logs on a Windows host
Before you begin

Initially, you should review the Generic-RSC collecting-0-0.log in the logs
folder

Further troubleshooting requires the support mode logs:

Procedure

1. Enable support mode in the LunMappingDetection.ps1 script on the host.
Run the following command:

 $supportOption="enabled"

2. Run the command for support mode:

powershell.exe -noprofile -file LunMappingDetection.ps1 > 
test.log
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Note

Run the support mode with the user that was used for discovery.

Checking SNIA library installation on a Windows host
To verify if SNIA library is correctly installed, ensure the following:

Procedure

l If the HBA is an Emulex model, check whether HBAAnyware or OneCommand
Manager is installed.

l If the HBA is a Qlogic model, check whether SAN Surfer is installed.

Gathering HBA information
To gather HBA information:

Procedure

1. Run wbemtest tool.

2. Connect to root/cimv2 and run the following query:

 select Name from Win32_SCSIController where 
ProtocolSupported=10 or Manufacturer='EMC Corporation' or 
Manufacturer='Emulex' or Manufacturer='QLogic'

3. Double-click the rows that are returned by the query and click show MOF.

4. Note the HBA make and model information.

Verifying HBA installation
Verify that the HBAs are installed by using the following procedure:

Procedure

1. Right-click My Computer.

2. Select Manage from the Server Manager window.

3. Expand the Diagnostics tab.

4. Click Device Manager.

5. Expand Storage Controllers within the Device Manager window and note the
HBA make and model.

Installing OneCommand Manager
Before you begin

If you are running the OneCommand/HBAAnyware Vision application, you must stop
the services before installing the OneCommand Manager application.

To stop the services:

Procedure

1. Select Start > Programs > Administrative tools > Services

Troubleshooting

302 EMC ViPR SRM 4.2.1  SolutionPack Guide



2. Stop the EmulexSensor service.

3. Stop the EmulexWMIAgent service.

4. Stop the Emulex PDH agent service.

5. Stop the EmulexScope agent service.

6. Install the OneCommand Manager/HBAAnyware application.

7. To restart the sensor after the installation is complete:

a. Stop SNMP service in case of SNMPv2c [Stop Net-SNMP Agent in case of
SNMPv3].

b. Start SNMP service in case of SNMPv2c [Start Net-SNMP Agent in case of
SNMPv3].

c. Start the EmulexSensor service.

Installing or modifying QLogic drivers on a Windows host
Refer to the procedure provided in the ReadMe provided with the downloaded
package.

Troubleshooting UNIX Agentless Host Discovery
This section describes some troubleshooting methods you can use when configuring
UNIX agentless host discovery.

Environment check for non-root configurations
Ensure that the host OS is supported in ViPR SRM and the configurations pertaining
to non-root users are correct. Non-root users can be configured using sudo, pbrun, or
dzdo.

Using logs on a UNIX host
Before you begin

Initially, you should review the Generic-RSC collecting-0-0.log in the logs
folder.

For further debugging, you need the support mode logs.

To retrieve support mode logs, run the following command on the host:

 ./LunMappingDetection.pl support=test_log

SNIA Library check
To verify that the SNIA library is correctly installed, check the contents of hba.conf.

Check the contents of hba.conf

more /etc/hba.conf
qla2xxx /usr/lib/libqlsdm.so
qla2xxx64 /usr/lib64/libqlsdm.so
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Verify libHBAAPI.so in 64 bit machines
In 64 bit machines, verify the presence of libHBAAPI.so:

ls /usr/lib64/libHBAAPI.so

Verify libHBAAPI.so in 64 bit machines

linbgm103:/lib # more /etc/hba.conf
com.emulex.emulexapilibrary /usr/lib64/libemulexhbaapi.so
com.emulex.emulexapilibrary /usr/lib/libemulexhbaapi.so

Another way to verify that Emulex HBA related software is installed is to check
whether /usr/sbin/hbanyware or /usr/sbin ocmanager is present or not.

Gathering information about AIX HBAs
To gather information about AIX HBAs, use the following procedure:

Procedure

1. Verify that HBA instances are installed:

/usr/sbin/lsdev -Cc adapter

2. Verify the HBA model:

lscfg –vl fcs

Gathering information about HP-UX HBAs
Procedure

1. Look for the HBA instances that are installed in the host. The following
command looks for both types of HP drivers (fcd and td):

 ls /dev | egrep "fcd|td"

or

 /usr/sbin/ioscan -knfC fc

2. Gather product data about each HBA instance such as the part number and
model. The HBA type and number should be replaced with #:

/opt/fcms/bin/fcmsutil /dev/<fcd#/td#> vpd
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3. Gather useful data about each HBA instance such as WWN:

 /opt/fcms/bin/fcmsutil /dev/<fcd#/td#>

Gathering information about Solaris HBAs
Show the HBA model and firmware level for all of the instances with the following
command:

 fcinfo hba-port

Gathering information about Linux HBAs
To gather information about Linux HBAs, use the following procedure:

Procedure

1. Verify that the HBA instances are installed:

lspci | grep "Fibre Channel"

2. Verify the HBA model:

dmesg | grep scsi

Installing or modifying Emulex HBA drivers on Linux
Before you begin

The following must be installed before you can install the utilities:

l The driver for the operating system:

n Linux driver version 8.2.0.33.3p or later (For RHEL5 and SLES10 operating
systems.)

n Linux driver version 8.2.8.x or later (For SLES11 operating systems.)

n Linux driver version 8.3.5.X or later (For RHEL 6 SLES 11 SP1 operation
systems.)

l Previous versions of the Linux driver must be uninstalled. You must run the
uninstall script that shipped with the version of the Linux driver you want to
remove.

To install the OneCommand Manager application in Linux, use the following procedure:

Procedure

1. Log on to the host as root.

2. Download the utilities from the Emulex website or copy them to the system
from the installation CD.

3. Copy the installation and uninstallation scripts to a known location, for easy
access by other users.
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4. Copy the OneCommand elxocm-<Platform>-<AppsRev>.tgz file to a
directory on the install host.

5. Change (use cd command) to the directory to which you copied the tar file.

6. Untar the file.

l For RHEL 5 and RHEL 6 type the following:

tar zxvf elxocm-rhel5-rhel6-<apps_ver>-<rel>.tgz

l For SLES 10 and SLES 11 type the following:

tar zxvf elxocm-sles10-sles11-<apps_ver>-<rel>.tgz

7. Change (use cd command) to the elxocm directory created in step 6.

For RHEL 5 and RHEL 6 type:

cd elxocm-rhel5-rhel6-<apps_ver>-<rel>

8. Run the install script.

Installing or modifying Emulex HBA drivers on UNIX
Before you begin

The following must be installed before you can install the utilities:

l The Solaris FC/FCoE driver version 2.50 or later.

l The NIC driver version 1.10 or later for NIC capability.

To install the OneCommand Manager application in Solaris:

Procedure

1. Copy the Solaris utility kit to a temporary directory on your system.

2. Untar the utility kit:

tar xvf elxocm-solaris-<version>.tar

3. Change to the newly created elxocm-solaris-<version> directory:

cd ./elxocm-solaris-<version>/

4. Execute the install script to begin installation. If the HBAnyware utility,
OneCommand Manager Core or OneCommand Manager Enterprise applications
or the Solaris driver utilities are already present on the system, the install script
attempts to remove them first:

./install

5. When prompted, enter the type of management you want to use:
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l 1 Local Mode : HBA's on this Platform can be managed by OneCommand
clients on this Platform Only.

l 2 Managed Mode: HBA's on this Platform can be managed by local or
remote OneCommand clients.

l 3 Remote Mode : Same as '2' plus OneCommand clients on this Platform can
manage local and remote HBA'

Installing or modifying QLogic HBA drivers on UNIX/LINUX
The SNIA API library package (example: qlapi-<api_version>-rel.tgz) is in
the driver combo package (example: qla2x00- vx.yy.zz-dist.tgz) or
(qla2x00-vx.yy.zz-fo-dist.tgz).

Using the files that you downloaded from Qlogic website, copy the tgz file (example:
qla2xxx-vx.yy.zz-dist.tgz) distribution file to /qla2x00.

The following example shows how the package is installed. Type the following
commands, as outlined in the following steps, from the / (root) directory:

Procedure

1. mkdir qla2x00
2. cd qla2x00*
3. mount /mnt/floppy
4. cp /mnt/floppy/*.tgz .

Note

The period at the end is required.

5. tar -xvzf *.tgz
6. cd qlogic
7. To install and set up the API library, type the following command:

in ./libinstall
This installs/sets up HBA API library.

Troubleshooting passive host discovery
This section contains information on troubleshooting passive host discovery.

Verifying passive hosts from the collection logs
Procedure

1. Enable the file connector in the corresponding Brocade or Cisco SolutionPack.

2. Review the collection information in the file-connector.log, and look for
PassiveHost as the devtype in the collection details.

For example:

 1421139292: group::Brocade-
Collectorz_losan239_110000000C93995CF1000000533E94F01-0000AFFF
00000008({isremote=true, partsn=0000AFFF00000008, 
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part=10000000C93995CF, ip=10.247.22.239, 
zmemid=10000000C93995CF, source=Brocade-Collector, 
w4ncert=1.0, hasDevice=Yes, parttype=Disk, 
zname=z_losan239_1, devtype=PassiveHost, hostname=losan239, 
vendrcode=0000C9, name=ZoneMemIdentifier, actdisc=0, 
hostwwn=10000000C93995CF, device=losan239, 
datagrp=BROCADE_ZONEMEMBER})=0.0

Verifying passive hosts from the RDF/topology store
If you have Sesame windows client, execute the following query:

PREFIX SRM: <http://ontologies.emc.com/2013/08/SRM#>
SELECT ?s ?p ?o
WHERE {
?s a SRM:PassiveHost .
?s ?p ?o
} LIMIT 1000

Verifying that LUNs from an array are being mapped to host
The partsn value (with LUNWWNS) is retrieved using a sparql query on the Topology
RDF store. When searching for this value in VIPR SRM, note that both the passively-
discovered host and the connected array both need to have been discovered. For
example:

1421139292: group::Brocade-
Collectorz_losan239_110000000C93995CF1000000533E94F01-0000AFFF000000
08({isremote=true, partsn=0000AFFF00000008, part=10000000C93995CF, 
ip=10.247.22.239, zmemid=10000000C93995CF, source=Brocade-
Collector, w4ncert=1.0, hasDevice=Yes, parttype=Disk, 
zname=z_losan239_1, devtype=PassiveHost, hostname=losan239, 
vendrcode=0000C9, name=ZoneMemIdentifier, actdisc=0, 
hostwwn=10000000C93995CF, device=losan239, 
datagrp=BROCADE_ZONEMEMBER})=0.0
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